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Support

Thank you for purchasing this NETGEAR product. You can visit www.netgear.com/support to register your product, get help,
access the latest downloads and user manuals, and join our community. We recommend that you use only official NETGEAR
support resources.

Conformity
For the current EU Declaration of Conformity, visit http://kb.netgear.com/app/answers/detail/a_id/11621.

Compliance

For regulatory compliance information, visit http://www.netgear.com/about/regulatory.
See the regulatory compliance document before connecting the power supply.

Trademarks
© NETGEAR, Inc., NETGEAR and the NETGEAR Logo are trademarks of NETGEAR, Inc. Any non-NETGEAR trademarks are

used for reference purposes only.
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202-11289-05
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December 2015

Added support for the following platforms:

- M4200 series managed switches, including the M4200-10MG-POE+.

- M43000 series managed switches, including the M4300-8X8F,
M4300-12X12F, M4300-24X24F, M4300-28G, M4300-52G,
M4300-28G-POE+, and M4300-52G-POE+.

- XS728T smart managed switch.
- WAC720, WAC730, and WND930 wireless access points.

- ReadyNAS RN716X, RN3130 (all models), RN31200 (all models),
RN31400 (all models), RN31600 (all models), and RN51600 (all
models).

Added information about the new MIB browser (see Use the SNMP MIB
Browser on page 62).

Added the option to search for the switch to which a host is directly
connected (see Search for the Switch to Which a Host Is Connected on
page 76).

Added the option to add and change an alarm configuration for a link on
a hierarchical map. For more information, see the following sections:

- Add an Alarm Configuration for a Link on a Hierarchical Map on
page 199.

- Change an Alarm Configuration for a Link on a Hierarchical Map on
page 203.

Added the option to back up and restore the system settings. For more
information, see the following sections:

- Set Up a File Server for System Backup and Restore Operations on
page 275.

- Back Up the System Settings on page 277.
- Restore the System Settings on page 281.

202-11289-04

December 2014

Added support for the following platforms:

- M6100 managed switch, including blades and supervisors inserted in
the chassis: XCM8944, XCM8944-POE+, XCM8944-uPOE, XCM8948,
XCM8948-POE+, XCM8948-uPOE, XCM8944F, and XCM8924X.

- S3300 smart switch: S3300-28X, S3300-28X-PoE+, S3300-52X, and
S3300-52X-PoE+.

- FVS336Gv3 firewall.
- WN370 wireless access point.

Added the option to display the slot list for an M6100 managed switch
(see View Device Details and Interface Details on page 95).
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December 2014
(continued)

Continued:

Added the option to enter an email address for notification of file backup
results (see Add or Modify a Backup Profile on page 122).

Added an option to send an SMS message when an alarm is triggered
(see Configure the SMS Server for Alerts and Alarm Notifications on
page 29 and Add or Modify an Alarm Notification Profile on page 182).
However, this option is supported for a particular SMS gateway in the
People's Republic of China only.

Added sampled flow (sFlow) for managed switches (see Chapter 8,
Manage sFlow).

Added support for an external file storage server on which you can store
backup files (see Set Up an External File Server on page 265 and Import
and Export Configuration Files to an External File Server on page 156).

Added the capacity to support Chinese characters for device names.

202-11289-03

January 2014

Added support for storage systems.

Added support for additional firewalls.

Added support for additional switches and wireless devices.
Removed devices that are no longer supported (EOL).
Added Chapter 14, Register Devices.

Added an Index.

202-11289-02

October 2013

Revised the structure of the manual entirely.
Added support for wireless devices.
Added support for the FVS318G firewall.

202-11289-01

June 2013

First publication.
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Introduction

Streamline network management tasks

The NETGEAR Network Management System 300 (NMS300) is a centralized and
comprehensive management application that enables you to discover, monitor, configure, and
report on enterprise-class networks with NETGEAR and third-party network devices.

This manual is intended for network administrators.
This chapter covers the following topics:

* Network Environment Concepts

e Compatible Devices

* Prepare the Network Devices for Discovery
¢ What to Do Next

Note: In this manual, the NMS300 application is referred to as the
application. The server on which the application is installed is referred
to as the NMS300 server.

For more information about the topics covered in this manual, visit the
support website at support.netgear.com.

For more information about this NMS300 release, see the NMS300
Release Notes, which are available on downloadcenter.netgear.com.

Firmware updates with new features and bug fixes are made
available from time to time on downloadcenter.netgear.com. Some
products can regularly check the site and download new firmware, or
you can check for and download new firmware manually. If the
features or behavior of your product does not match what is
described in this guide, you might need to update your firmware.

10
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Network Environment Concepts

The application resides on the NMS300 server at a static IP address on the local area
network. The application monitors the NETGEAR and third-party devices on the network.

Local area network
Internet
Static IP gateway Internet
address
NMS300 Web NETGEAR | | Third-party
server browser devices devices
Web
browser

Figure 1. The Network Management System 300

You access the application through a web browser. The IP address for a web browser that is
located outside the Internet gateway must be permitted to access the network.

The application supports the following devices:
* NETGEAR devices

For detailed information about the supported NETGEAR devices, including model
numbers, see Compatible Devices on page 14.

e Third-party (non-NETGEAR) devices, including the following:
Routers

VoIP gateways

- Hosts

Virtualization servers

* The managed NMS300 server

The application displays whether third-party devices are up or down. If a third-party device
supports SNMP, the application uses SNMP MIBs to gather and present health and status
information about the device.

Introduction
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Device Groups

To simplify the management of networks with many devices, you can create device groups.
Group devices by vendor, location, device type, device model, and contact. Device groups

are optional.
r—— — — — — — — — A
| Device group M |
| | Network Network ||
| | device M1 device Mm | |
Lo = = = = — — 4
Local area network Internet
Static IP gateway Internet
address r——|-—-—- - - — —
NMS300 Web || Network Network ||
server browser | | | device N1 Device Nn | |
| . I
Device group N
I_____g_p___J Web
browser

Figure 2. Device groups

You can create two types of device groups:

Static device groups. A static group is a fixed list of specific devices. You must
configure this list manually. For more information, see Add or Modify a Static Device
Group on page 71.

Dynamic device groups. A dynamic group is a dynamic list of devices that filter
selection criteria determine. The list changes automatically as devices that meet the filter
criteria are added to and removed from the network. For more information, see Add or
Modify a Dynamic Device Group on page 73.

Types of Users

The application includes the following default user security profiles:

Admin. A user who can perform administration-related functions. An admin user is
authorized to perform all application functions. Only an admin user can modify and delete
the default security profiles, can define new security profiles, and can add or remove user
profiles.

For more information, see Chapter 11, Manage Users and Security Profiles.

Operator. A user who can manage the enterprise network functions, but cannot perform
administration-related functions.

Observer. A user who can only monitor and view enterprise network functions.

Introduction
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This manual is written for the admin user but also contains information that is useful for
operators and observers.

Introduction
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Compatible Devices

This release of the application supports the following features:

e Support for NETGEAR managed and smart switches

e Support for NETGEAR wireless devices

e Support for NETGEAR firewalls

e Support for ReadyDATA and ReadyNAS storage devices

e Support for discovery and node status monitoring of third-party devices

Note: Products that reached their end of life (EOL) are not included in the
following lists.

NETGEAR Managed Switches

This release supports the following NETGEAR managed switches:

« GSM5212P

« GSM7212F

« GSM7212P

«  GSM7224P

« JGSM7224

*  M4100-12G-POE+
*  M4100-12GF

*  M4100-24G-POE+
* M4100-26-POE+

*  M4100-26G

e M4100-26G-POE
* M4100-50-POE

*  M4100-50G

*  M4100-50G-POE+
* M4100-D10-POE
* M4100-D12G

* M4100-D12G-POE+
*  M4200-10MG-POE+
*  M4300-8X8F

*  M4300-12X12F

*  M4300-24X24F

Introduction
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e M4300-28G
*  M4300-52G
¢ MA4300-28G-POE+
¢ M4300-52G-POE+
+  M5300-28G
¢ M5300-28G-POE+
*  M5300-28G3
*  M5300-28GF
*  M5300-52G
¢ M5300-52G-POE+
*  M5300-52G3
e M®6100, including blades and supervisors inserted in chassis:
- XCM8944
- XCMB8944-POE+
- XCM8944-uPOE
- XCM8948
- XCM8948-POE+
- XCM8948-uPOE
- XCM8944F
- XCMB8924X
M7100 XSM7224
e M7100 XSM7224S

NETGEAR Smart Switches

This release supports the following NETGEAR smart switches:

« FS526Tv2
« FS726Tv2
« FS728TLP

« FS728TPv2
 FS728TP-200
* (GS108T-200

«  GS110TP
 (GS418TPP
 GS510TLP

« GS510TP

« GS510TPP

Introduction

15



NMS300 Network Management System Application

GS516TP
GS716T-300
GS724T-400
GS724TPv2
GS748T-500
GS728TP
GS728TS
GS728TPP
GS728TPS
GS728TXS
GS748T-400
GS752TP
GS752TPS
GS752TS
GS752TXS
S3300-28X
S3300-28X-PoE+
S3300-52X
S3300-52X-PoE+
XS708T
XS712T
XS716T
XS728T

NETGEAR Firewalls

This release supports the following NETGEAR firewalls:

FVS318G
FVS318N
FVS336Gv2
FVS336Gv3
SRX5308

NETGEAR Wireless Access Points

This release supports the following NETGEAR wireless access points:

WACT720
WAC730

Introduction
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« WG103

*  WN203

*  WN203-200

«  WNS370

«  WND930

«  WNAP210

«  WNAP320

«  WNAP370

«  WNDAP350

«  WNDAP360

*  WNDAP380R
*  WNDAP380RvV2
«  WNDAP620

«  WNDAPG660

NETGEAR Wireless Management Systems and Controllers

This release supports the following NETGEAR wireless controllers and wireless
management system:

« WC7520
« WC7600
*  WC9500
« WMS5316

NETGEAR Storage Systems

This release supports the following NETGEAR ReadyDATA and ReadyNAS storage
systems:

+ RD5200
+ RDD516
e RN716X
« RN2120
*  RN3130 (all models)
*  RN3220
*  RN4220

*  RN31200 (all models)
* RN31400 (all models)
*  RN31600 (all models)

Introduction
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* RN51600 (all models)
Prepare the Network Devices for Discovery

To manage the devices on your network, you must prepare them for the application. By
default, the application lets you manage up to 200 devices. For information about managing
more than 200 devices, contact your NETGEAR sales contact.
» To prepare the devices on your network:
1. Upgrade your devices to their latest released firmware.
To upgrade the firmware, use the web management interface of the device.

Each device must run the latest firmware before the application can discover and manage
the device. Once you perform this one-time upgrade, the application can centrally
manage future device firmware upgrades.

2. Create the credentials for your devices.

The application uses a combination of SNMP, HTTP, and Telnet protocols to interact with
the devices on your network.

You must configure the application with the device credentials to authenticate with the
devices over the following protocols:

e Telnet and HTTP protocols. If the devices are not configured with the default
password for the admin user, create two new credentials in the application.

Create one credential for the Telnet protocol and another credential for the HTTP
protocol that contain either the admin user credential or the credential of another user
of the device with administrative privileges.

¢ SNMP community strings. If the devices are not configured with the default SNMP
community strings, create a credential in the application for the SNMP protocol that
contains the matching community strings.

For more information, see Add or Maodify a Device Credential on page 37.

3. Make sure that each device on your network is configured to send SNMPv1 or SNMPv2
traps to the IP address of the NMS300 server.

The application listens for SNMPv1 and SNMPV2 traps.

What to Do Next

Before you can manage your network, you must perform certain basic configuration tasks
and let the application find the devices that are on your network. These tasks are described in
the following chapters:

e Chapter 2, Get Started
» Chapter 3, Discover and Manage Resources

Introduction
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Get Started

Log in and perform basic configuration
tasks

After you logged in to the application, you can change your password and account information
and configure the email server.

This chapter covers the following topics:

* Log In to the Application

e Change Your Password and Account Information

» Configure the Email Server for Alerts and Alarm Notifications
e Configure the SMS Server for Alerts and Alarm Notifications

19
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Log In to the Application

The application uses a browser server architecture. Administrators and other types of users
can access the application from any supported browser. For more information about installing
the application, see the NMS300 Network Management Quick Start Guide, which is available
at downloadcenter.netgear.com.

Before you log in to the application, check the following items:

* Make sure that the application is installed on a server with a static IP address.
e Clear your browser cache before you use the application.

& CAUTION:

The application supports multiple concurrent users. We recommend that
different users coordinate their application activities so that modifications to
a page made by one user are not inadvertently changed by another user.

> To select your language and log in to the application:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

e To connect to the application from the same NMS300 server on which you installed
the application, enter the URL http://localhost:8080.

If you entered a different port number for the NMS300 server during the application
installation, replace 8080 in this URL with the port number that you provided during
installation.

e To connect to the application from a remote computer, replace localhost with the IP
address of the NMS300 server. For example, enter http://203.0.113.56:8080, in
which 203.0.113.56 is the IP address of the NMS300 server and 8080 is the port
number for the NMS300 server.

After you connect to the application, the User Login window opens.
Q

Language ‘ English EI

User Name | |

Password | |

™ Remember User Name

Forgot Password

2. From the Language menu, select your language.
The default language is English. You can also select Chinese.

3. Enter your user name and password.

Get Started
20
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When the application is initially installed, the default administrator user name is admin
and the default administrator password is also admin.

You must be an administrator (admin user, that is, a user with a security profile that is set
to Admin) to be able to create user names and passwords for other types of users.

Click the Sign In button.

NETGEAR
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For more information about the Network Summary page, see Monitor the Network on

page 78.
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Change Your Password and Account Information

We recommend that you change your password to a more secure password. This
recommendation applies to admin users only because nonadministrative users such as users
with a security profile set to Operator or Observer cannot change their password.

As an admin user, you can also change your account information. Items that you can change
include your email address, real name, and telephone number. You cannot change your user
name but you can add a second admin account with a different user name. For more
information, see Chapter 11, Manage Users and Security Profiles.

Change Your Password

When the application is initially installed, the default administrator user name is admin and
the default administrator password is admin. As an admin user, you can create user names
and passwords for other types of users.

» To change your password:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

Get Started
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4. Select ADMIN > SETTINGS.
[ wowion [ comns | acamws [rvovoroor [ smow [ serowrs [ soss [ wsmns [ wowm ]

SETTGS
System and Website Settings
Getting Started with NMS. System Settings  Customize
/&7 Discover your network and add the devices you wantto Set global settings for the system and website. AL/ Customize the navigation and look of your web portal.
manage,

Account Information a Manage Monitor and Alarm = my.NETGEAR.com Account Profile
View or modify uSers, of Create New users. Configure and validate myNETGEAR com acoount profile
through myNETGEAR.com Web AP

Metwork monitor, 3larm and threshold related configurations.

> myNETGEAR com Ac

— sFlow
> Set sFlow related configurations.

Manage External File Server

L gxemal File Server configurations and File Pracessing with
External File Server.

License And Version Information

View NMS300 license, supported device and version
information.

—_ System Backup/Restore

Systern BackupRestore Server Configurations and
Protessing.

5. Under Account Information, click the Change Password link.

Change My Password

Old Password ,—l k4
New Password ,—l r
Re-type Hew Password |—| z

| cancet

6. Enter your old and new passwords.
7. Click the Submit button.

Your password is updated.

Get Started
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Change Your Account Information

You can change your general account settings such as your email address and telephone
number.

» To change your account information:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

and Websi g
Getting Started with NMS System Settings Customize
Discover your network and addthe devices you want to Set global seltings for the system and website, A! Customize the navigation and lock of your web portal,

manage

Account Information ﬁ Manage Menitor and Alarm D my.NETGEAR.com Account Profile
ﬁ View or modify users, or create new users, Metwork monitor, alarm and threshold relsted configurations . Configure and validate my NETGEAR.com account profile
through myNETGEAR com Web APL

» User Management

(= sFlow Manage External File Server License And Version Information
8 setsFlow related configurations &% Evemal File Sever configurations and File Pracessing with View NMS300 license, supporiad device sndversion
External File Server. information,

System Backup/Restore

System Backup/Restore Server Configurations and
Processing.

5. Under Account Information, click the Edit Account link.

Get Started
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My Account Information

User Hame roger_admin

E-mail roger_admin@nstgear.com

Last Hame
First Name
Telephone

[ suoni JRES

6. Modify the information as needed.
7. Click the Submit button.

Your account information is updated.

Configure the Email Server for Alerts and Alarm
Notifications

Before the application can send email updates and alarm notifications, you must configure
the email server settings. Only an admin user can configure the email server settings.

Note: For information about adding an alarm notification profile with an
email address to which the application can send a notification, see
Add or Modify an Alarm Notification Profile on page 182.

Configure the General Email Server Settings

The following procedure describes how to configure the general email server settings.

» To configure the email server:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

Get Started
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The Network Summary page displays.
4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings

/&P Discover your network and sddthe devices you wantto Set global seftings for the system and website
manage.

4 Customize
AZ Customize the navigation and look of your web portal,

Account Information Manage Menitor and Alarm b my.NETGEAR.com Account Profile
* Vigw or modify users, or create new users, ﬁ Metwork moniter, slarm and threshald related configurations  Configure and validate my NETGEAR.com account profile
through my NETGEAR com Web AFL
> MyNETGEAR com Account Profile
3 sFlow Manage External File Server License And Version Information
Set sFlow related configurations. % Exemal File Server configurations and File Processing with View NMS300 license. supported device and version

External File Server. infermation

System Backup/Restore

System Backup/Restore Server Configurations and
Processing.

5. Under Getting Started with NMS, click the SMTP Email Settings link.

SMTP Configuration
SMTP Server Host *
SMTP Server Port 25 -3

[~ Authentication Enabled

User Hame z
Password T

[ Use SSL

‘ Cancel || Test

6. Enter your SMTP configuration settings.

7. If your SMTP server requires authentication, select the Authentication Enabled check box.
8. In the User Name field, enter the user name for your email account.

Get Started
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Note: You must enter the email user name entirely, that is with the at sign
(@) and domain name. For example, username@domain.com. The
SMTP server also uses the entire user name as the address from
which email is sent.

9. Inthe Password field, enter the password for your email account.

10. To use a secure email connection, select the Use SSL check box, and in the SMTP Server
Port field, enter the port number for the SSL connection.

11. Click the Test button.
Your SMTP configuration settings are verified.
12. Click the Submit button.

Your changes are saved.

Configure Email Server Settings for a Gmail Account

The following procedure describes how to configure the email server for a Gmail account.

» To configure the email server for a Gmail account:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

Get Started
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4. Select ADMIN > SETTINGS.
[ o | s | s | wowon | come | mems [ oo | suow | wooms | ow | va |hom |

System and Website Settings

Getting Started with NMS

System Settings
Discover your network and addthe devices you want to Set global seltings for the system and website,
manage.

> Discover Devices

4 Customize
a{ Customize the navigation and look of your web portal,

Account Information

i Manage Monitor and Alarm
Wiew or modify users. or create new users.

‘g MyMNETGEAR.com Account Profile

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

Metwork moniter, alarm and thresheld related configurations.

> mNETGEAR com Account Profile

E sFlow Manage External File Server License And Version Information
A Set sFlow related configurations &5 External File Sever configurations and File Processing with View NMS300 license, Supponed device andversion
External File Server,

Infermation

Ei System Backup/Restore

System BackupRestore Server Configurations and
Processing.

5. Under Getting Started with NMS, click the SMTP Email Settings link.

B SMTP Configuration X

SMTP Configuration
SMTP Server Host smtp.gmai. com *
SMTP Server Port 25 x

[¥] Authentication Enabled

User Name YourUserName@gmail com z
Password ssssssssses z
[¥] use SSL

Cancel || Test |

6. Enter the following settings and select the following check boxes:
e Inthe SMTP Server Host field, enter smtp.gmail.com.
¢ Inthe SMTP Server Port field, enter 25.

e Select the Authentication Enabled check box.

In the User Name field, enter the user name for your Gmail account.

Get Started
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Note: You must enter the email user name entirely, that is with the at sign
(@) and domain name. For example, username@gmail.com. The
SMTP server also uses the entire user name as the address from
which email is sent.

* Inthe Password field, enter the password for your Gmail account.

To use a secure email connection, select the Use SSL check box, and in the SMTP Server
Port field, enter 465.

Click the Test button.
Your SMTP configuration settings are verified.
Click the Submit button.

Your changes are saved.

Configure the SMS Server for Alerts and Alarm
Notifications

Note: The SMS server option is supported for a particular SMS gateway in
the People's Republic of China only. No other SMS servers are
supported in this release.

Before the application can send SMS updates and alarm notifications, you must configure the
SMS server settings. Only an admin user can configure the SMS server settings.

For information about adding an alarm notification profile with an SMS telephone number to
which the application can send a notification, see Add or Modify an Alarm Notification Profile
on page 182.

» To configure the SMS server:

1.

2.

Contact NETGEAR support to obtain the corporation ID and password for the Chinese
SMS server that is supported.

Open a browser and connect to the application through the static IP address of the NMS300
server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Get Started
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5. Select ADMIN > SETTINGS.
[ o | s | s | wowon | come | mems [ oo | suow | wooms | ow | va |hom |

System and Website Settings

Getting Started with NMS

Discover your network and add the devices you want to
manage

System Settings
Set global seftings for the system and website,

4 Customize
f’ Customize the navigation and 100k of your web portal,

Account Information

Manage Monitor and Alarm
& View or modify users, or create new users.

‘g MyMNETGEAR.com Account Profile

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

Metwork monitor, alarm and threshold related configurations.

+ myMETGEAR com Account Profile

= sFlow

Manage External File Server License And Version Information
t_‘j' Set sFlow related configurstions. &5 Exemal File Sever configurstions and File Processing with View NMS300 license, supponed device andversion
External File Server,

Infermation

Ei System Backup/Restore

System BackupRestore Server Configurations and
Processing.

Under Getting Started with NMS, click the SMS Server Settings link.

B SMS Configuration X
SMS Configuration
Corporation 1D [ =
Password | | z

[ Cancer | “Tost|

Enter the corporation ID.

The corporation ID specifies the SMS gateways that the application must use. This is the
corporation ID that NETGEAR support gave you.

Enter the password for accessing the SMS gateway.

This is the password that NETGEAR support gave you.
Click the Test button.
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Your SMS configuration settings are verified.
10. Click the Submit button.

Your changes are saved.

Get Started
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Discover and Manage Resources

Find and manage the devices on your
network

Before you can manage your network, you must let the application find the devices that are on
your network and perform other setup tasks that could simplify the management of your network.

This chapter covers the following topics:

Discovery Concepts

Use Quick Discovery to Discover Devices on Your Network

Use a Discovery Profile to Discover Devices on Your Network

View and Manage the Wired and Wireless Devices on Your Network
Manage Device Groups

Search for the Switch to Which a Host Is Connected
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Discovery Concepts

You can discover devices on your network by using the following methods:

Quick discovery. Discovers devices without using a discovery profile. This method is a
quick and easy discovery method but gives you limited control over the discovery
process.

Regular discovery. Filters the devices on your network through a discovery profile that
you must configure first. This method gives you more control than the quick discovery
method but is a bit more complicated.

With both methods, the application can discover wired devices, wireless devices, NETGEAR
devices, and third-party devices that support standard SNMP MIBs.

The application can discover and monitor NETGEAR firewalls over the WAN. Firewalls can
use a static WAN IP address, dynamic WAN IP address, or WAN host name. If a firewall
uses a WAN host name, the firewall must also use DNS.

Note: By default, the application lets you discover up to 200 devices. For
information about discovering more than 200 devices, contact your
NETGEAR sales contact.

For wireless access points (APs), the nature of the AP determines whether the application
can discover the AP:

Standalone AP. An AP that is not controlled by another device and that operates in
standalone mode. This type of AP is also referred to as a Fat AP. The application can
discover and manage standalone APs just like any other network device that the
application supports.

Controller-managed AP. An AP that a NETGEAR WC7520 or WC9500 wireless
controller manages. This type of AP is also referred to as a Fit AP. After the application
discovers a wireless controller, it displays the controller-managed APs in the device table.
In this indirect way, the application can discover the controller-managed APs but cannot
manage them. You cannot back up or restore the configuration, upgrade the firmware, or
delete the access points from the application. Controller-managed APs are not
subtracted from the number of devices that the license of the application supports. The
license of the application ignores the controller-managed APs.

Discover and Manage Resources
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Use Quick Discovery to Discover Devices on Your Network

Quick Discovery is a quick and easy discovery method but gives you limited control over the
discovery process.

> To discover the devices on your network:

1.

Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.

Click the Sign In button.

The Network Summary page displays.
Select RESOURCES > DISCOVERY.

ADMIN

WIRELESS | RESOURCES | MOWITOR CONFIG ALARMS TOPOLOGY SFLOW

Metwork Discovery

[ aapromo || con o || ek bscovery — [RETIE

O name - Scheduled ¢ RetunentType & LastExecution Time
[ |gisc-ts-147.250 Bno Mot Recurrent

[ | gise-ts-hosiname Bro Not Recurrant 0BI28/201311:1500
O |sisc-wareip B Mot Recurrent 020572013 14:15:00

Rows perpage 10 B9 < [ 1 111 >

& LastExecution Status

W Succeaded
& Succesded

& New BExecution Time

e
Go RO

*

Click the Quick Discovery button.

e
Discovery Settings
Quick discovery will discover all lletgear and third-party network devices.
Select Network Type and Addresses
IP Range E [ . . ’ . . |
Select Credentials
[] Hame 4 Protocol & Port 4 Timeout(sec)
[ Defaut SMMP SNMP V2C 161 10
[] Defaut HTTP HTTP a0 L}
[[] Detfauk Telnet Telnet 23 10
[ Defautt HTTPS HTTPS 443 6
[ Detaut FYS318G HTTPS HTTPS 8080 5

td

[ haa | remore |

& Retries *

Discover and Manage Resources
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From the menu in the upper left on the pop-up window, select one of the following network
types and enter the applicable address information in the fields to the right of the menu:

IP Range
Subnet

Single IP

IP Address(es)
Hostname

Specify the credentials that pertain to the devices on your network by selecting one of the
following types of credentials:

Default SNMP

Default HTTP

Default Telnet

Default HTTPS

Default FVS318G HTTPS

Note: For the NETGEAR FVS318N, FVS336Gv2, FVS336Gv3, and

SRX5308 firewalls, use the default SNMP device credentials. For the
NETGEAR FVS318G firewall, use the default FVS381G HTTPS
device credential.

If the credential that you need is not listed in the table, do the following:

a.

C.

Click the Add button.

The Select Credentials page displays. In addition to the default credentials, the page
displays the device credentials that you added. For more information, see Add or
Modify a Device Credential on page 37.

Select one or more credentials and click the Add Selection button.
To add all credentials, click the Add All button.

The Select Credentials page closes and the selected credentials are added to the
credentials table.

Select the credential or credentials that you added.

Click the Execute button.

Discover and Manage Resources
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When the quick discovery process completes, the Quick Discovery pop-up window opens
and displays the results.

™ Quick Discovery X

Execution Result

Note: The discovery may take a while to complete, please be patient.

Status Discovery finished.

Rows perpage| 50 [ < [T /1 > [N vot

Status. « Device Name % I[P Address + Wendor #+ Device Type + Model ¥

@ Already Discovered 192.168.10.208 m Netgear Switch M4100-26G-POE ['_“
(&) Already Discovered FS752TP-NMS300 192.168.10.202 B etgear Switch FS752TP ‘ é|
@Already Discovered 192.168.10.209 m Netgear &) Switch MS5300-52G-POE+

@ Already Discovered 192.168.10.205 B vetgear Switch GSMT73525v2

@ Already Discovered GST46Tv2-SmartSw... | 152.168.10.204 m Netgear Switch G5748Tvd

@ Already Discovered JGSMT224 192.168.10.207 m Netgear ) Switch JGSMT224

{& nready Discovered 192.168.10.203 B vetgear Switch GST7S2TPS

{® Aready Discovered 192.168.10.206 Bl vetoear Switch BST52TXS

@ Unreachable 192.168.10.200

@ unreachable 192.168.10.210 ¥
| Close

Note: If a credential failure occurs, a common reason is that the device login
information changed from its default. When a credential failure occurs,
add or modify the credential and run the discovery job again. For more
information, see Add or Modify a Device Credential on page 37.

10. Click the Close button.

The Quick Discovery pop-up window closes.

Use a Discovery Profile to Discover Devices on Your
Network

A discovery profile gives you more control over the discovery process than the quick
discovery method but is a bit more complicated. The following sections describe how you can
use a discovery profile to discover devices:

1. Add or Modify a Device Credential

2. Add or Modify a Discovery Profile

3. Execute a Discovery Job or Schedule or Reschedule an Existing Discovery Job

Discover and Manage Resources
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Add or Modify a Device Credential

During the discovery process, the application must log in to devices to obtain the information
to discover and manage the devices. A device credential includes the user name, password,
and SNMP community string that allows the application to log in to the device. The user
name and password are the same user information that you use to log in to the device to
perform system configuration. The application provides default device credentials for
discovery over HTTP, HTTPS, SNMP, and Telnet, and for discovery of a NETGEAR
FVS318G firewall over HTTPS. (The NETGEAR FVS318N, FVS336Gv2, FVS336Gv3, and
SRX5308 firewalls use an SNMP device credential.)

You must configure the correct device credentials for any device that you want the
application to manage. If a device is not configured with its default credentials, do the
following:

e If a device is not configured with its default admin user password, create two new
credentials in the application, one for Telnet and another for the HTTP protocol. These
credentials contain either the admin user credential or the credential of another user with
administrative privileges.

e If adevice is not configured with its default SNMP community strings, create a credential
in the application for the SNMP protocol that contains the matching community strings.

> To add a device credential or modify an existing device credential:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICE CREDENTIALS.

DEVICE CREDENTIALS

Device Credentials (7]
| nda || eat [ potete | Rows perpage| 10 [ < | 1 |12 > Total: 12
[ Name ~ Protocol ¢ Port ¢ Timeout(sec) ¢ Refries ¢
Default FvS31 HTTF HTTF 0 B 1
rVS318G HTTPS TIPS 8080
O Default HTTP HTTP 80 3

1
O oefault HTTPS HTTPS 443 [ 1
[ Default SNMP SNMP VIC 161 10 1
[ Default Teinet Telnet 23 10 1
O non-def-215-tel-passworl Telnst 23 10 1
O non-deftel 209-passwordd Telngt ] 10 1
Telnet 23 10 1

1

1

Telnet ] 10

[ telnet-217-non-default Telnet b} 10

Discover and Manage Resources
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Add a device credential or modify an existing device credential:

e To add a device credential, click the Add button.

e To modify an existing device credential:
a. From the Device Credentials table, select a device credential.
b. Click the Edit button.

For a new device credential, the Add Credential pop-up window opens. For an existing
device credential, the Edit Credential pop-up window opens.

£ Add Credential X
Authentication > Management Interface Associated Devices

Credential General Info

Hame £ a betwee 2
Protocol SNMP V1 E
Authentication Info

Read Community

Write Community

Previous |”Hext | _. Cancel ‘

In the Credential General Info section, enter or modify the name for the credential.
From the Protocol menu, select one of the following protocols:

e SNMP V1
e  SNMP V2C
¢ SNMP V3
e Telnet

e SSH

e HTTP

e HTTPS

Depending on your protocol selection, the pop-up window might adjust to display other
fields and menus.

In the Authentication Info section, enter or modify the information for the selected protocol.

Discover and Manage Resources
38



NMS300 Network Management System Application

Note: If you are setting up a Telnet device credential for a managed switch
for which the privileged EXEC password was changed (on the Enable
Password Configuration page of the switch web management
interface), enter the privileged EXEC password in the Enable
Password field. The Enable Password field displays when you select
Telnet from the Protocol menu.

9. Click the Management Interface tab.

& Add Credential X
Authentication Management Interface > Associated Devices

form.caption.credentialinterface

Port 161 z
Timeout{sec) 5 14
Retries 2 k4

[ Previous | | next | Y | cancel |

10. Enter or modify the port number, time-out period in seconds, and the number of retries.
11. Click the Associated Devices tab.

& Add Credential X

Authentication Management Interface Associated Devices w

Associated Devices Add

&

[~ Status 4 Device Name % [P Address 4% Vendor 4 Device Type 4 Device Model £

Mo data to display!

| Previous || Hext || Cancel |

Discover and Manage Resources
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12. Click the Add button.

T Select Devices X

Filter: None Show Filter

Rows per page 1_9__!____ < [Ta > IER o

[T status # Device Name 4 |P Address % Mendor 4 Device Type % Device Mode! # Firmware Version B
m| (2] Up 192.168.10.102 192.168.10.102 Netgear & switch GSMT224v2Z 8.0.1.26
[|@®up 192.168.10.104 192.168.10.104 B netgear Switch FS726TP

| (-] Up 192.168.10.114 192.168.10.114 mNE‘tgeEr k2 switch GS728TPS 5.3.017
@ up 192 16310120 192 168 10120 B etgear Switch M5300-28G3 10.0.0.18
M| @u 192.168.10.121 192.168.10.121 m Netgear &) Switch GSM73285v2 8.0.3.20
@ up 1592.168.10.124 182.166.10.124 m Netgear Switch BSMT252PS 8.03.25
| ®u 192.168.10.125 192.168.10.125 B tetgear Switch GSMT248v2 80122
O (] Up 192.168.10.131 192.168.10.131 Netgear i) Switch GSMT7252P5 8.0338
| ®up 192 163 10140 192 168 10140 Netgear Switch GSMT22802 80129
["] o up 192.168.10.202 192.168.10.202 Netgear &) switch FS752TP 5.0233

Add Selection | | Add All || Close |

13. Select one or more devices and click the Add Selection button.
To add all devices to the device credential, click the Add All button.

The Select Devices pop-up window closes and the selected devices are added to the
Associated Devices table.

14. If you are modifying an existing device credential, to remove devices:
a. Select the devices.
b. Click the Remove button.

The devices are removed from the Associated Devices table.
15. Click the Save button.

The page closes and the new or modified device credential displays in the Device
Credentials table.

Add or Modify a Discovery Profile

A discovery profile filters the network device information that the application can detect. The
application can discover devices through an IP address range, IP subnet address, a single IP
address, a list of IP addresses, or device host name.

> To add a discovery profile or modify an existing discovery profile:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Discover and Manage Resources
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3. Click the Sign In button.

The Network Summary page displays.
4. Select RESOURCES > DISCOVERY.

WIRELESS W MOHITOR CONRIG ALARMS TOPOLOGY SFLOW ADMIN

Metwaork Discovery Q
addprofile || Editerofic [ cuickpiscoery [T Rows perpage| 10 [ < [ 1 i1 > JE T3

O name ~ Stheduled ¢ Recurent Type ¢ LastExecution Time 4 LastExecution Status 4 NextExecution Time ¢

[ | dise-tvs-147.250 B Mot Recurrent

O dise-tvs-hostname Bre Mot Recurrent OBF28/2013 11:15:00 ¥ Succeeded

O | dise-waneip [% Mot Recurrant 0052013 14:15:00 @ succesded

The page displays the existing discovery profiles.

5. Add a discovery profile or modify an existing discovery profile:
* To add a discovery profile, click the Add Profile button.
e To modify an existing discovery profile:
a. From the Network Discovery table, select a discovery profile.
b. Click the Edit Profile button.

For a new discovery profile, the Add Profile pop-up window opens. For an existing
discovery profile, the Edit Profile pop-up window opens.

™ Add Profile X
[ oo | owon | ronn |

General Info

Hame

Description Enter a string between 1 to 100

Discovery Options

D Resolve Host Hames(Attempt to resolve host name to IP Address)

D ICMP Ping Devices{Ping devices before authentication)

Discovery Filters

] vendor [] Location [] pevice Type Switc ﬂ:

Discovery Includes

D ICMP Only Devices(Discover devices that only respond to Ping)

D Unclassified Devices(Discover devices that from unknown vendors)

LLDP Option

Enable LLDP Link Discovery{Automatically discover LLDP links)

[ [ [ sove | aa)

Discover and Manage Resources
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Enter or modify the information in the following sections:
e General Info. Enter the name and description of the profile.
e Discovery Options:

- Resolve Host Names. To attempt to resolve a host name to an IP address, select
the Resolve Host Names (Attempt to resolve host name to IP address) check
box.

- ICMP Ping Devices. To monitor the node status of third-party non-SNMP
devices, select the ICMP Ping Devices (Ping devices before authentication)
check box.

« Discovery Filters. Select the discovery filters you want by vendor, location, and
device type.

e Discovery Includes. Select whether to include ICMP-only devices or unclassified
devices.

e LLDP Option. To monitor the node status of third-party non-SNMP devices, select
the Enable LLDP Link Discovery (Automatically discover LLDP links) check box.

Click the Network tab.

™ Add Profile X

Select Network Type and Addresses

Select Credentials [ Add |
[ mame & Protocal & Port & Timeout(sec) 4 Retries 'Y
[[] Defaut ShivP SHMP V2 161 10 1
[] Detaut HTTP HTTP 80 3 1
[ Detaun Telnet Telnet 23 0 1
[] Detaut HTTPS HTTPS 443 6 1
[[] Detaut Fvs HTTPS HTTPS 8080 6 1

previous | [ next | [Tl B B | close

From the menu in the upper left of the pop-up window, select one of the following network
types and enter the applicable address information in the fields to the right of the menu:

« |IP Range
e Subnet
e SinglelIP

e IP Address(es)
¢ Hostname

Discover and Manage Resources
42



NMS300 Network Management System Application

9. Specify or modify the credentials that pertain to the devices on your network by selecting
one of the following types of credentials:

Default SNMP

Default HTTP

Default Telnet

Default HTTPS

Default FVS318G HTTPS

10. If the credential that you need is not listed in the table, do the following:
a. Click the Add button.

C.

B Select Credentials x

Rowsperpage| 10 [ < [ 1 |2 > [JEEN Totat 12

] nMame + Protocal %+ Port 4 Timeout(sec) 4 Retries &
[[] Defaut FYS HTTPS HTTPS 8080 B
[[] Defaut HTTP HTTP 80 &
D Defaut HTTPS HTTPS 443 B
[ Detaut shup SNMP V2C 181 10
[] Default Teinet Telnet 23 10
[ nen-det-215-4el-passwort Telnat 28 10
[] ' non-def-tel-208-password3 Telnet 23 10
[ nen-defautt-215-4elnet Telnet 23 10
[[] non-defaul-M5300 Telnet 23 o
[ telnet-217-non-default Telnet 23 10

= = al = =t = = =

Add Selection || Addan || Ciose |

In addition to the default credentials, the pop-up window displays the device
credentials that you added. For more information, see Add or Maodify a Device
Credential on page 37.

Select one or more credentials and click the Add Selection button.
To add all credentials, click the Add All button.

The Select Credentials pop-up window closes and the credentials are added to the
Select Credentials table on the Network pop-up window (see the figure that is shown
in Step 7).

In the Network pop-up window, select the credential or credentials that you added.

11. Click the Save button.

The pop-up window closes and the new or modified discovery profile displays in the
Network Discovery table.

Execute a Discovery Job

You can execute a one-time discovery job immediately.

> To execute a discovery job:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.
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For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select RESOURCES > DISCOVERY.

WIRELESS - MONITOR CONFIG ALARMS TOPOLOGY 083 ADMIN

Metwork Discovery (2]
addprofile  I|  Editerofie | cuickbiscovery TN Rows perpage| 10 [ < [ 1 i > [JE Tomr3

O name ~ Scheduled ¢ RecumentType % LasiExecution Time + Last Execution Status % MNext Execution Time ®

[0 disc-tes-147.250 [x B8 Mot Recurrent

[ disc-ts-hosiname Bro Not Recumrent 0872972013 11:15:00 @ Succeaded

O | dise-wan-ip B Mot Recurrent 0052013 14:15:00 @ Succeeded

Select the discovery profile.
From the More menu, select Execute.

When discovery completes, the Execution Results pop-up window opens and displays the
discovered devices that the application adds to its inventory database.

B Execution Result X

Execution Result

Note: The dizcovery may take a while to complete, please be patient.

Status Discovery finished.

Rowsperpage| 10 [ < [ /26 > [N votar 254

Status. « Device Name + IP Address + Vendor 4 Device Type + Model *
&J Successful 192.168.10.28 Bl vietgear Switch G5M73285v2
@A\ready Discovered gs110tp-demo-unit 192.168.10.101 m Netgear ] Switch GS110TP
@A\ready Discovered 192.168.10.102 m Wetgear Switch GSWT224v2
(@) Already Discovered 0s72Bts-name 1921 | 192.168.10.138 B vetgear Switch G5728TS
@ Aready Discovered 192.168.10.140 B vetgear & switch GSWTZ24v2
@ Already Discovered 192.168.10.131 m Netgear k2] Switch GSMT7252PS
& nready Discovered 192.168.10.125 B vetgear Switch GSM7248v2
@ Already Discovered 192.168.10.124 m Netgear ey Switch GSMT252PS
@A\reaﬂy Discovered 192.168.10.121 m Netgear k2] Switch GSMT73285v2
@ Already Discovered mass 192.168.10.112 B vetgear Switch GST752TPS

[Close
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7. Click the Close button.

The pop-up window closes.

Note: Output files from completed resource discovery jobs are saved for the
data retention period. For more information, see Set the Data
Retention Period on page 266.

Schedule or Reschedule an Existing Discovery Job

You can schedule or reschedule an existing discovery job to occur later. This discovery job
can be one time or recurrent.

To schedule or reschedule an existing discovery job for future execution:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DISCOVERY.

o WIRELESS m MOHITOR CONRIG ALARMS TOPOLOGY 5 ADMIN
Network Discovery (7]
addprofie || Editprofie I uickDiscovery [T Rows perpage| 10 B9 < [ 1 |11 > Totalk 3
[ Name - Scheduled & Recurrent Type & LastExecution Time 4 LastExecution Status & NextExacution Time 0
O dise-tvs-147.250 B Mot Recurrent

O dise-tvs-hostname Bre Mot Recurrent OBF28/2013 11:15:00 ¥ Succeeded
O dise-wan-ip [ % B Mot Recurrant 097052013 14:1500 Q Succeaded

The page lists the existing discovery profiles in the application.

5. Select the discovery profile.
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6. Click the Edit Profile button.

™ Edit Profile X
[ oo > [ oo | _renr

General Info

Hame disc-fvs-hastname r Description Ender & s etyveen 1 10 100 ]

Discovery Options

Resolve Host Hames(Attempt to resolve host name to IP Address)

[[] ICMP Ping Devices(Ping devices before

Discovery Filters

[] vendor [] Location [[] pevice Type SWIiC

Discovery Includes

[C] 1CMP Only Devices{Discover devices that only respond to Ping)

E flied devices that from vendors)
LLDP Option
Enable LLDP Link Di W i i LLDP links)

TR o scresuc | sove | crecue JIEES

7. Take one of the following actions:
* To add a new schedule, click the Add Schedule button.
» To modify an existing schedule, click the Edit Schedule button.

Execution Type & Status

Enable No g Execution Type

v |

[ Suom: JETES

8. From the Enable menu, select Yes.
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The pop-up window adjusts to display more fields.

Execution Type & Status
Enable | Yes E Execution Type One time scheduled E
Starting On
Starting on 0972772013 18:01:00 x
EZ58 | cancel

9. Specify whether the application executes the discovery job once or on a recurring basis by
selecting one of the following options from the Execution Type menu and entering or
modifying the corresponding information:

e Onetime scheduled. This is the default selection.
In the Starting On field, enter or modify the date and time.

* Recurrent. The pop-up window adjusts to display more fields.

Execution Type & Status

Enable es g Execution Type Recurrent g
Starting On

Starting On 04/30/2013 14:59:00 z
Recurrence

Recurrence Type Weekly g

Day of the Week |7 Monday |- Tuesday |- Wednesday |- Thursday |- Friday |_ Saturday |_ Sunday
Stopping On

' End Time

* Never

[ cancl |

Enter or modify the following information:

a. In the Starting On field, enter or modify the date and time.

b. From the Recurrence Type menu, select how the schedule recurs and complete
the corresponding field or select the corresponding check boxes.
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c. Select the End Time radio button

and enter or modify the date and time in the

corresponding field, or leave the Never radio button selected, which is the

default setting.
10. Click the Submit button.

The Schedule pop-up window closes. The
discovery profile.

11. In the Edit Profile pop-up window, click the

discovery job schedule becomes part of the

Save button.

Your discovery job is executed according to the schedule that you set.

Note: Output files from completed resource discovery jobs are saved for the
data retention period. For more information, see Set the Data

Retention Period on page 266.

Remove a Device Credential

You can remove a device credential that you no longer need.

» To remove a device credential:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.
3. Click the Sign In button.
The Network Summary page displays.

4. Select RESOURCES > DEVICE CREDENTIALS.

DEVICE CREDENTIALS

Device Credentials

| ncd || eat || peiete |

[ Name =~ Profocol &
[ Default FVS318G HTTPS HTTPS

O Oefault HTTP HTTP

[ Cefault HTTPS HTTPS

O Default SNMP SNMP VIC

O Default Telnet Telnat
O non-def-215-tel-passworl Telngt
O non-deftel 208-password3 Telngl
O non-default-215-telnet Telnet
O non-default-M5300 Telnet
O teinet-217-non-default Telnet

(2]
Rowsperpage| 10 [ < | 1 |12 > Total: 12
Port ¢ Timeout(sec) ¢ Refries +

2080 [ 1
80 3 1
443 6 1
161 10 1
23 10 1
23 10 1
23 10 1
13 10 1
23 10 1
23 10 1
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5. Select the device credential.
6. Click the Delete button.

A confirmation pop-up window opens.
7. Click the Yes button.

The device credential is removed from the Device Credentials table and deleted.

Remove a Discovery Profile

If you delete a discovery job from the Jobs table, the application deletes the discovery profile
for the job automatically. For more information, see View and Manage Jobs on page 252.
You can also remove a discovery profile manually.

To remove a discovery profile manually:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DISCOVERY.

WIRELESS MOHITOR CONFIG TOPOLOGY ADMIN
Network Discovery (7]
[ naaprorie || o proie || vk dicovery | Rows perpage 0 18 < [1 i1 > [ Tour3
[ name =~ Scheduled %+ Recuwrent Type % LastExecution Time @ LastExecution Status % Mexd Exgcution Time %
[ dise-tes-147.250 B Mot Recurrent
O dise-tvs-hostname B Mot Recurrent OBF28/2013 11:15:00 @ Succeeded
O dise-wan-ip [ % B Mot Recurrant 097052013 141500 Q Succeaded

5. Select the discovery profile.
6. From the More menu, select Delete.

A confirmation pop-up window opens.
7. Click the Yes button.
The discovery profile is removed from the Network Discovery table and deleted.
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View and Manage the Wired and Wireless Devices on Your
Network

After the application discovers the wired and wireless devices on your network and adds
them to the inventory database, you can view and test the devices. The following sections
describe the tasks that you can perform:

View Device Information

View Wireless Device Information Only

Modify the Name, Location Information, and Contact Information
Remove Device Information

Synchronize a Network Device

Log In to a Device

Ping, Perform a Traceroute, or Reboot a Device

Use the SNMP MIB Browser

View and Export the Inventory Table and Interface List Table

The application polls the devices to make sure that they are still on the network. You can
change how frequently the device inventory is polled. For more information, see Set the
Inventory Polling on page 269.

View Device Information

You can see a table of devices that the application discovered in your network.

» To view the Devices table:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
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4. Select RESOURCES > DEVICES.

WIRELESS MONITOR ALARMS TOPOLOGY 0BS ADMIN

| Edt ] petete [| Resync [T Rowsperpage| 10 B4 < | 1 |15 > [ Totat 41
[ status  # Device Name = IPAddress & WACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model ¢
O eu 192168101 e 19216810230 74:44:01:90108:72 1P Address shanghal GN Switch GEMT24v2
D euv 192.168.10.104 00:22:319e:95:37 1P Address Switch GEMT3205v2
0 euw 19216810114 20:4e7191:5b:e6 1P Address san jose Switch GSTI8TPS
Deuv 1 192.168.10.120 4c80:dedn 7T B8 1P Address san jose Switch M5300-28G3
O eu 1821 19216810125 cO3 e Tchcs IP Address beljing Switch GEMT 2482
0O eu 192.168.10.201 10:00:763:06.08 1P Address Switeh GST48TPS
0O euw 192.168.10.216 28680018020 1P Address Switch GST24TV3
O eu 192.168.10.217 20:4e:7ETb:d7.9a IP Address Jung-locatioon-217 Swilch GSMI212F
Oeu 192.168.10.226 00.8eldSadale 1P Address Switch GETSITHS
0 euve 192168.10.237 192.168.10.237 30:46:93:1 60207 1P Address Switch GEM7252PS

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.
7. To view details about a device, click the device name (or IP address) for the device.

For more information, see View Device Details and Interface Details on page 95.

View Wireless Device Information Only

You can easily monitor your wireless network by displaying wireless controllers, wireless
access point (APs), wireless management systems, and active wireless clients.

Note: For information about viewing wireless clients of wireless controllers,
APs, and management systems, see Monitor Wireless Clients and
View Client Details on page 99.
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View Wireless Controller Information Only
You can display only the wireless controllers that the application manages.

To view wireless controller information:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select WIRELESS > CONTROLLERS.

MONITOR ALARMS TOPOLOGY 0BS ADMN

Wireless Controllers —0
T | e ~ Ravspersage 0 8 < (1 1 > [N Toata

[ status # Device Name = IP Address # Hostname % Managed By # MAC Address  # Location # Device Model %

0O eue
O euw
0/ eu

19216810161 P Address 2806 Be2de5N Metgear sanjose WCas00
19216810164 IP Address 209115118085 WCT520
19216810160 P Address @0:91:15:97:.71:59 WCT520

To add columns to or remove them from the Wireless Controllers table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address,
Hostname, Managed By, MAC Address, Location, Device Model, Vendor, Device Type,
Last Update Time, Hardware Version, Firmware Version, Configuration Version, Serial
Number, Contact, and Discover Time.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as name, IP address, location, model, and
status.

To hide the filter, click the Hide Filter button.
To view details about a device, click the device name (or IP address) for the device.

For more information, see View Device Details and Interface Details on page 95.
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View Wireless Access Point Information Only

You can display only the standalone APs and controller-managed APs. The application
manages the standalone APs. The controller-managed APs are managed by their wireless
controllers and display for information only.

To view wireless access point information:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select WIRELESS > AP.

RESOURCES MOWITOR CONFAIG ALARMS TOPOLOGY ADMIN

Access Points (7}
Fierione
| Deicte || Resync || webcu [T Rows perpage 10 k4 < [ 1 i1 > Total: 10
[ status & Device Name ~ Assaciated Controller IP Address ¢ Hostname 4 ManagedBy ¢ MAC Address # Location 4 Device Type 4 Device Mod|
0O eu 350-157 19216810157 IP Address 30:46:9a 1a.db-ag & standalone AP VNDAP 35(]
0O eup 62 192.168.10.162 IP Address B4:1b:5e:50:58:98 Standalone AP WHNDAPG2(
0O eup 192.168.10.167 1P Address f4ibSes018:18 & standalone AP WNDAFE6]
geuw 192.168.10.168 IP Address 24:1b5e5c:50a8 & Standalone AP WNDAPE2(]
0| @ Down 192.168.10.108 1P Address 0:91:15:a4:82:40 B controlier Managed AP WNAP320
O euv 192,168.10.163 1P Address 84:1b:5e:50 128 & standalone AP WNDAPB6(]
O @ Down 192.168.10.136 IP Address 20:4e 7158 420 Controller Managed AP WNDAF 36()
Oeuvs 192.168.10.240 IP Address 20:h0:50:88:29.60 Controller Managed AP WNDAP36(]
0O e 192168.10.103 1P Address 80:0115:a4:80:20 Controlier Managed AP WNAP320
Oeu 3 19216810150 1P Address e0:9115:6:2318 & standalone aP WNAP210
< >

To add columns to or remove them from the Access Points table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, Associated Controller,
IP Address, Hostname, Managed By, MAC Address, Location, Device Type, Device
Model, Vendor, Last Update Time, Hardware Version, Firmware Version, Configuration
Version, Serial Number, Contact, Discover Time, and Description.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as device name, device IP address, controller
name, location, device model, and status.

To hide the filter, click the Hide Filter button.
To view details about a device, click the device name (or IP address) for the device.

For more information, see View Device Details and Interface Details on page 95.
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View Wireless Management System Information Only
You can display only the wireless management systems that the application manages.

To view wireless management system information:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select WIRELESS > WMS.

ADMIN

WIMS List (7]

| petete [ resync [ weoou [T Rowsperpage| 10 B4 < | 1 |11 > [ Totan
[ status % Device Name ~ IP Address % Hostname % Managed By % MACAddress & Device Model ®
Oew 192.168.10.41 P Address c0:300e3d Teb0 WMES3E

To add columns to or remove them from the WMS List table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address,
Hostname, Managed By, MAC Address, Device Model, Vendor, Location, Device Type,
Last Update Time, Hardware Version, Firmware Version, Configuration Version, Serial
Number, Contact, and Discover Time.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.
To view details about a device, click the device name (or IP address) for the device.

For more information, see View Device Details and Interface Details on page 95.
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Modify the Name, Location Information, and Contact
Information

You can modify the device name, location information, and contact information that the
application displays for a wired or wireless device.

To modify information for a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICES.

MONITOR ALARMS TOPOLOGY 0BS ADMIN

| Edt ] petete [| Resync [T Rowsperpage| 10 B4 < | 1 |15 > [ Totat 41
[ status  # Device Name = IPAddress & WACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model ¢
0O eu 19216810102 mine | 19216810230 T444:01:900072 1P Address shanghal CH Switch GEMT224v2
D euv 192.168.10.104 00:22:319e:95:37 1P Address Switch GEMT3205v2
0 euw 19216810114 20:4e7191:5b:e6 1P Address san jose Switch GSTI8TPS
Deuv 192.168.10.120 4c80:dedn 7T B8 1P Address san jose Switch M5300-28G3
0O eu 19216810125 cO30eTichs IP Address beljing Switch GEMT248v2
0O eu 192.168.10.201 10:00:763:06.08 1P Address Switeh GST48TPS
0O euw 192.168.10.216 28680018020 1P Address Switch GST24TV3
O eu 192.168.10.217 20:4e:7ETb:d7.9a IP Address Jung-locatioon-217 Swilch GSMI212F
0O eu 19216810226 00:8ef2 5adale 1P Address Switch GET5ITHS
0O eup 19216810237 30:46:9301 b 2bT IP Address Switch GEMT252P8

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.
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7. Select the device.
8. Click the Edit button.

B Edit Device Infomation X

Edit Information
Device Hame [1927168.10213 k4
Location | BT 7

Contact [G5724Tv3_con |#
Description GS724Tv3

Other Information
Status Up Device Type Switch
IP Address 1582.168.10.213 MAC Address 28:c6:8e:01:9b:31
Discover Time 05/21/2013 17:28:32
System Object ID 1.3.6.1.4.1.4526.100.4.17

m Cancel

9. Modify the device information.
10. Click the Submit button.

The device information is updated and the pop-up window closes.

Remove Device Information

You can remove all information that the application displays for a wired or wireless device.
However, when you run another discovery job, the application might rediscover the device
and add it again to its inventory database.

» To remove information for a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select RESOURCES > DEVICES.

MONITOR ALARMS TOPOLOGY 0BS ADMIN

| Edt ] petete [| Resync [T Rows perpage| 10 4 < [ 1 lis > [N Totat 41
[ status  # Device Name = IPAddress & WACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model ¢
O euv 192168.10.102mine | 192.168.10.230 T444:01:901872 1P Address shanghal CN Switch GEMT224v2
0O ew 192 192.168.10.104 00:22:3(9e:95:37 IP Address A2y Switch GESMT3285v2
0 euw 19216810114 20:4e7191:5b:e6 1P Address san jose Switch GSTI8TPS
D euv 192.168.10.120 4cE0:dedbTT B8 1P Address san jose Switch M5300-28G3
0O eu 19216810125 cO30eTrehcs IP Address beljing Switch GEMT248v2
0O eu 192.168.10.201 10:00:763:06.08 1P Address Switeh GST48TPS
0O euw 19216810216 28680018020 1P Address Switch GST24TV3
O eu 192.168.10.217 20:4e:7ETb:d7.9a IP Address Jung-locatioon-217 Swilch GSMI212F
0O eu 6 19216810226 00:8ef2 5adale 1P Address Switch GET5ITHS
0O eu 192168.10.237 192.168.10.237 30:46:93:1b:b2:07 1P Address Switch GEM7I52PS

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.

7. Select the device.
8. Click the Delete button.

A confirmation pop-up window opens.

9. Click the Yes button.
The device is removed from the Devices table and deleted.

Synchronize a Network Device

You can time-synchronize a wired or wireless network device to the NMS300 server.

> To synchronize a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.
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2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICES.

WIRELESS MONTOR ALARMS TOPOLOGY 0 ADMIN

| Edt [| Deiete [| Resync [JMIEOR Rowsperpage| 10 4 < | 1 lis > [ Totat 41
[ status & Davice Name ~ IP Address 4 MACAddiess ¢ Hostame % Managed By % Location % Device Type % Device Model ®
O eup 192168101 B 19216810230 744401800872 IP Address shanghal CN Switch GEMT224v2
0O eu 19216810104 00:22:3198:95:37 1P Address Switch GEMT3288v2
0O eu 19216810114 20:4e:TEON ShicE IP Address an jose Switch GST28TPS
0O euvp 19216810120 4cB0dedb 7768 IP Address san jose Switch M5300-28G3
O euv 19216810125 03 0e:Thoboes 1P Address Bbeijing Switch GEMT 248v2
0O eup 192.168.10.201 10:00:7(b3.06:08 IP Address Switeh GST48TPS
Oeu 19216810.216 28:¢6:80:01:90:7b IP Address Switch GST24TV3
0O eup 19216810.17 20:4e:TETh:AT .92 IP Address Jung-locatioon-217 Switch GSMT212F
O eu 192.168.10.226 0082 5adale 1P Address Switch GSTSITHS
0O eup 192168.10.237 30:46:9a1 207 1P Address Switch GEMT252P8

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.

7. Select the device.
8. Click the Resync button.

A confirmation pop-up window opens.

9. Click the Yes button.

The device is synchronized and the confirmation pop-up window closes.
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Log In to a Device

You can log in to a wired or wireless device on your network using either the web
management interface or Telnet.

You can log in to a device when your web browser can be routed to the device. Generally,
your web browser must be on the local network side of the Internet gateway.

To log in to a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.
4. Select RESOURCES > DEVICES.

MONITOR ALARMS TOPOLOGY 0 ADMIN

| Edt || Detete [| Resync [TTORA Rows perpage| 10 4 < [ 1 lis > [N Totat 41
[ status  # Device Name = |PAddress & WACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model ¢
O euv 192168.10102mine | 192.168.10.230 Ta4a:01:801072 P Address shanghal CN Switch GEMT224v2
0O eu 192.168.10.104 00:22:319e:95:37 1P Address Switeh GSMTI285v2
0 euw 19216810114 20:4e7191:5b:e6 1P Address san jose Switch GSTI8TPS
Oeu 192.168.10.120 4cB0:dedn T8 1P Address san jose Switch M5300-28G3
0 eus 19216810125 cO-3t D Thobcs 1® Address beliing Switch GEMTZ48V2
O eu 192168.10.201 10.00:71b3.06:08 IP Address Switch GET48TPS
0O euw 19216810216 28680018020 1P Address Switch GST24TV3
Oeuw 192.168.10.217 20:4eTIT0:A7.9a IP Address JunB-locatioon-217 Switch GSMIZ12F
0O eu 19216810226 00:8ef2 5adale 1P Address Switch GET5ITHS
0 euve 192.168.10.237 30:46:93:1 60207 1P Address Switch GEM7252PS

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hostname, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.
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To hide the filter, click the Hide Filter button.

7. Select the device.
8. Take one of the following actions:
e Log in over the web management interface:

a. From the More menu, select Web GUI.
A login window for the web management interface opens.
b. Enter the user name and password.

For most NETGEAR products, the user name is admin and the password is
password.

c. Click the button that lets you log in to the device.

The name of the button depends on the device. For most NETGEAR products, the
button is called the Login button.

e Log in over a Telnet connection:
a. From the More menu, select Telnet.
A login pop-up window for the CLI opens.
b. Enter the user name and password.

For most NETGEAR products, the user name is admin and the password is
password.

Ping, Perform a Traceroute, or Reboot a Device

You can ping, perform a traceroute, or reboot a wired or wireless network device from the
LAN or WAN. Your web browser must be routed to the NMS300 server to conduct these
tasks.

» To test or reboot a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select RESOURCES > DEVICES.

WIRELESS MONITOR ALARMS TOPOLOGY 0 ADMIN

| Edt || petete [| Resync [TTORA Rowsperpage| 10 B4 < | 1 |15 > [ Totat 41
[ status  # Device Name = IPAddress & WACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model ¢
O eu 192168101 e 19216810230 74:44:01:90108:72 1P Address shanghal GN Switch GEMT24v2
D euv 192.168.10.104 00:22:319e:95:37 1P Address Switch GSM73285v2
0 euw 1 19216810114 20:4e7191:5b:e6 1P Address san jose Switch GSTI8TPS
Oeu 1 192.168.10.120 4c80:dedn 7T B8 1P Address san jose Switch M5300-28G3
O eu 1821 19216810125 cO3 e Tchcs IP Address beljing Switch GEMT 2482
O eu 192168.10.201 10.00:71b3.06:08 IP Address Switch GET48TPS
0O euw 192.168.10.216 28680018020 1P Address Switch GST24TV3
O eu 192.168.10.217 20:4e:7ETb:d7.9a IP Address Jung-locatioon-217 Swilch GSMI212F
0O eu 19216810226 00:8ef2 5adale 1P Address Switch GET5ITHS
0O eup 19216810237 30:46:9301 b 2bT IP Address Switch GEMT252P8

The page displays the devices that the application discovered.

To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.

Select the device.
Take one of the following actions:
e Ping the device. From the More menu, select Ping.

When the ping completes, a pop-up window opens and displays the results.
e Trace aroute. From the More menu, select TraceRoute.

When the traceroute completes, a pop-up window opens and displays the results.
* Reboot the device. From the More menu, select Reboot.

Even though you reboot the device, the device remains in the inventory of the
application.
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Use the SNMP MIB Browser

The SNMP MIB browser lets you retrieve information about SNMP-enabled devices directly.
The application supports SNMPv1, SNMPv2c, and SNMPv3 and all supported standard and
private MIBs. The SNMP MIB browser lets you select one of several MIB databases (such as
RFC Standard MIBs or NETGEAR Private MIBs) and navigate a MIB tree to select a specific
MIB object. You can also search for a MIB object, upload MIBs to the MIB browser, and
delete MIBs from the MIB browser.

The application displays the data that the MIB object collects, information about the selected
MIB object, and information about the SNMP credentials.

Select a MIB Object and Collect SNMP Data or Issue SNMP Commands

You can use the MIB browser to collect data from SNMP-enabled devices or issue SNMP
commands.

To select a MIB object, view information about the MIB object, and collect SNMP data
or issue an SNMP command:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICES.

MONTOR ALARMS TOPOLOGY 0BS ADMIN

| Edt [| peiete [| Resync [JMITITIRS Rowsperpage| 10 4 < | 1 |is > [ Totat 41
[ status ¢ Device Name ~ |P Address ¢ MACAddress ¢ Hostame ¢ Managed By 4 Location ¢ Device Type ¢ Device Model ¢
0O eu 192168.10102-rmine | 19216810230 T444.01:900072 P Address shanghal CN Switch EMT224v2
0O eup 192.168.10.104 192.168.10.104 00:22:3(9:95:37 1P Address Switch GEMT3288v2
0O ew 19216810114 19216810114 20:4€7E81:5hicE 1P Address san jose & switeh GST28TPS
0O ev 1 192.168.10.120 4c:60:dedb T 68 IP Address san jose Switch M5300-2863
0O eus 19216810125 c0:30eTches P Address pelling Switch GEMT248v2
0O euw 192.168.10.201 10:0d:7(63:06:08 1P Address Switeh GET43TPS
0Oeuw 19216810216 28:6:80:01:90:20 1P Address Swiltch GS5T24Tv3
Oeu 19216810217 20:4e707b:d7 95 IP Address Jung-locatioon-217 Switch GSMT212F
O eup 19216810226 00:8efrSadale IP Address Switch GETSITHS
0O eup 192.168.10.237 30:46:931b:b 207 1P Address Switch GEMT252P8

The page displays the devices that the application discovered.
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To add columns to or remove them from the Devices table, right-click the table heading

anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hostname, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and

Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and

status.
To hide the filter, click the Hide Filter button.

7. Select the device.
From the More menu, select MIB Browser.

MIB Browser

PAddress 172 28 2 11 7 Pert 161 @ crecena D) Operations | Get =] E2

MIB Groups

RFC Standard MIB: -] .
nemeEE L % 08 _—m

) (] ACCOUNTING-CONTROL-MIS
5[] ADSL-UNE-EXT-NIB
s [ ADSL-LINE-MIB

) ] ADSLTCMIB

5[] ALARIMIB

) | APPLETALK-MIB

5 ] ATM-FORUM-MIE

) ATNHNE

s ATNETC-MIE

) ) BGPAMIE

) ] ERIDGE-MB

. v
MIB Information

Name

Hame/OID Value

Status

Object ID

Syntax

Type

Access

Index

Reference

Description

The MIB browser opens in a new browser page.

9. To specify the SNMP credentials for the device that you are polling, do the following:

a. Click the Credential button at the top of the page.

Set Credential X

Protocol [sunpvs

SHMP UserName l admin | z

Authen Protocol [mone =
m Cancel |

b. From the Protocol menu, select the SNMP version.
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By default, the SNMPv3 information is displayed.

If you select SNMP V1 or SNMP V2C, specify the write community and read
community strings.

If you select SNMP V3, specify the user name and, if required, the authentication
protocol.

Click the Submit button.

10. From the menu in the upper left of MIB Groups pane, select the MIB database.

A MIB tree populates the MIB Groups pane.

11. Navigate to the MIB object.

The MIB Information pane below the MIB Groups pane displays the name and object ID
of the selected MIB trap, along with a description and other information.

If you cannot find the MIB object, search for it in the MIB tree by doing the following:

a.

d.

Click the magnifier icon next to the menu in the upper left of MIB Groups pane.
A pop-up window opens.

In the Find what field, enter your search criteria.

Click the Find Next button.

If a match is found, it is highlighted in the MIB tree.

To close the pop-up window, click the Cancel button.

12. From the Operations menu in the upper right of the page, select one of the following SNMP
commands:

Get. Collects data based on the selected MIB object.

Get Next. Collects data based on the next MIB object (relative to the selected MIB
object) in the MIB tree.

Set. Changes the value of the selected MIB object.

The SNMP SET pop-up window opens, allowing you to specify the data type and
value for the command.

Table View. Collects table data based on the selected MIB object. This command is
available only for table-related MIB objects.
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13. Click the Go button.

[MIB Browser
P Address 172 26 B 27 7 Port 161 * oD 136141147061120 Operations | Get ]
MNetgear Private MIBs o8
=l & ——
) WE-Z52-Mg ‘
) RETP-MIB Hame/OID Valuo
) RSVPUIB = T
) SECURITY-PACK-MIB :
© SFLOW-WIB
o @& sFlowilie
© [ sFlowAgent
& sFlowversion
@ SFlowAgentaddressType
& sFlowAgentiddress
o ) sFlowReTable
P Crass A Tans o
‘ i
MIB Information
Hame sFawAgenthddressType
Status  curren! t
Object!D 1361411670611
Syntax InetiddressType
Type: OBJECTTYFE
Atcess readonly
Index
Reference
Description The address hipe of the address
associated with this agent. Only iped
and g6 types are supponed

The Results List pane displays the name and object ID and the value that the MIB object
collected.

If the data collected applies to a table-related MIB object, the Table View button lets you
switch to a table view.

14. To collect SNMP data or issue an SNMP command for another MIB object, repeat Step 10
through Step 13.

15. To clear all collected data, click the Clear All button.

The Results List pane is cleared.

Add MIB Files
You can load new MIB files into the MIB browser.

» To add new MIB files to the MIB browser:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
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The Network Summary page displays.
4. Select RESOURCES > DEVICES.

HOME WIRELESS CONFIG ALARMS SFLOW

REPORTS

DEVICES

[cor [] vowte || resc [T

[ status & Device Name ~ P Address 4 MACAddress ¢ Hosiname 4 Managed By
0O eu 192168.10102-mine | 192.168.10.230 T444:01:90100.72 1P Address
0O eu 192.168.10.104 19216810104 00:22:3190:95:37 IP Address
O eus 192168.10.114 19216810114 20:4e:7F81:5hie IP Addross
Oeu 192.168.10.120 192.168.10.120 480 dedb TT 68 IP Address
Oeuv 192.168.10.125 192.168.10.125 030 Trehes 1P Address
0O eup 192.168.10.201 192168.10.201 10:00: T E0306:08 IP Address
Oeu 192.168.10.216 192.168.10.216 28:¢6:8e:01:90:7b IP Address
0O eu 192.168.10.217 192.168.10.217 20:4eTETb:dT:9a IP Address
O euvp 192.168.10.226 192.168.10.226 00:8er25ada0e IP Address
0O eu 192.168.10.237 192.168.10.237 30:46: 91 bib2ib7 IP Address

ADMIN

Rowsperpage 10 0 < | 1 5 > B Totan 41

4 Location 4 Device Type 4 Device Model @
shanghal CN Switch GEMT224v2
Switch GSMT3288v2
san jose Switch 63728TPS
san jose Switch M5300-286G3
beljing Switch GEMT248v2
Switch GET48TPS
Switch GST24Tv3
Jung-locatioon-217 Switch GESMT213F
Switch G8752THS
Switch GEMTI52PS

Note: To add MIB files to the MIB browser, you do not need to select a device.

From the More menu, select MIB Browser.

MIB Browser

1P Address T Port

==
= ,.@a

] ACCOUNTING-CONTROL-MIE

| ADSL-LINE-EXTIB @

] ADSL-LINE-MIB

] ADSL-TC-MIB

| ALARM-MIB

| APPLETALK-MIB

| ATH-FORUM-MIB
ATH-MIB
ATHM-TC-MIB

) BGPa-MIB

|| BRIDGEMIB

MIB Information

Hame

Operations | Get

RFC Stangard MIBs

Status

Object I

Syntax

Type

Access

Index

Reference

Description

The MIB browser opens in a new browser page.
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6. Click the green + icon next to the menu in the upper left of MIB Groups pane.

B Upload new MIB files X

@ Selecta MIB File Group [ RFC Standard 1iBs [+ |
Add a new MIB File Group
Select B Fies [ad | Remoe |
[] w8 Name 4 Parsing Status 4 Parsing Detail 2
No data to display!

7. Either select an existing MIB file group from the Select a MIB File Group menu or select
the Add a new MIB File Group radio button and specify the name for a new MIB file group
in the field.

8. Compose the list of MIB files to be added to the MIB browser by doing the following:

* To add one or more MIB files to the table in the Upload new MIB files pop-up window,
do the following:

a. Click the Add button.
A pop-up window opens.

b. Navigate to the MIB file or files that you want to upload and select one, several,
or all MIB files in the pop-up window.

The MIB file or files are uploaded to table in the Upload new MIB files pop-up
window.

* To remove one or more MIB files from the table in the Upload new MIB files pop-up
window, do the following:

a. Select the check boxes to the left of the MIB files in the table.

To select all MIB files in the table, select the check box in the table heading.

b. Click the Remove button.

The MIB file or files are removed from the table in the Upload new MIB files
pop-up window.

9. Click the Submit button.
The MIB file or files on the list are saved in the group that you specified in Step 7.
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Remove a MIB File

You can remove a MIB file MIB browser. For example, you can remove a MIB file that is
obsolete.

To remove a MIB file from the MIB browser:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICES.

MONTOR CONFIG ALARMS TOPOLOGY REPORTS 0 ADMIN

| Edt J| Detete || Resync [INITTIRS Rowsperpage| 10 [ < | 1 |is > [ Totat 41
[ status & Device Name ~ |P Address 4 MACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model @
O euve 192168.10102-mine | 192.168.10.230 744401800872 IP Address shanghal CN Switch GEMT224v2
0O euw 192.168.10.104 192.168.10.104 00:22:3192:95:37 1P Address Switch GEM73285v2
0Oeuw 192.168.10.114 19216810114 20:4€7E81:5hicE 1P Address san jose Switch GST28TPS
0Oeuv 16216810120 192.168.10.120 4¢60dedn 7T 68 IP Address san jose Switch M5300-28G3
O eu 192.168.10.125 19216810125 c0:3 0 Trebies IP Address beljing Switch GEMT248v2
0O eup 182.168.10.201 192.168.10.201 10:00:7163:06:08 1P Address Switeh GST48TPS
0Oeuw 2 19216810216 280680018070 1P Address Switch GST24TY3
0O eu 19216810217 20:4e7¢70:47:9a 1P Address Jung-locatioon-217 Switch GESMT213F
O eu 10,2 192.168.10.226 00:8er25adale 1P Address Swilch GET5ITHS
0O eu 192.168.10.237 192.168.10.237 30:46:951 bib2bT 1P Address Switeh GEMT252P8

Note: To remove a MIB file from the MIB browser, you do not need to select
a device.
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From the More menu, select MIB Browser.

MIB Browser

1P Address * Pont 4 on Operations | Get -]
MIB Groups Result Table.
RFC Standard MIBs -
& & °@ Result List
5 ] ACCOUNTING-CONTROL-MIB =
5 [ ADSL-LINE-EXT-MIS omeioD vae
& ] ADSL-LINE-MIB
& ] ADSLTCIB
& ] ALARM-MIB
G ] APPLETALK-MIE
5[] ATU-FORUIHMIE
5 [ AT
3 ] ATM-TC-ME
5 || BGP4-MIB
5 | BRIDGE-MIB o
3 8

Type
ACcess
Index
Reference

Description

The MIB browser opens in a new browser page.

Navigate to the MIB object.

The MIB Information pane below the MIB Groups pane displays the name and object ID

of the selected MIB trap, along with a description and other information.

If you cannot find the MIB object, search for it in the MIB tree by doing the following:

a. Click the magnifier icon next to the menu in the upper left of MIB Groups pane.

A pop-up window opens.
b. Inthe Find what field, enter your search criteria.
Click the Find Next button.
If a match is found, it is highlighted in the MIB tree.
d. To close the pop-up window, click the Cancel button.
Click the red x icon next to the menu in the upper left of MIB Groups pane.
A confirmation pop-up window opens.
Click the Yes button.
The MIB file is deleted.
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View and Export the Inventory Table and Interface List Table

You can view the table of wired and wireless devices and interfaces that the application
manages, and export this table to an Excel or PDF file.

» To view and export the Inventory table and Interface List table:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > INVENTORY.

Inventory (7]
| Exporttobxcel || ExporttoPoF | Rowsperpage| 10 B4 < [ 1 |15 > Total: 41
Slatus # Device Name ~ P Address % MAC Address ¢ Hostname % Managed By # Location ® Device Type % Device Model L
@ up 19 0102mine | 192.168.10.230 T4:44:01:9000:72 IP Adidress shanghai CN Swilth GSMT224%2 |

e up 192.168.10.104 00:22:39e-85:37 IP Address Switch GSMT3285v2

eu 182.168.10.114 2048719150006 IP Address san jose Switch GST28TPS

o up 192.168.10.120 4cB0dedb: 7T 68 IP Address san jose Switch M5300-28G3

@ up 5 19216810125 c0:300e: T lebics IP Address beljing Switch GEMT 248v2

e up 19 0.201 192.168.10.201 10:0d:T103:06:08 IP Address Swileh GST4ETPS

© Up 192.168.10.216 192.168.10.216 28:¢6:82:01:90:2b 1P Address Switch GST24Tv3

e up 19 0.217 192.168.10.217 204e:TIT:AT.9 IP Address Juné-locatioon-217 Swilth GSMT212F

eu 6 182.168.10.226 00:8ef2 5ada e IP Address Swilth GETSITHS

e up 19216810237 30:46:9a 100207 IP Address Switeh G8MT252PS

Interface List (7]
Rowsperpage| 10 B4 < [ 1 |r32 > [ Totaran

Index  ~ Name # Interface Type # Admin Status# Operation Status # Speed(Mbps) + MTU *

1 151 ethemalCsmacd @ up @ Down 1000 1500

2 1092 ethemetCsmacd @ up @ Down 1000 1500

3 1193 ethemelCsmacd eup @ Down 1000 1500

4 194 ethemetCsmacd e up @ Down 1000 1500

5 15 ethemetCsmacd @ up @ up 1000 1500

B 1198 ethemetCemacd @ up @ Down 1000 1500

7 1ig? ethemetGsmacd @ up @ Down 1000 1500

8 1798 ethemelCsmacd o up @ Down 1000 1500

L] 19 ethemetCsmacd eu @ Down 1000 1500

10 11510 ethemetCsmacd @ up ® Down 1000 1500

5. To add columns to or remove them from the Inventory table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
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Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as device type, device name and IP address,
device model, and status.

To hide the filter, click the Hide Filter button.

To view interfaces for a specific device, click the table row for the device anywhere but in the
Device Name column.

To view details about an individual device or interface, in the Device Name column, click the
device name (or IP address), or, in the Name column, click the interface name.

For information about viewing device details, see View Device Detalils and Interface
Details on page 95.

9. Click the Export to Excel button or the Export to PDF button.
10. To save the device information on your computer, follow the directions of your browser.

Manage Device Groups

To simplify the management of networks with many devices, you can create device groups.
Once they are discovered, you can group the devices on your network by location, device
type, and other criteria.

You can create static and dynamic device groups:

Static device group. A fixed group of specific devices that you add manually. For more
information, see Add or Modify a Static Device Group on page 71.

Dynamic device group. A dynamic list of devices that are selected automatically based
on your filter selection criteria. For more information, see Add or Modify a Dynamic
Device Group on page 73.

For general information about device groups, see Device Groups on page 12.

Add or Modify a Static Device Group

A static group is a fixed list of specific devices. You must add devices manually.

> To add a static device group or modify an existing static device group:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.
For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICE GROUPS.

DEVICE GROUPS

Device Groups (7]
Add Static Group || Add Dynamic Group [ EditGroup || Delete Group Rows perpage| 10 b < [ 1 i1 > Total: §

[J Group Name ~ Group Type % Device Count % Created By # Create Time %

O Al Netgear Devices ﬁ Chymamic Group 40 admin 04r22i201311:59:52

O a By Static Group 0 admin 090372013 18.06:06

O managed-swilch By Static Group [1] admin 080372013 18:04:54

[ smart-swicth By Static Group 0 admin 09022013 18:04:23

0O we Sy Static Group [ adrmin 09032013 18:05:16

5. Add a static device group or modify an existing static device group:
* To add a static device group, click the Add Static Group button.

e To modify an existing static device group:
a. From the Device Groups table, select the static device group.
b. Click the Edit Group button.

For a new static device group, the Add Static Device Group pop-up window opens. For an
existing static device group, the Edit Static Device Group pop-up window opens.

!® pdd Static Device Group x

Basic Information

Group Hame

Description Enter a g between 1 to & J

Associated Devices | Ada |

[~ Status % Device Name - [P Address 4 Vendor 4 Device Type 4 Device Model *

No data to dispiay!

IETE | cancel

6. Enter or modify the group name.
7. Enter or modify the description.
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8. Click the Add button.

B select Devices X

Filter: Hone " Show Filter

Rows per page 17077“7 < 141 > EEN oo

_I__ Status 4% Device Name - [P Address % Vendor # Device Type # Device Model # Firmware Version *

Mo data to display!

| Add Selection || Add Al || Close |

9. To filter the devices that display in the pop-up window, click the Show Filter button.

You can filter the devices by criteria such as device type, device name and IP address,
location, device model, and status.

To hide the device filter, click the Hide Filter button.

10. In the Select Devices pop-up window, select devices for the group.
11. Click the Add Selection button.

To add all devices, click the Add All button.

12. If you are modifying an existing static device group, to remove devices:
a. Select the devices.
b. Click the Remove button.

The devices are removed from the Associated Devices table.
13. Click the Submit button.

The pop-up window closes. The devices are added to the static device group, and the
group is displayed in the Device Groups table.

Add or Modify a Dynamic Device Group

A dynamic group is a dynamic list of devices that are selected automatically based on your
filter selection criteria. The list changes automatically as devices that meet the filter criteria
are added to and removed from the network.

> To add a dynamic device group or modify an existing dynamic device group:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.
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2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.
3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICE GROUPS.

Device Groups
Add Static Group || Add Dynamic Group || EditGroup || Delete Group

[J Group Name ~ Group Type % Device Count # Created By
O ANl Netgear Devices ﬁ Crynamic Group 40 admin

O & By Static Group i] admin

[ Wanaged-switch By Static Group 0 adrmin

[ smart-swicth Ny Static Group 0 admin

0O we Sy Static Group [ admin

Rows perpage| 10 B < [ 1 i1 > Totak §

2]

% Create Time %
042212013 11:59:52
090372013 18.06:06
090X201318:04:54
09032013 18:04:23
0832013180516

5. Add a dynamic device group or modify an existing dynamic device group:
e To add a dynamic device group, click the Add Dynamic Group button.

* To modify an existing dynamic device group:

a. From the Device Groups table, select the dynamic device group.

b. Click the Edit Group button.

For a new dynamic device group, the Add Dynamic Device Group pop-up window opens.
For an existing dynamic device group, the Edit Dynamic Device Group pop-up window

opens.

! Add Dynamic Device Group X

Basic Information

Group Name

Description Enter a string between 1 to 5 J

Device Selection Filter

[~ Vendor

[T Location

[™ Device Type Switch v |
[~ Device Model

[T Contact

[ view Devices | ISR | cancel |

6. Enter or modify the group name.
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7. Enter or modify the description.
8. Enter or modify the criteria for the device selection filter.

You can filter by device vendor, device location, device type, device model, and device
contact. You can select more than one filter. To filter by device type, make a selection
from the Device Type menu.

9. To view the devices in the group before you save the group, select the View Devices
button.

The devices that meet the selection criteria are displayed.
10. Click the Submit button.

The pop-up window closes. The devices are added to the dynamic device group, and the
group is displayed in the Device Groups table.

Remove a Device Group

You can remove a device group that you no longer need.

To remove a device group:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select RESOURCES > DEVICE GROUPS.

DEVICE GROUPS

Device Groups (7]
Add Static Group || AddDynamic Group I EditGroup | Delete Group Rowsperpage| 10 B9 < [ 1 i1 > Total §

[J Group Name ~ Group Type # Device Count 4 Created By # Create Time %

O Al Netgear Devices 8§ Cynamic Group 40 admin 04202013 11:50:52

O & Sy Static Group [1] admin 09032013 18.:06:06

[ Wanaged-switch Sy Static Group 0 admin 0902013 18:04:54

[ smart-swicth Sy Static Group 0 admin 09032013 18:04:23

0O we Sy Static Group [ admin 09032013 18:05:16

5. Select the device group.
6. Click the Delete Group button.
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A confirmation pop-up window opens.

Click the Yes button.
The device group is removed from the Device Groups table and deleted.

Search for the Switch to Which a Host Is Connected

You can enter an IP address or MAC address of a device (that is, a host) and let the
application search for the switch in your network to which the host is directly connected.

> To search for a switch to which a device is directly connected:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select RESOURCES > SEARCH HOST.

Search Host (7]

i =

Host P Address or MAC Address to search for |

Host Info
IP Address
MAC Address

Rowsperpage[ 10 [ < 1 /0 > [ oo

System Name & Model ¢ IPAddress # MAC Address # Connect Port *

Neo data to display!

In the Host IP Address or MAC Address to search for field, enter an IP address or MAC
address.

Click the Apply button.
If a match is found, the table displays information about the switch to which the host is

connected, including the system name, model, IP address, and MAC address of the
switch and the switch port to which the host is connected.
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Monitor Devices and the Network

Monitor how devices and the network
perform

You can view summary and detailed information about the network, devices, and interfaces,
including real-time and historical information and performance statistics. You can also enable
and disable the configuration monitors, view and export the audit logs, view firmware versions,
and view NMS300 server information.

This chapter covers the following topics:

Monitor the Network

Monitor the Top 10 Widgets for All Devices

View the Wireless Summary and Monitor the Top 10 Widgets for Wireless Devices
View Device Details and Interface Details
Monitor Wireless Clients and View Client Details
Manage the Configuration Monitors

Customize the Optional Network Dashboard
View and Export Audit Logs

View Firmware Version Information

View the NMS300 Server Information

View Application Notifications
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Monitor the Network

You can monitor the network by various criteria and you can customize the information that
displays on the Network Summary page.

View the Default Network Summary

If you did not customize the Network Summary page, the page displays a device tree, an
enterprise network map, a physical representation of the status and device type of the
inventory, and various top 10 widgets.

» To view the default network summary:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
NETGEAR T -

Walcome [ | J o. # O
o | weniss | esers | woron | o | sames | vrorr | o | woms | ome | v | om |
etwork Summary
Device Tree View ©  Enterprise Network Map @
Group By [ Locatan = J
© @ ksl 0 FUsI186 w:.ra.m
@ mass

s @ shanghal CN

s @ sanjose

. @ Netgear sanjose

o @ netgear

© @ JuneBlocation-215
© @ Jund-locatioon-217
& @ Junt-location-W5300
;@ germany

w @ velling ’ mv‘?-‘a ‘U‘?ZSTEN

5 © Unknown gi""’i‘}!f&‘ﬁ!??« : ﬁ”’”ﬂ s ozs“
iy Juty FAp3zn P

W"uémils—namﬁﬁ "-‘E! ucwuuﬂ&’!ﬁﬂ swlmﬂlidlﬁ
Dewice Inventory Status/Device Type (7] Top 10 Devices by Average CPU (Today) (7]
Dwce Name Dece Type GPU Utiization
Device Status Desice Type @ 19216810125 & switch 1 —
O [ standaione 22 L] & switch T
B cawn [ rirewall L] & standatone AP (=315
O switch @3 & standalone AP [k —
[ Router Y & standaione AP @RS
O Contraller Manage | g B standaione AP | EETTEN
B wus LY & standatone ap -
[ wireless Contral ° T ——
@ Juni 3 & standalone AP L
© jim B switch R
(7] Latest 10 Alams. (7]
Device Type. Memory Utilization. “Alarm Name Device Name Severfty Alarm Time
& standaione 4P [T — Wax station limitalion reached rineari4831E 08052013 17:33.21
Switch — " — Device Memory ublization is oy, 2 | nor REGEEERESTRN
B [l— - —
Bwiteh — 2 -
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Switch [ R
Sviten — —
Svaten S
Swatch £ —
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By default, the following widgets display on the page.

Widget Description Information

Device Tree View A tree of all discovered and Group devices by:

managed devices in the network. |« | ocation (the default setting)
You can expand the tree. «  Vendor

e Device Type

« Device Group

Enterprise Network Map |A world map that displays the e Manual link
location of each device and its e LLDP link
connections to other devices « < 1.5 Mbps link

e« >= 1.5 Mbps < 10 Mbps link
e >= 10 Mbps < 100 Mbps link
e >= 100 Mbps < 1 Gbps link
e >=1 Gbps < 10 Gbps link

e >= 10 Gbps link

e Link of unknown speed

Device Inventory A slice graph displaying the device status (Up or Down) and a slice graph
Status/Device Type displaying the network breakdown per device type.

Top 10 Devices by Top 10 devices by average CPU |+ Device status

Average CPU (Today) utilization for today « Device name

« Device type
e CPU utilization in percentage

Top 10 Devices by Top 10 devices by average « Device status
Average Memory (Today) | memory utilization for today « Device name

* Device type
* Memory utilization in percentage

Latest 10 Alarms e Alarm Name
¢ Device Name
e Severity

¢ Alarm Time

4. To view details about a device, click the device name.

For more information, see View Device Details and Interface Details on page 95.

Customize the Network Summary Page

You can customize the items that display on the Network Summary page. You do not need to
be an admin user to customize the Network Summary page.

In addition to the default widgets that are shown in the table in View the Default Network
Summary on page 78, you can add the optional widgets that are listed in the following table.
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Table 1. Optional widgets for the Network Summary page

Widget Description Information
Devices

Top 10 Devices by Top 10 devices by average « Device status
Average Response Time |response time for today « Device name
(Today)

* Device type
e Average response time in ms

Top 10 Devices by Top 10 devices by average packet | Device status
Average Packet Loss loss percentage for today « Device name
(Today)

« Device type
e Average packet loss in percentage

Interfaces
Top 10 Interfaces by Top 10 interfaces by interface e Device status
Utilization (Today) utilization for today « Device name
¢ Interface status
¢ Interface name
« Ingress (Rx) utilization in percentage
e Egress (Tx) utilization in percentage
e Total utilization in percentage
Top 10 Interfaces by Top 10 interfaces by traffic rate for [« Device status
Traffic Rate (Today) today « Device name
¢ Interface status
e Interface name
¢ Ingress (Rx) traffic rate
« Egress (Tx) traffic rate
e Total traffic rate
Note: Traffic rate is stated in bps, Kbps, or
Mbps.
Top 10 Interfaces by Top 10 interfaces by total traffic for |+ Device status
Traffic (Today) today « Device name

« Interface status

e Interface name

¢ Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.
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Table 1. Optional widgets for the Network Summary page (continued)

Widget

Description

Information

Top 10 Interfaces by
Errors (Today)

Top 10 interfaces by total errors
for today

e Device status

e Device name

« Interface status

¢ Interface name

e Number of ingress (Rx) errors
e Number of egress (Tx) errors
e Total number of errors

Top 10 Interfaces by
Discards (Today)

Top 10 interfaces by total
discarded packets for today

e Device status

e Device name

e Interface status

e Interface name

* Number of discarded egress (Tx) packets
e Number of discarded ingress (Rx) packets
e Total number of discarded packets

» To customize the Network Summary page:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select HOME > NETWORK SUMMARY.
The Network Summary page displays.
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¥ Enterprise Network Map

» Device Tree View
» Device Invantory
» Alarm

» Top 10 Device

» Inferface

NMS300 Network Management System Application

5. Click the Customize Portal button.

Widgets Area

Device Tree View X

Group By | Location m

@ @& ShangHai
@ ShangHai AP
© @ GuangDong
e@s
© @ unknown
© @ ShangHai AC
@ gs110tp_ektecom
@ asd
@ netgearAOFCCE

| save | [ Remave Al || Reset || Detaut | | Heip |

Enterprise Network Map X

Device Inventory StatusDevice Tvpe x

Device Status

“O
0o v

Device Type

©

O swich

Top 10 Devices by Average CPU (Today)

Device Name Device Type CPU Utiization(%:)
® 1921820118 Switeh [ e
@ GSMT212F2 Switch [C— - —
@ M4100-26-POE_111 & switch [“— . —
© M5300-286-POE+_111333 [ —.. —
© 192188.0.124 [ o——]

Top 10 Devices by Average Memory (Today) x

© 1521680124 - EX

@ 1921680118 &) swten
@ switen
& Switch  — | ——
B Switen —)

Latest 10 Alarms X

Alarm Name Device Name Severity Alarm Time
Interface Trasmitted p GST48T_1 0410/2013

Interface recived pack GST48T_1 04/10/2013
Interface recived pack... GS728TXE_1 04M10/2012
Interface Trasmitted p... | GST28TXS_1 04M10/2013
Interface Trasmitted p... | GSTS2TXES_1 04M10/2012
Interface recived pack... GS752TXS_1 04M10/2013
Interface Trasmitted p... | M5300-28G-F... 04M10/2012
Interface recived pack... GST52TP_1 04M10/2013
interface Trasmitted p... | GSTS2TP_1 041072013
Interface recived pack... M5300-28G-F... 04M10/2013

Widget Area X

Drag the widget from left 1o here

Dvag the widget from left fo here

The page displays the widgets that are currently selected. The left side of the page

displays the Avai

Av

ble Widgets

¥ Enterprise Metwork Map

» Device Tree View

lable Widgets menu.

» Device Inventory
» Alarm
» Top 10 Device

» Interface
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6. Customize the Network Summary page by performing one of the following tasks:

* Add a widget. From the Available Widgets menu, click and drag a widget to an
empty widget area at the bottom of the page. When the widget is in the target widget
area, the widget area displays green and you can drop the widget.

Table 1 on page 80 describes the optional widgets that you can add.

* Remove a widget. In a widget area that is populated by a widget, click the X (£4) in
the upper right of the widget area.

* Adjust the widget order. To move a widget to another widget area, click and drag
the title bar of the widget. When the widget is in the target widget area, the widget
area displays green and you can drop the widget.

*  Remove all widgets. Click the Remove All button.
* Reset the Network Summary screen to its defaults. Click the Default button.

7. Repeat Step 6 until you selected all widgets that you want to display on the Network
Summary page.

8. If you are not content with your selections, click the Reset button and repeat Step 6 and
Step 7.

9. Click the Save button.
The settings are saved for your account.
10. (Optional) Select HOME > NETWORK SUMMARY.

The page displays its customized settings.

Monitor the Top 10 Widgets for All Devices

You can monitor the status and top 10 widgets for devices on the network by various criteria
and you can customize the information that displays on the Top 10 page.

View the Default Top 10 Widgets

If you did not customize the Top 10 page, the page displays the default top 10 widgets.

» To monitor the default top 10 widgets and view device details:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
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The Network Summary page displays.
Select MONITOR > TOP 10.

(7]

Top 10
Top 10 Devices by Average CPU (Today)
Device Type CPLU Utilization
& switch ——
&8 switch [ E
& standatone AP e —
& standalone ap [ mir)
& stsndalone AP [~ -y —
© 660-167 & Standalone 4P - s
9. 5 & switeh [
e & standalonesr @)
@ jimm B switch [
@ Jimmy-620-168 & standalone AP [
Top 10 Interfaces by Utilization (Today)
Davice Name Interface Narne R Uil T Ll Total
@ 19216810216 0.00% 181% 18.21%
© 19216810216 18.19% 0.00% 18.19%
© 192.168.10.237 018% 0.14% 0.30%
@ 19216810237 0.10% 0.14% 0.24%
@1 013% 0.06% 0.19%
L] 0.03% 0.03% 0.06%
e 0.01% 0.04% 0.05%
e 0.04% 0.00% 0.04%
© 192.168.10,226 0.00% 0.03% 0.03%
@ UTM150 0.03% 0.00% 0.03%
Top 10 Interfaces by Trafiic (Today)
Interface Name T Rx Tatal
o1 @ gnt 48980GE  6O0BMB 489.81 GB
© 192.168.10.216 ® ;i3 112.45MB  [489.27GB  489.38GB
@ 192.168.10.226 @ 1539 S1463MB 102087 150 6B
@ 19216810226 @ 1ig46 74251MB |[111.19MB  853.70MB
@ 1921681 I7249ME  [45413MB  83263IMB
o1 30649ME 26434 MB  B60.84 ME
@ ITE3BMB | 23936MB  S1574ME
e 33532MB  [119.95MB | 455.27 WB
@192 & 15 1M9T6MB  33406ME 45472 WB
@ Junet-215-fimmy-GSMT224v2 @ o7 168.79MB |209.06MB  377.85MB

Top 10 Devices by Average Memory (Today)
Device Name

© 192.168.10.120
@ netgeartidging
@ 1921681061

810217

@ Juneb-215-jimmy-GEMT224v2

Top 10 Interfaces by Traffic Rate (Today)

Device Name Interface Name
@ 19216810218 @ g1

Device Type

& standalone 4P
& switch

Switeh

& switch

& standatone AP
Switch

& switeh

Switch

Switch

& switch

Rx(bps)
2,206
181,929,625
165,344
96,244
126,711
13813
H¥n3
29708
a7

14,888

Fx Emors

Customize Portal

e

Memory Utilization
[

Tuibps)
182,126,565
40831
137,805
144,357
63,875
92,244
62,457
34304
14918
41620

Total

182,17
181,93
303,14
240,60
190,5¢
106,0¢
87,17¢
64,017
56,644
56,50

By default, the following widgets display on the page.

Widget

Description

Information

Top 10 Devices by
Average CPU (Today)

Top 10 devices by average CPU

utilization for today

Device status
* Device name
e Device type

e CPU utilization in percentage

Top 10 Devices by
Average Memory (Today)

Top 10 devices by average

¢ Device status

memory utilization for today « Device name

« Device type

* Memory utilization in percentage
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Widget

Description Information

Top 10 Interfaces by
Utilization (Today)

Top 10 interfaces by interface Device status

utilization for today « Device name

« Interface status

e Interface name

e Ingress (Rx) utilization in percentage
e Egress (Tx) utilization in percentage
e Total utilization in percentage

Top 10 Interfaces by
Traffic Rate (Today)

Top 10 interfaces by traffic rate for | Device status

today « Device name

e Interface status

e Interface name

« Ingress (Rx) traffic rate
e Egress (Tx) traffic rate
e Total traffic rate

Note: Traffic rate is stated in bps, Kbps, or
Mbps.

Top 10 Interfaces by
Traffic (Today)

Top 10 interfaces by total traffic for Device status

today « Device name

e Interface status

e Interface name

e Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB,
or GB.

Top 10 Interfaces by
Errors (Today)

Top 10 interfaces by total errors e Device status

for today «  Device name

e Interface status

¢ Interface name

e Number of ingress (Rx) errors
¢ Number of egress (Tx) errors
e Total number of errors

To view details about a device, click the device name.

For more information, see View Device Details and Interface Details on page 95.

To view details about an interface, click the interface name.

For more information, see View Device Details and Interface Details on page 95.
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Customize the Top 10 Page

You can customize the information that displays on the Top 10 page by adding and removing

widgets. You can also reset the page to its default information.

In addition to the default widgets that are shown in the table in View the Default Top 10
Widgets on page 83, you can add the optional widgets that are listed in the following table.

Table 2. Optional widgets for the Top 10 page

Widget

Description

Information

Top 10 Device

Top 10 Devices by
Average Response Time
(Today)

Top 10 devices by average
response time for today

Device status

Device name

Device type

Average response time in ms

Top 10 Devices by
Average Packet Loss
(Today)

Top 10 devices by average packet
loss percentage for today

Device status

Device name

Device type

Average packet loss in percentage

Top 10 Interface

Top 10 Interfaces by
Discards (Today)

Top 10 interfaces by total
discarded packets for today

Device status

Device name

Interface status

Interface name

Number of discarded egress (Tx) packets
Number of discarded ingress (Rx) packets
Total number of discarded packets

Top 10 Standalone AP

Top 10 Standalone AP by
CPU Utilization (Today)

Top 10 wireless standalone APs
by total CPU utilization for today

Device status

Device name

Device type

CPU utilization in percentage

Top 10 Standalone AP by
WLAN Utilization (Today)

Top 10 wireless standalone APs
by total WLAN utilization for today

Device status

Device name

Device type

WLAN utilization in percentage

Top 10 AP by Client
Count (Current)

Top 10 wireless standalone APs
and controller-managed APs by
number of current clients

Device status

Device name

Device type

Total number of clients
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Table 2. Optional widgets for the Top 10 page (continued)

Widget Description Information

Top 10 Standalone AP by | Top 10 wireless standalone APs « Device status
Wired traffic (Today) by traffic volume over a wired « Device name

connection for today - Device type

e Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.

Top 10 SSID
Top 10 SSID by Client Top 10 SSIDs by number of e SSID
Count (Current) current clients o Device status

¢ Device name
* Radio
e Total number of clients

Top 10 SSID by Traffic Top 10 SSIDs by traffic volume for |« SSID

(Today) today « Device status
e Device name
* Radio

e Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.

Top 10 Radio
Top 10 Radio by Client Top 10 radios by number of e Radio
Count (Current) current clients « Device status

¢ Device name
« Device type
¢ Total number of clients

Top 10 Radio by Traffic | Top 10 radios by traffic volume for |« Radio

(Today) today « Device status

e Device name

« Device type

e Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.

> To customize the Top 10 page:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
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A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select MONITOR > TOP 10.

The Top 10 page displays.

Click the Customize Portal button.

ADMIN

HOME

REPORTS

Available Widgets Widgets Area Save || Remove All || Reset || Defaun | | Help
¥ Top 10 Device Top 10 Devices by Average CPU (Today) X | Top 10 Devices by Average Memory (Today) X
@ 192.1630.118 B switen [ — 1] @ 1921680124 @ swicn —
@ GsMT2iIF-2 B switcn [ . — 0 1921880118 @ swich — ., T—
+ Top 10 Devices by Average Resp... | @ M4100-26-POE_111 B switen [“— . — 111333 @ swicn o, —

» Top 10 Devices by Average Pack 9 M5300-28G-POE+_111333 Swilch [“— . —] & 1210025 1 & swicn P |
@ 192.1630.124 B switen [ — . — @ GSMT212F-2 & swich —m—
» Interface

» Top 10 Standalone AP
» Top 10 581D

> Top 10 Radio

Device Name Intertace Name R Ui Txut Total | Denice Name: Rouibps) Tuibgs) Totzibes)
@ MSI00-20G-FOE-_111333 | @ 103 005% 0.07% 012% © gs110tp_eitecom_1 LT 4 150 43
@ gs1108p_eltecom_1 L X 005% 0.05% 0% @ gs110tp_elitecom_1 - X% 150 218 358
© M4100-26POE_111 L1y 0% 001 0.01% @ M5300-26G-POE+_111333 | @ 103 149 m 260
@ 192.1680.118 @ s 0% 0.01% % © gs110tp_eitecom_1 LT % £ 12
@ 102 1680.118 Szt 001% % s @ N530028G-POE-_111333 | @ 107 54 53 107
@ M5300-28G-POE+_111333 | @ 107 001% % 001% 9 g:110p_elitecom_1 LX) 3 &7 9%
© 1521680137 @ 001% % 0.01% © 1921620118 @ siovt &7 19 8
0 GSMT212F-2 9 o7 49 30 80
@ M5300-26G-POE+_111333 | @ 119 16 60 7%
@ GsMT212F-2 905 2 L} 0

D aces by Tra Top 10 Interface by Errors (Today) X

Device N TKE) RkB) Tota(kB) Inlerface Name TxEmors RxEmors Total
08 o 248635 537416 785,051 @ 0 4 4
2348 10513 357 584 0 0 4 4
174,289 ni03 25402 0 0 4 4
91103 1742 265,402 0 0 4 4
162,808 101805 2451 @ 0 3 3
837 139400 Pk L1 0 3 3
125,445 sz2.a97 20343 0 ] 3 3
82804 126444 209,338 0 0 3 3
69043 123500 192943 @ 0 3 3
123,900 69,043 192943 [} 0 3 3

Drrag the widget from lefi to here Dirag the widget from left 1o here
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The page displays the widgets that are currently selected. The left side of the page
displays the Available Widgets menu.

v Top 10 Device

» Interface
» Top 10 Standalone AP
» Top 10 SSID

» Top 10 Radio

= Tap 10 Devices by Average Resp,

= Top 10 Devices by Averane Pack

6. Customize the Top 10 page by performing one of the following tasks:

Add a widget. From the Available Widgets menu, click and drag a widget to an
empty widget area at the bottom of the page. When the widget is in the target widget
area, the widget area displays green and you can drop the widget.

Table 2 on page 86 describes the optional widgets that you can add.

Remove a widget. In a widget area that is populated by a widget, click the X (E4) in
the upper right of the widget area.

Adjust the widget order. To move a widget to another widget area, click and drag
the title bar of the widget. When the widget is in the target widget area, the widget
area displays green and you can drop the widget.

Remove all widgets. Click the Remove All button.
Reset the Top 10 screen to its defaults. Click the Default button.

7. Repeat Step 6 until you selected all widgets that you want to display on the Top 10 page.

If you are not content with your selections, click the Reset button and repeat Step 6 and
Step 7.

9. Click the Save button.
Your changes are saved.

10. (Optional) Select MONITOR > TOP 10.
The page displays its customized settings.

View the Wireless Summary and Monitor the Top 10
Widgets for Wireless Devices

You can monitor the wireless inventory and top 10 widgets for wireless devices on the
network by various criteria and you can customize the information that displays on the
Wireless Summary page.
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View the Wireless Summary and Default Top 10 Wireless

Widgets

If you did not customize the Wireless Summary page, the page displays the wireless
inventory and default top 10 widgets for wireless devices.

To monitor the wireless inventory, monitor the default top 10 widgets for wireless
devices, and view wireless device details:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select WIRELESS > WIRELESS SUMMARY.

WIRELESS

RESOURCES MONITOR

Wireless Summary
Wirgless Inventory
Wireless AP Status

g ue
B cown

Top 10 AP by Client Count(Current)
Device Name
9 350

@ netoeardG23Fe

Top 10 Standalore AP by Wired Traffic (Today)

CONFIG

Wireless Device Type

Device Name Device Type Rx T Total Alarmn Narme

@ 350-157 E Standalone AP 24595MB  (12751MB  3T346MB B0% utilization

[ etpean239 | = stndaloneAP 236128 _4nsamE 217065 [METERPTEIEY

e 660-163 Standalons AP 2I568MB  (1655MB | 25223M8 Mode is down

9 &2 & Standalone AP 23203MB 1114 MB 24406 MB Mian station limitation reached
@ Jin Standalone AF 23076MB 1287 MB 24365 M8 Rogue AP detact

@ Ge & standalone AP 23083MB  |1249MB | 24232MB Mode Is down

@ ne & standalone AP 0586 MB  1118MB  MT04ME Mode i down

9 ne & standaione AP 187.72MB  1088ME | 19860 ME Node is down

TOPOLOGY SFLOW

©  Top 10 SSID by Client Count (Current)
s8I0
1-110-150
0 standalone ar 350-157-5gh2
[ centrolier Manage

g wms

[ wireless Cantrelie

@  Top 10 Standalons AP by CPU Utilization (Today)

Device Type Client Count Device Mame:
& stsndatone &P 1 @ netgeari4adng
& standalone &P 1 ]

o

L1

9.

L]

'Y

@

©  Lstest 10 Wireless Alams

Mia station limiation reached

ADMIN

Device Type

& Standalone AP
& standalone AP
Standalone AP
& standalone AP
Standalone AP
& Standalone AP
& standalone AP
& Standalone AP

Severity
Critical
0W06/2013 15:1020
DAME2013 150320

Customize Portal

Radio
24GHz 1
SGHE 1

CRULtilzation
T
-
-
- s
[ —
- e
[ = —
i—

Aarm Time.

0O0E2013 18:550
0970672013 18:55.00
D0B/2013 16:06.20
OAME201316:0317

09062013 150314

MOamanm 150314

090572013 173808

(2]

Client Count
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By default, the following widgets display on the page.

Widget

Description

Information

Wireless Inventory

Status of the wireless APs and .
distribution of wireless devices in
the network

Wireless AP status:

- Number of APs that are up

- Number of APs that are down
Wireless device type:

- Number of standalone APs

- Number of controller-managed APs

- Number of wireless management
systems (WMSs)

- Number of wireless controllers

Top 10 SSID by Client
Count (Current)

Top 10 SSIDs by number of .
current clients .

SSID

Device status

Device name

Radio

Total number of clients

Top 10 AP by Client
Count (Current)

Top 10 wireless standalone APs .
and controller-managed APs by .
number of current clients

Device status

Device name

Device type

Total number of clients

Top 10 Standalone AP by
CPU Utilization (Today)

Top 10 wireless standalone APs .
by total CPU utilization for today |

Device status

Device name

Device type

CPU utilization in percentage

Top 10 Standalone AP by
Wired traffic (Today)

Top 10 wireless standalone APs .
by traffic volume over a wired .
connection for today

Device status

Device name

Device type

Ingress (Rx) traffic volume
Egress (Tx) traffic volume
Total traffic volume

Note: Traffic volume is stated in KB, MB,
or GB.

Latest 10 Wireless Alarms

Alarm name
Device name
Severity
Alarm time

5. To view details about a device, click the device name.

For more information, see View Device Details and Interface Details on page 95.
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Customize the Wireless Summary Page

You can customize the information that displays on the Wireless Summary page by adding
and removing widgets. You can also reset the page to its default information.

In addition to the default widgets that are shown in the table in View the Wireless Summary
and Default Top 10 Wireless Widgets on page 90, you can add the optional widgets that are
listed in the following table.

Table 3. Optional widgets for Wireless Summary page

Widget Description Information

Top 10 Standalone AP

Top 10 Standalone AP by | Top 10 wireless standalone APs Device status
Memory Utilization by total memory utilization for « Device name

(Today) today + Device type

* Memory utilization in percentage

Top 10 Standalone AP by | Top 10 wireless standalone APs « Device status
WLAN Utilization (Today) | by total WLAN utilization for today |« Device name

« Device type
 WLAN utilization in percentage

Top 10 SSID

Top 10 SSID by Traffic Top 10 SSIDs by traffic volume for | SSID

(Today) today «  Device status
e Device name
¢ Radio

e Egress (Tx) traffic volume
e Ingress (Rx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.

Top 10 Radio
Top 10 Radio by Client Top 10 radios by number of « Radio
Count (Current) current clients « Device status

* Device name
« Device type
¢ Total number of clients

Top 10 Radio by Traffic | Top 10 radios by traffic volume for |« Radio

(Today) today «  Device status

e Device name

« Device type

e Ingress (Rx) traffic volume
e Egress (Tx) traffic volume
e Total traffic volume

Note: Traffic volume is stated in KB, MB, or GB.

Monitor Devices and the Network
92



NMS300 Network Management System Application

» To customize the Wireless Summary page:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select WIRELESS > WIRELESS SUMMARY.
The Wireless Summary page displays.

Click the Customize Portal button.

WIRELESS | RESOURCES | mMoOMTOR ALARMS. TOPOLOGY REPORTS JOBS ADMIN

Available Widgets Widgets Area | save | Remove All | Reset | Defaun | Help

Wireless AP Status WWireless Deiice Type NETGEAR,_620-97 [] 2 24GHz 3
« Top 10 Standalong AP by Memor, 0w [ sanome s | [NETGEIR_s1.97 P el ¥
= Top 10 Standalone AP by WLAN .. 0 tomn [ Controlier Maruage | |NETGEAR_1105_%9 L] 246K 1
0 wes WG103_229 @ relg 24GHz 1
[] wireless Controlle
» Top 1058ID
» Top 10 Radio

» Device lnventory

= Alarm

Top 10 AP by Client Count{Current) Top 10 Standalone AP by CPU Utilization (Today)

x i X
Divice Type Cient Count Device Type CPU Usizaion

R

@ sndslone e 3
[= R

(@ stndalens 2P

(] Confroller Mana.., 13 T 34 & stndaione 4P O

] B suncacnere 13 ] Stndaione AP AN
] B stwncsione e 7 @ @ sungaionesr W
L] ConkollerMana_. 6 ) @ sondalenesr ETTTINT)
(] [= ERC T ] @ suntacnerr  ETTEEN

L] B sndsonerr |5 L] [PENTT T = —
L] @ suncsione 5 o @ Stndalone 4P

("] B sncaioner 4 |

on

L]

ety

Top 10 Standalone AP by Wired Traffic (Today) x Latest 10 Wireless Alarms X

Dvice Type Re T Teta Alaem Name Seventy Aatm Time

0824203095001
fur2 i ERTRL V4]

@ Soncalooe 4P S14ZUE  [453MB  SEANME | [ Devios Memory ublizaton s over
@ suncucnesP  S071M8  367MB 54508 || Rogue AP oiect

@ Stoncsooe 4P SO1BMS  [430MB  S445MB
@ Stncalcoe s S041M8  [355MB S39TMB
@ sencame s S031M8  |345u8  SaTTME
@ Stncaloe 4P 9B [434MB S358MB
@ sencsore P gp1208  ar2M8 S323uB
@ stancatore s 30388 349MB s253MB
@ swncsicee s 4303M8  [343MB  S253MB

I ISTISTSIS

Widget Area X | widget Area X

Drag the widget from left o here Drag the widge! from left to here
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The page displays the widgets that are currently selected. The left side of the page
displays the Available Widgets menu.

(oo ]

¥ Top 10 Standalone AP

=Top 10 Standalone AP by Memoar..

= Top 10 Standalone AP by WLAN ..

» Top 10SSID
» Top 10 Radio
» Device Inventory

» Alarm

Customize the Wireless Summary page by performing one of the following tasks:

e Add awidget. From the Available Widgets menu, click and drag a widget to an
empty widget area at the bottom of the page. When the widget is in the target widget
area, the widget area displays green and you can drop the widget.

Table 3 on page 92 describes the optional widgets that you can add.

« Remove a widget. In a widget area that is populated by a widget, click the X (E4) in
the upper right of the widget area.

e Adjust the widget order. To move a widget to another widget area, click and drag
the title bar of the widget. When the widget is in the target widget area, the widget
area displays green and you can drop the widget.

«  Remove all widgets. Click the Remove All button.
* Reset the Wireless Summary screen to its defaults. Click the Default button.

Repeat Step 6 until you selected all widgets that you want to display on the Wireless
Summary page.

If you are not content with your selections, click the Reset button and repeat Step 6 and
Step 7.

Click the Save button.
Your changes are saved.
(Optional) Select WIRELESS > WIRELESS SUMMARY.

The page displays its customized settings.
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View Device Details and Interface Details

You can view many details for a device and its interfaces. The detailed information that the
application can provide depends on the type of device. The Devices table can list the
following devices in the Device Type column:

Switch

Firewall

Standalone AP
Controller-Managed AP
Wireless Controller
WMS

Storage

Router

Unknown

For information about the details that the application can provide for each type of device, see
Appendix B, Device Details. For information about NETGEAR products that the application
supports, see Compatible Devices on page 14.

» To view the detailed information for a device and an interface:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
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4. Select RESOURCES > DEVICES.

MOHITOR CONFIG ALARMS TOPOLOGY 08S ADMIN

| eat J] oetete [| resync (RIS Rowsperpage| 10 [ < [ 1 15 > [ Totr 41
[ Stalus ¢ Device Name - P Address 4 MACAddress ¢ Hostname 4 Managed By 4 Location 4 Device Type 4 Device Model 4
O eu 192168.10,102-mine | 192.168.10.230 T4:44:01:900072 P Address shanghal CN Switch SEMT 224w
0O euvs 192.168.10.104 192.168.10.104 00:22:3192:95:37 1P Address Switeh GEMT3205v2
O eu 182.168.10.114 182.168.10.114 20:40:7181 5bich IP Address san jose Switch GE728TPS
0O eu 192.168.10.120 192.168.10.120 4660:dedbTT.68 1P Address san jose Swilch M5300-28G3
O eup 189216810125 192.168.10.125 0:310e:Trebcs IP Address beijing Switch GSMT248v2
0O euvs 192.168.10.201 192.168.10.201 10:00:7£03:06:08 1P Address Switeh G5748TPS
0O euw 1921 192.168.10.216 28:66:90:01 9020 1P Address Switch GET24TVE
O eus 192 192.168.10.217 20:4e:TETb:AT 93 IP Address JunB-locatioon-217 Switch GSMI212F
0O eu 182 192.168.10.226 0082 5adale 1P Address Switch GETSITHS
0O eu 192 192.168.10.237 30:46:9301 00207 IP Address Switch GEMT252PS

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.

7. Click the name of the device.
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The following figure shows the page that displays when the device that you select is a
switch.

VARELESS

MONITOR

© 192.168.10.61 > Device Detail View

Dashboara General Information

= Device Details

“Intertsce List Status.

~Traffic Wonitor Device Name

- Bandwidth Monitar Device Group(s)

= Gonfig Files 1P Adiress

- Cradential Hostname
Wanaged By
MAC Aildress
Location
Contact
Device Type

Duration From Start
Discover Time,
Last Update Thne
Last Backup Time
Systern Object I
Temperature (T

Description

Inventary Information

Vendor
Denice Model
Hardware Version
Firmwate Version
Conflguration Version
Sorial Humiber

ALARMS.

TOPOLOGY

eup

192.168.10.61

B A1 Nstgear Disvices
1921681061

1P Address
20:4e770:0870

@ switch
6 days, 2217s, 56 mins, 49 secs
0841072013 134701

1361.414526.100.11.8

340

G721 2P ProSate 12-port Gigabit L2+
Managed Switch with POE+, 10.0.1.23,

[
GSMIH2P

100123

TH11951F0016

Latast 10 Alams

Alarm Name. Bevertty. Alarm Time
o dila o spleyt

Top 10 Interface by Traffc (Today)

Ingex. Interface Name R ™ Totsl

10 o om 201948 819MB 2837 MB

5 (@ TSONB  1875MB  2654M8

Lates! 10 Config Backups

File Narie: File Tyne Create Time Size(KE)
No st to cispleyt

e

Avum

Aoverage Response Time and Packet Loss (Today)

Packet Loss

Response Time

Average CPU and Memory Uiization (Today)

CPU Uiilization

Memory Uilization

MinfMax/Average Response Time

Typé | Cobumny M Time | Last Hour -
.
.
Y T | I O

I vin (mz) [ miox (ms) [l Awerage (ms)

CPU (7]
Type [Line v Tme [Lasthour  »
1z
o —— T T~
%
.
4
H
o
14040 1450 13:00 15110 13120 13:30
W crPuutilizstion (%)
Mermary (7]
Troe [Live ] Trve [Lostbos
0
o0
0
z
o
24040 1450 13100 1520 1520 13130

I Memory Utiization (%)

The following figure shows the Dashboard menu that displays when the device that you

select is a switch.

= Device Details

* Interface List

= Traffic Monitar

= Bandwidth Monitor
= Canfig Files

= Credential
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Note: If the device that you select is an M6100 managed switch, the
Dashboard also displays the Slot List option.

8. From the Dashboard menu, select a menu option.

The page adjusts to display information that corresponds to your menu option. For
information about the details that the application can provide for each type of device, see
Appendix B, Device Details.

For switches, wireless controllers, wireless management systems, and routers, you can
display interface details.

9. To display interface details:
a. Select Interface List.

MONITOR CORFIG ALARMS TORPOLOGY 5 ADMIN

O 192168, 1061 = 6 > Imerface Detail View

Dashboard General Information (7] Traffic Information (7]
» Interface Details
« Monitor Data Status. o un Received Packets 5,652,330
« Natwork Details Operation Status eup Transmitted Packets 4,592,271
Index B Recetved Bytes 62462 MB
Hame 0% Transmifted Bytes 1.7908
Interface Type ethemetCsmatd Inbouind Exiors 0
Mac Address 20c4eTrT000BT0 Outhamnd Errors
My 1518 Inbounud Discatds L
SpeediMbps) 1000 Outbound Discards 0
Deice Hame 1921681061
Description Slot 0 Port & Gigabit- Level
Latest 10 Alams (7]
Alamn Narng Severity Alamm Tirme

No diata to display?

The following figure shows the Dashboard menu for an interface:

Dashboard

* Interface Details

= Monitor Data

= Network Details

b. From the Dashboard menu, select a menu option.
The page adjusts to display information that corresponds to your menu option.

For more information about the details that the application can provide for an
interface, see Appendix B, Device Details.
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Monitor Wireless Clients and View Client Details

The application lets you monitor the active wireless clients by wireless controller, standalone
AP, controller-managed AP, or SSID.

You can display various wireless details for each client.

» To monitor wireless clients and view details for a single client:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select WIRELESS > ACTIVE CLIENTS.

WIRELESS RESOURCES MONITOR CONFIG ALARMS TOPOLOGY 5 S SERS ADMIN

1, Mote: Please select wireless device or SSID filter first,

Active Client List (7]
Wireless Controller . .
= 0 | clear || Hide Fiter
Rowsperpage| 10 [ < [ 1 |11 > B Tomio
[ Client MAC Address « ClientIP Address ¢ Locaon ¢ APMame ¢ Associated Controller ¢ S50 4 BSSID & Prolocol ¢ Authentication Mode ¢ Duratior

No dats lo digpiad

By default, the filter for active clients is active because the Active Client List table can
display many wireless clients.

5. To hide the filter for active clients, click the Hide Filter button and go to Step 12.

6. From the Device Type / SSID menu, select Wireless Controller, Standalone AP,
Controller Managed AP, or SSID.

The name of the field to the right of the Device Type / SSID menu adjusts according to
your selection from the menu.

7. Click the dots next to the field to the right of the Device Type / SSID menu.
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A pop-up window similar to the following opens.

B Select Device X

Show Filter
Rows per page| 10 _u__ < [1 ]!l = m Total &
Status & Device Mame a Vendor & IP Address $ MACAddress & Device Type & Device Model $
O ew 350157 B vetgesr 18216810157 JodEdatadss [ Stendsione AP WHDAF3S0
O ew £20-162 B vetgeor 192168.10.162 84:1b;5e:5¢:56:08 & standsione ap WNDAPG20
O ew 660-167 B vetgesr 19216810167 84:1iSe S0 16:18 Standslone AP WNDAPEED
O 8w Jiminy-620-168 B vetoeer 19216810168 84:1b:58:5¢:5b:aB Standalone AP WNDAPE20
O ow July1 7-660-163 B vetgeer 19216810163 84:1b:SeSe fac 8 & stendsione AP WHNDAREED
© @ pown netgears4s3ns [ [T 19216810166 00:245264:8218 [ Standalone AP W03
O @ pown netgearid 02EE m Netgesr 19216810156 c43dcTal0Zed E Standalone AP WHNDAPIED
O ew netgearA523FE B vetgear 19216840150 80-01:15:86 2318 Standsione AP WNAP210
[ conce

8. To filter the devices or SSIDs that are listed, click the Show Filter button.

You can filter the devices by criteria such as hame, IP address, location, and model. You
can filter the SSIDs by criteria such as SSID name, device name, and device IP address.

To hide the filter for SSIDs or devices, click the Hide Filter button.

The following figure shows an example of a pop-up window that opens when you filter by
device IP address:

[ Select Device X

Device Hame 1P Location Device Model
192.168.10.163 ] | LU | Clear | Hide Filter
Rowsperpage| 10 B < [ 1 11 > [EH Toters
Status 4 Device Name - Vendar & P Address 4 MAC Address & Device Type 4 Device Model ®
O ®up Jub17-BB0-163 Eretoesr 19216810163 B4 1beSe St ta 18 Standalone AP WNDAPRED
X2 | concer |

9. Select the device or SSID.
10. Click the Select button.

The pop-up window closes and the empty Active Client List table displays.
11. Click the Apply button.
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The application populates the Active Client List table with the wireless clients of the
selected device or SSID.

HOME WIRELESS RESOURCES MOMITOR CONAIG ALARMS TOPOLOGY SFLOW USERS ADMIN

ACTIVE CLIENTS

1, Note: Please select wireless device or SSID filter first,
Activa Client List (7]
Device /S50 Standalone AP
Stoninions AP July 7-660-163 =] I ciear || Hide Fier
Rows perpage[ 10 [ < [ 1 |11 > [N Totar2
[ Client MAC Address = ClientIP Address % Laocation % AP Name % Associated Contraller % 55D % BSEID % Frotocol * Al
[ | 00:1 46 occa:28 0.0.0.0 ut 50-163 111-660-163-2.4 841 bsesdtanm 802.11ng Ol
O |o0:1e:2 57 0.0.0.0 111-666-163-5.0 841 biSeSd1a00 802.11na O
< >

To add columns to or remove them from the Active Client List table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Client MAC Address, Client IP Address,
Location, AP Name, Associated Controller, SSID, BSSID, Protocol, Authentication Mode,
Duration, Channel, RSSI, SNR, Transmit Power, Transmitted, Rate (Mbps), Received
Rate (Mbps), Transmitted Bytes, Received Bytes, Transmitted Packets, Received
Packets, and Status.

To view details for an individual wireless client, in the Client MAC Address column, click a
MAC address.

A page similar to the following displays.

MONITOR ALARMS TOPOLOGY SERS ADMIN

© July17 660-163 > 00:14:6c:fbzcd:28 > Client Detail View
» Client Detalls Type [ Comn | Tme [Resitme v 10Seconas | Type [Cobamn ] Time [Resitime (| [10 Seconds (v
¥ Client Monitor &0 120
30 100
= Signal Monitor a0 an
= Traflic Monitor 30 &0
0 40
w0 20
] o
2241155 22142113 22042133 22142533 2243115 22143133 22:41155 22042120 22142540 22143100 22043120 22043140
B ass1 B snr
From the Dashboard menu, select a menu option.

By default, the page displays the Signal Monitor menu option. If you select the Traffic
Monitor menu option, the page adjusts.
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The following table lists some of the dashboard options and widgets or tables that are
available for a wireless client.

Dashboard Option Widget or Table

Signal Monitor Client RSSI
Client SNR

Traffic Monitor Client Received/Transmitted Bytes
Client Data Rate

Manage the Configuration Monitors

The application provides monitors for the following device metrics:

L]

Status

ICMP ping
CPU

Memory
Temperature
Disk (for storage devices)
IP traffic

ICMP traffic
TCP traffic
UDP traffic
SNMP traffic
Interface traffic

In addition, the application provides monitors for the following server, wireless device, and
storage system metrics:

L]

NMS system server

Radio statistics

WLAN utilization

VAP statistics (wireless performance statistics of the WLAN network based on SSID)
Wired Ethernet statistics (wired performance statistics of standalone APs)

Storage temperature

Storage disk temperature

Storage disk capacity

By default, all monitors are enabled. You can disable or reenable individual monitors and
specify the information and devices that are monitored.
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For information about how to configure alarm trigger settings for these monitors, see Add a
Custom Alarm Configuration on page 176.

The following sections describe the tasks that you can perform for the configuration monitors:

e Configure an Individual Monitor

» Disable a Monitor

* Reenable a Monitor

e View or Modify the Polling Interval for a Monitor

Configure an Individual Monitor

For each individual monitor, you can modify the information and devices that are monitored.

» To configure an individual monitor:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select MONITOR > MONITOR CONFIGURATION.

MONITOR CONFIGURATION

Monitor Configuration (2]
| _edt_J] enavie || oisabie |} view Threshoid | Rowsperpags[ 0 [ < [ 1 12 > [EH Totl:23

[ Enatle 4 Monitor Name & Monitor Type 4 Polling Interval{rminutas) 4 Description )

(] Yas Device Status ICHP 3 Drevice up and down status

0O & ves Device ICMP Fing ICHP 3 Device ICMP Ping results

(] Yes Device CPU Device Key Metrics 10 CPU utilization of the device

0O &es Device Memory Device Key Metrics 10 Mernory Utilization of the device

O &ves Device Temperature () Device Key Melrics 10 Device Temperature (C)

0O @ves UTM Disk UTH 10 Disk Utilization of the UTM

O & ves Device IP Traffic Device Key Metrics 10 Dievice raffic statistics per |P protocol

(|} ‘fag Device ICMP Traffic Device Key Metrics 10 Device traffic statistics per ICMP protocol

(]} Yas Device TCP Trafic Dievice Key Metrics 10 Device traffic statistics per TCP protocol

(] Yes Device UDP Traffic Device Key Metrics 10 Deevice traffic statistics per UDP protocol

(] Yes Device SHMP Traffic Device Key Metrics 10 Device rafic statistics per SNWP protocol

0O & ves Device Interface Traffic Interface 10 Divice interface performance statistics

O & ves NMS Systerm Server Devite Key Metrics § NMS Systern Serer Monitor

0O & ves Radio Statistics Wirgless 10 Wireless performance of WLAN netwark based on radio

(]} ag WLAN Utilization Wireless 10 WLAN utilization of wireless Device

a Yas VAP Statistics Wireless 10 Wireless performance statistics of WLAN network bas,

O Yes Wired Etemel Statistics wireless 10 ‘Wired parformance statistics of Standalonge AF,

O & ves Storage Disk Temperature Monitor Storage 10 Temperature of the storage disk

O & ves Storage Temperature Monitor Storage 10 Termperature of the storage probe

0O @ es Storage Disk Storage 10 Disk Utilization ofthe storage
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5. Select the monitor.
6. Click the Edit button.

" Monitor Configuration {Device IP Traffic) X

General Inforamtion > Monitor Devices Monitor Parameters

General Info

Monitor Hame

v |
Yes E
Polling Interval(minutes) 10 Minutes a

Enable

Device traffic statistics per IP protocol
Description

B oo

7. (Optional) In the General Information pop-up window, modify the following settings:
e From the Polling Interval menu, select a polling interval.
e Enter a description.

8. Click the Monitor Devices tab.

"~ Monitor Configuration (Device IP Traffic) X
General Inforamtion Monitor Devices > Monitor Parameters
Monitor Target Devices
& All Devices
¢ Select Devices or Device Groups
Cione

9. (Optional) In the Monitor Devices pop-up window, select one of the following radio buttons:
» All Devices. Monitors all devices.

Select Devices or Device Groups. The pop-up window adjusts to let you select
devices, device groups, or both to monitor:

a. Click the Add Device button.

b. Either select individual devices and click the click Add Selection button, or click
the Add All button.
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The device or devices are added to the table on the Monitor Devices pop-up
window.

c. Click the Add Group button.

d. Either select individual devices and click the click Add Selection button, or click
the Add All button.

The device groups or groups are added to the table on the Monitor Devices pop-up
window.

10. Click the Monitor Parameters tab.

7~ Monitor Configuration (Device IP Traffic) X
General Inforamtion Monitor Devices Monitor Parameters «/

Monitor Parameters.

Available Selected

Error Packets Received
Inbound Discards

Inbound Header Errors
Outbound Discards
Outbound No Reute Discards

%2 T aw

[5ove JET

11. (Optional) In the Monitor Devices pop-up window, move parameters between the Available
Fields table and Selected Fields table by using the >, <, >>, and << buttons.

a. Inthe Available Fields table, select a parameter.
b. Click the > button.

The parameter moves to the Selected Fields table.

c. To move another parameter, repeat Step a and Step b.
12. Click the Save button.

Your changes are saved.

Disable a Monitor

By default, all monitors are enabled.

» To disable a monitor:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.
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Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select MONITOR > MONITOR CONFIGURATION.
Select the monitor.
Click the Disable button.

A confirmation pop-up window opens.
Click the Yes button.

The monitor is disabled. In the Monitor Configuration table, the Enable column displays
No for the monitor.

Reenable a Monitor

To reenable a monitor after you disabled it:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select MONITOR > MONITOR CONFIGURATION.
Select the monitor.
Click the Enable button.

A confirmation pop-up window opens.

The monitor is reenabled. In the Monitor Configuration table, the Enable column displays
Yes for the monitor.
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View or Modify the Polling Interval for a Monitor

You can view and modify the polling interval for a monitor to control how frequently the
device and network information is updated.
» To view and modify the polling interval for a monitor:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select MONITOR > MONITOR CONFIGURATION.
[iowon | cos | s [ oo | _sion | weoms | s | vare | om |

MONITOR CONFIGURATION

Monitor Configuration (7]
| edit_|J Enavie ] oisavie [J view Threshaid | Raws perpage| 20 I < [ 1 lr2 > K Totsi23

[ Enable 4 Monitor Name 4 Monitor Trpe: 4 | Polling Intervaliminutas) 4| Description ®
(] es Device Status ICHP 3 Drevice up and down status

O & ves Device ICHP Ping ICHP 3 Device ICMP Ping results

O Yas Device CPU Device Key Metrics 10 CPU utilization of the device

O & ves Device Memory Davice Key Metrics 10 Mermory Utilization of the device

O & ves Device Tempearature (<) Davice Key Metics 10 Device Temperature ()

0O @ves UTM Disk UTH 10 Disk Utilization of the UTM

O & ves Device P Traffic Dieice key Metics 10 Dievite fraffic statistics per IP protacol

(|} ‘fag Device ICMP Traffic Device Key Metrics 10 Device traffic statistics per ICMP protocol

(]} Yas Device TCP Trafic Dievice Key Metrics 10 Device traffic statistics per TCP protocol

(] Yes Device UDP Traffic Device Key Metrics 10 Deevice traffic statistics per UDP protocol

(] Yes Device SHMP Traffic Device Key Metrics 10 Device fraffic statistics per SNMP protocal

(m} Yos Device Interface Traflic Interface 10 Device interface performance statistics

O & ves NMS System Server Davice Key Metrics 5 MMS System Serer Monitor

O &ves Radio Statistics Wireless 10 Wireless performance of WLAN netwark based an radio

(]} ag WLAN Utilization Wireless 10 WLAN utilization of wireless Device

O & ves VAP Statistics Wireless 10 ‘Wireless performance statistics of WLAN network bas

(] Yes Wired Ethernet Statistics Wireless 10 ‘Wired parformance statistics of Standalone AP,

O & ves Storage Disk Temperature Monitor Storage 10 Temperature of the storage disk

(] Yas Storage Temperature Monitor Storage 10 Temparature of the storage probe.

0O & ves Storage Disk Storage 10 Disk Utilization ofthe storage

The current polling interval for each metric is listed on the page in the Polling Interval
(minutes) column.

5. Select the monitor.
6. Click the Edit button.

7. In the General Information pop-up window, from the Polling Interval menu, select a polling
interval.

8. Click the Save button.

Your changes are saved.

Monitor Devices and the Network

107



NMS300 Network Management System Application

Customize the Optional Network Dashboard

By default, the network dashboard does not display any information. If you want to use the
network dashboard, you must create and customize network views and select one or more of
these views on the network dashboard.

The following sections describe the network dashboard tasks:

e Create or Modify a Dashboard View and Launch the Dashboard View
e Remove a Dashboard View
e Customize the Network Dashboard

Create or Modify a Dashboard View and Launch the Dashboard
View
You can create dashboard views, including dashboard views that let you monitor
performance in real time.

» To create a dashboard view or modify an existing dashboard view and launch the

dashboard view:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select MONITOR > DASHBOARD VIEWS.

Dashboard Views (7]
[ add | vLaunchPopup) | Launch vew) [IREEITRG Rows perpage 10 [ < [ 1 i > [ Tomr2
[ name ~ Time Frame # Created By 4 Created Time %
O ap_radioStatistics Realtime relang OW282013 11:45:22
B SwittchPingResponseTime Realtime roland 0282013 11:43:37

By default, the application does not include any dashboard views.
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Create a dashboard view or modify an existing dashboard view:

e To create a dashboard view, click the Add button.

« To modify an existing dashboard view:
a. From the Dashboard Views table, select the dashboard view.
b. From the More menu, select Edit.

For a new dashboard view, the Add Dashboard displays. For an existing dashboard view,
the Edit Dashboard pop-up window opens.

[ Add Dashboard X

GeneralInfo > Monitors and Parameters

Monitor Parameters

Hame | Erter & : x

Time Frame [ Rest-time [~ ] Intervals (sec) 10 Seconds

Default Chart Type Line E

Source Type Device E
Device Selection (up to 10 devices) Add Device Remove
D Status & Name & P Address % Device Type & Device Model & Firmware Yersion L]

Mo date to displayl

In the Name field, enter or modify the name for the dashboard view.

From the Time Frame menu, select the time frame over which you want to view the
performance:

* Real-time. View the performance in real time. (This is the default setting.) From the
Intervals (sec) menu, select the period in seconds or minutes over which you want
the view the performance:

- 10 Seconds (This is the default setting.)
- 30 Seconds
- 1 Minute
- 2 Minutes
- 5 Minutes
e Last Hour
e Last 24 Hours
e Last 7 Days
e Last 30 Days

If you select Real Time from the Time Frame menu, select a predefined period in seconds
or minutes from the Interval menu.
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From the Default Chart Type menu, select one of the following types:

Line

Column
Column Stacked
Area

Area Stacked

10. From the Source Type menu, select either Device or Interface:

Device. Create or modify a dashboard view of devices:
a. Click the Add Device button.

The Device Selection pop-up window opens.

[ Device Selection(up to 10 devices) X

Filter: None " Show Filter
rowsperpage| 10 [ < [1 /4 > [EH ot o7

T Status # Device Name & [P Address % Vendor 4+ Device Type % Device Model 4+ Firmware Version *

M@ 192188.10.102 192.162.10.102 Bl vetgear Switch GsMT224v2 2.0.1.28

M ®u 192.168.10.104 192.162.10.104 B Netgear Switch FS726TP

N @uw 192.168.10,114 192.168.10.114 Bl netgear & swich G5728TRS 53.0.17

N @u 152168.10.120 192168 10.120 Bl netgear Switch 15300-2863 10.0.0.18

| @u 192 168.10.121 192.168.10.121 Bl vetgear Switch GsMTazEs2 80320

M @u 192168.10,124 192.168.10.124 B netgear Switch GsMr2szPs 80325

o 192188.10.125 192.162.10.125 Bl vetgear Switch asMTade 20122

N @®up 192.168.10.131 192.168.10.131 Bl netgear Switch GSM7252PS 80338

| @u 192.168.10.140 192.168.10.140 Bl netgear Switch GsM7224v2 80128

N ®u 192168.10.2 192.168.10.2 Unknown Unknown

Add Selection | | Add All || Close |

b. To filter the devices that display in the table, click the Show Filter button.
Select up to 10 devices and click the Add Selection button.

To add the first 10 devices that display in the table, click the Add All button.

d. If you are modifying an existing dashboard view, to remove devices, select the
devices, and click the Remove button.

The devices are removed from the Device Selection table.

Interface. Create or modify a dashboard view of interfaces:
a. Click the Add Interface button.
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The Interface Selection pop-up window opens.

E interface Selection(up to 10 Interfaces) X

Select Devices

Filter: Hone Show Filter
Rows per page| 10 ﬂ, < [ e > N wota a7

Status 4 Device Name ~ P Address 4 Vendor & Device Type % Device Model & Firmware Version s

@ up 192.168.10.102 192.168.10.102 Bl ietgear &) switch ‘GsMTz24v2 80126 ~

e 152168 10104 192168.10.104 B netgear Switch FS726TP E

@ 192.168.10.114 192 168.10.114 B netgear &) swicn Gs728TPS 53017

@ 192,168 10.120 192 168.10.120 B netgear &) swicn 115300-28G3 100.0.18

Qe 19216810121 192.188.10.121 B tietgear Switch ceMTIzEs 20320 L]

A T oo, G T R P o [l
Rowsperpage[ 10 [ < [1 13 > [ ot 2e

T index 4 Hame =« Inferface Type & Admin Status 4 Operation Status 4 Mac Address 4 Speed(ibps) & MU +

[mlf o sthemetCsmacd @up @ Down 74440180 1474 0 1518 ~

r o oo ethemetCsmacd @ up @ Dovin T4:44:01:90. 1474 0 1518 =

[ BTl ot ethemetCsmace o @ Dowin T444:01:00.1474 0 1518

42 o2 ethemetCsmacd @ up ® Dowin T4:44:01:90: 1074 0 1518

|3 M3 ethernetCsmacd -] Up @ Dovin T4:44:01:90: 1474 0 1518

— nMa e i b S bk - [ . Ta.EA-NAONEATE n acao M

| Add Setection | [ Add All || Close |

b. To filter the devices that appear in the table, click the Show Filter button.
From the upper table, select a device for which you want to monitor interfaces.
d. From the lower table, select the interfaces, and click the Add Selection button.

To add the first 10 interfaces that display in the table, click the Add All button.

e. To add interfaces for another device, repeat Step a through Step d.

f. If you are modifying an existing dashboard view, to remove interfaces, select the
interfaces, and click the Remove button.

The interfaces are removed from the Interface Selection table.

11. Click the Monitors and Parameters tab.

B Add Dashboard X

General Info Monitors and Parameters «

Monitors and Parameters

Monitor | Device ICMP Ping u

Available Fields

Selected Fields

Maximum Respense Time (ms)
Winimum Response Time (ms)
Average Respone Time (ms)
Packet Loss(%)

o |

£ ¥ avw

12. From the Monitor menu, select a monitor.
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The Monitor menu displays only common monitors that apply to the device types that
you select in step 10 on page 110. Your selection from the Monitor menu determines the
options that display in the Available Fields section.

13. Specify the fields and their order.

To select the fields, use the left and right arrows. To arrange their order, use the up and
down arrows.

14. Click the Submit button.

The pop-up window closes. The new or modified dashboard displays in the Dashboard
Views table.

15. Select the new or modified dashboard view.
16. Click one of the following buttons:
* Launch (Popup). A pop-up window similar to the following opens.

| Legend: M 192.163.10.120 19216810121 W 152.188.10.114 7
5 Last Hour
Maximum Response Time (ms) Minimum Response Time (ms)
e E—— S
Blook...

R Y VR

139 1645 ILSL ILST 12:03 1209 IS 121 127 133 11239 148 LLSL 1LSF 1203 1209 1205 1221 1 1233

[iose |

To close the pop-up window, click the X (§4) button.
e Launch (New). A pop-up window opens in a new browser window.

The information that displays if you click the Launch (New) button is identical to the
information that displays if you click the Launch (Popup) button.

Remove a Dashboard View

You can remove a dashboard view that you no longer need.

» Toremove a dashboard view:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select MONITOR > DASHBOARD VIEWS.
I HOME WIRELESS RESOURCES m CONRIG ALARMS TOPOLOGY

Dashboard Views (7]
[ add | vLounchopup) | Launch prewy (IS0 Rows perpage| 10 B9 < [ 1 |11 > [ Totar2
1 Mame ~ Time Frame %+ Crealed By #+ Created Time ]
O aP_RadioStatistics Reakime reland OW2BRM B 114522
D SwitchPingResponseTime Real-time roland 09282013 11:43:37

5. Select the dashboard view.
6. From the More menu, select Delete.

A confirmation pop-up window opens.
7. Click the Yes button.

The dashboard view is removed from the Dashboard Views table and deleted.

Customize the Network Dashboard

If you did not add any dashboard views (see Create or Modify a Dashboard View and Launch
the Dashboard View on page 108), the network dashboard does not display any information.
After you added one or more dashboard views, you can select a dashboard view to display
on the network dashboard.

» To customize the network dashboard:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select MONITOR > NETWORK DASHBOARD.

WIRELESS RESOURCES m ALARMS TOPOLOGY 0 ADMIN
HETWORK DASHEOARD

Network Dashboard: SwitchPingResponseTime

Legend: I 19216810120 W 13216810125 M 15216810004 19218810114 W 15216840.102-mine.
{5 Last Hour
Max Response Time (ms) Min Response Time (ms)

Chast Type | Line - Chaet Type | Line ~)

09:51  0%:37  10:03 10:09 10:1%  10:21  10:27 10:33  10:39 10043 09:51  09:37 10:03  10:09  10:1% 10:21 10:27 10:33 10:39  10:45

Average Response Time (ms) Packet Loss (%)

Chast Type | Line: v: C!m'fyulm ~)

09:51 09:57 10:03 10:0%  10:1%  10:21  10:27 10:33  10:3%  10:4%5 09:51 0957 10003 10009 10015 10:21 10:27  10:3F  10:39 10:4%

5. Click the Select View button.

Rows per page| 10 g < [ 1 ln > IEER ot s

Mame & Time Frame % Source Type %+ Crested By % Crested Time *
Cortrallers -Lasl'm Hours: .Device .rmami 'mnomaamsam
StandAloneAPs Real-time Device: raland 09M 02013 10:31:53
SwitchPingResponseTime Last Hour Device roland 09102013 10:48.26

[ select view | | Close |

If the table does not display any dashboard views, you did not create any. For information
about creating a dashboard view, see Create or Modify a Dashboard View and Launch
the Dashboard View on page 108.

6. In the table, click the dashboard view.
7. Click the Select View button.

The pop-up window closes and the selected network dashboard view displays.
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View and Export Audit Logs

The system audit logs provide information about the tasks that you performed on the network
or on the NMS300 server.

Audit logs are saved for the data retention period. For more information, see Set the Data
Retention Period on page 266.

» To view and export the application audit logs:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select ADMIN > AUDIT LOG.

HOME WIRELESS | RESOURCES | MONITOR CONRIG ALARMS TOPOLOGY REPORTS
Systern Audit Log (7]
FiNter:{Operation Time Range: Today] | ShowFiter |
[ oot ionxce | eoporttoror | Rowsperpage 0 8 < [ 1 s > [ ot as
User Marne + Category 4 Operation 4 Target 4 Status 4 Operation Time -
roland Users Login lo System MMS System ¥ Succeeded 091 02013 1005745
roland Users Exit System MM System a Succeeded 0902013 10:57:34
roland Wonitor Sel Metwork Dashboard: SwitthPingResponseTime MM System & Succesded 09 Q2013 10:48:37
roland Monitor Add D Wi ol Time MMS System @ Succesded 091 0r2013 10:48:26
roland Monitor Add D Wierwr, Swil aResponseTime MMS System ¥ Failed 091072013 10:48:17
roland Monitor Update Dashboard View: Controllers MNMS System U Sutceeded 091 0F2013 10:45:15
roland Honitor Update Dashboard View: Contrallers NMS Systern @ succeeded 0941072013 10:44:30
roland Monitor Updats Dashboard View: Controllers MMS System 0 Succesded 091 0F2013 10:44:02
roland Monitor Update Dashboard View:. Controllers MMS System ¥ Succeeded 09 0F2013 10:43:30
rolang Users Exit Systemn NMS Systemn & succesded 02013 10:42:24

To filter the log entries that display in the System Audit Log table, click the Show Filter
button.

You can filter the log entries in the System Audit Log table by criteria such as user name,
category, and operation time span.

To hide the filter, click the Hide Filter button.

Click the Export to Excel button or the Export to PDF button.
To save the audit logs on your computer, follow the directions of your browser.
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View Firmware Version Information

You can view the firmware version information for the application and for all NETGEAR
switches, NETGEAR wireless devices, and NETGEAR firewalls that the application
discovered.

» To view firmware version information:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

and Websi g
Getting Started with NMS System Settings Customize
Discover your network and add the devices you want to Set global sefings for the system and website, ‘{ Custornize the navigation and lsok of your web portal,

manage

Account Information @ Manage Monitor and Alarm = my.NETGEAR.com Account Profile
ﬁ View or modify users, or create new users. Metwork moniter, alarm and thresheld related configurations. N Configure and validate myMETGEAR.com account profile
through my NETGEAR.com Web AP

(= sFlow Manage External File Server License And Version Information
o setsFiow relsted configurstions &% Evemal File Sever configurations and File Processing with Vigw NMS300 license, supponad device Sndversion
External File Server information

>

System Backup/Restore

System BackupRestore Server Configurations and
Processing
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5. Under License And Version Information, click the NMS300 Version link.

B Version Information X

Version Information

Version numl iber 1308

Model + “ersion %
FEMP26v3 804 [#]
GEMZ24v2 804 El
GSMr248v2 804

GSMT22ERS 1000

GSM7252PS 1000

GSMPI2EFS 803

GEMPIzESY 1000

GEMT 35252 1000

KEMTZ24S 801

cEMs2ZP 1001 l

Under Version Information, the firmware version of the application displays in the
Version number field.

6. To view firmware versions of NETGEAR devices that the application discovered, click the
Switch, Wireless, Firewall, or Storage tab.

7. Click the X ()4) button.

The pop-up window closes.

View the NMS300 Server Information

You can monitor the performance information of the NMS300 server.

> To view the NMS300 server information:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select RESOURCES > NMS SERVER DETAIL.

HMS SERVER DETAIL

MS Server Detail View
General Information (7] Ayerage CPU and Memory Litilization (Today) (7]
Operating System Wicrasof Windows 7 Professional QS CPU Utilization 05 Memnary Utilization
Duwation From Start T hrg, 54 mins, 43 secs
IP address 192168104
MAC address 64-31-50-36-20-13
Total Memory 397GB
Free Memory 1.280G8
JUM Tatal Memory 904 38 MB
SV Free Memory 639,38 MB
SV Mimory WNilization (Curret) B/II%
Total Disk Space 45334 GB
Free Disk Space 5751 6B
System Health (7] Disk Lhilization History (7]
Type | Cokamn v Tme [Lanttow )
FIP Servcie eup &0
TFIP Senvice eup 50
Trap Senvice @ up @
30
Syslog Service @ up 2
DB @ Nomal 10
Monitor Polling Sendce @ Nomal L]
10113 10:25 10:35 10:45 10:55 11108
B server Disk Utilization(%s)
CPU (7] Jvivl Memory Utilization History (7]
Type [Colan v Tine [LastHouwr v Type | Cohmn v Tme [Lasthiowr v
20 40
15 30
12 .
8
4
o [
10115 1omzs 10135 10143 10135 11103 10:18 10:25 10:35 10:45 10:55 11105
B Server CPU Ltilization{%:) B server JuM Memory Utilization(%s)
Mamory (7} Latest 10 Alarms (7]
I o [ammName Severity Alarm Time
80
40
]
. 1o data bo displayl
o
B Server Memory Utilization(2:)
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View Application Notifications

The application generates a notification when a task is completed. For example, if you
initiated a firmware upgrade for one or more devices, the application generates a notification
when the upgrade is completed. The notification includes details about whether the task
completed successfully.

When the application generates one or more notifications, a small red-colored circle displays
on top of the Envelope button in the top bar at the upper right of the page. A number in the
circle indicates the number of notifications that the application generated.

> To view application notifications:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
NETGEAR
Welcome | 3@ § t)n #
[ [ wcss [ wsomecs [ wowron [ come | mamus [ ovrcor | siow | wrows | wes | v | wom |
i

HETWORK SUMMARY

Network Summary
Davice Tree View 9 Enterprize Network Map Q
Group By | Location u

- «
& @ tost o Fvsiiee i we 7830184
@ mass

o @ shanghal CN

@ @ sanjose

& @ Netgear sanjose

s @ nelgear

w @ Juneb-location-215
o @ Jung-locatioon-217
s @ Junb-location-M5300

& @ gemarny 'V i UngTEm
& @ beling Y
Unknown
i B i..n,.ﬂmti A
68104000 amedo. 188,101 mwﬂmwimﬁlmﬁ
Device Inventory Status/Device Type [7] Top 10 Devices by Average CPU (Today) (7]
Divica Nami Divice Tyne: CPU Utlization
Device Status Dievice Type @021 5 B switch (==t
O [ standalane 22 ) & switch (R
B oown [ Firewan L] & standatone AP N
[0 Switch -] & standatone AP =y
[0 Router @ & standatone ap -
O cortrolier Manage | g &3 standalone AP T
| wus -] Switch -
W Yrblese Conbiolte (-] &8 standatone AP -
L] & standatone AP [ — ) —
@ jimr & swich ST
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In the top bar at the upper right of the page, click the Envelope button.

wetcome  — 20 169 14 101

The My Notifications pop-up window opens.

B My Notifications X

My Notifications
Rows per page| 10 H < 1 > Total: 0
[ & Start Time & End Time * Applcation & Status 5

Mo data to display!

To view details about a notification, select the notification and click the Details button.
To close the pop-up window, click the X (§4) button.
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Keep your device firmware current

You can back up and restore device configurations. You can also upgrade device firmware.
This chapter covers the following topics:

» Back Up Your Device Configurations

» Restore Your Device Configurations

e Import and Export Configuration Files to an External File Server
* Upgrade Firmware for One or More Devices
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Back Up Your Device Configurations

You can back up the configurations of the NETGEAR devices on your network.

You can schedule configuration backup jobs for future execution on a recurrent basis for
batch operations.

Note: For information about backing up the application system settings, see
Back Up the System Settings on page 277.

The following sections describe the backup tasks:

e Add or Modify a Backup Profile

e Execute a Backup Job

e Schedule a Backup Job

e View the Execution Status of a Backup Job
* Remove a Backup Profile

Add or Modify a Backup Profile

A backup profile defines the devices that are included in a backup job, and as an option, the
schedule with which the backup job occurs. You must create a backup profile before you can
back up the configuration of one or more devices.

To a single backup profile, you can add devices, device groups, or both.

» To add a backup profile or modify an existing backup profile:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > BACKUP.

6.

BACKUP

Backup (7]
nddpronie || Edt || Executerronie  [INITIIN Rowsperpage| 10 [ < [ 1 i1 > Total: 3

[ mame ~ Stheguled % Recurant Type # LastExscution Time ¢ LastExecution Status % Next Exacution Time s

O |Fvs31sc B e Not Recurrant 0902013 11:49:45 ¥ Succesded

[0 Gemraze Bno Mot Recurrent 0aNr201311:4528 & Partially Succesded

O | standaloneaPs_Backup Tes Vigekly 0anER01311:52:00

The Backup page displays the existing backup profiles.

To add columns to or remove them from the Backup table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, Scheduled, Recurrent Type, Last
Execution Time, Last Execution Status, Next Execution Time, Description, Created By,
and Created Time.

Add a backup profile or modify an existing backup profile:
e To add a backup profile, click the Add Profile button.
* To modify an existing backup profile:
a. From the Backup table, select a backup profile.
b. Click the Edit button.

For a new backup profile, the Add Profile pop-up window opens. For an existing backup
profile, the Edit Profile pop-up window opens.

4 Add Profile x

General Info

Hame 1 T
Description
Backup File Setting
File Name 1 3
Version
Backup Result Notification
[ E-mail To

provious | e cioe
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7. Enter or modify the following information:
e General Info. Enter a name and description for the new profile.
* Backup File Setting. Enter a file name and version for the backup file.

e Backup Result Notification. To enable the application to send an email message
with the backup results, select the E-mail To check box and enter an email address.

8. Click the Select Devices tab.

2 Add Profile X
Select Devices > View Result

Select Target Network Devices or Groups Add Device Add Group
[~ Status 4 Entity Name 4 Enttty Type 4 IP Address 4 Vendor 4 Device Model +
No data fo display!

M oo oo | sove | coccue JET

9. Add devices, device groups, or both:
a. Click the Add Device button.

B Select Devices X

Rowsperpage[ 10 [ < | 1 |14 > [EEN votarao
[ status .0 Dml‘lﬂne - U’.MNW s Huﬁnm 0 .‘:’.ardw 0 MWTvpﬂ .l bsv;ca Model .0 .ﬁr.mware‘;‘ar.smn
O @ue 182 16810 102-mine 19216810 230 B retgear Switch GEMT224v2 50128
0O @uw 18216810104 19216810104 mNe‘geBt’ Switch GEMT3285v2 8.0.3.42
0O ew 19216810114 19218810114 B retgear Switch GS728TPS 53017
O euw 192.16510.120 19216810420 Bl netgear Switch M5300-2863 10003
0O euw 19246810125 19216810125 Blrietgear & switch GEMT 2482 80122
O ew 152.168.10.201 192.168.10.20 Bl netosar Switch GS74BTPS V5209
[ @ pown 19246510215 19216840216 Bl vetgesr Switch GETTYE 627130
0O &uw 18216810217 19218810217 B netosar & switch GSMT212F 100123
O @®uw 18246810221 19216810221 B netgear & switch KEMP2245 80430
0Oeéw 192.16310.226 19216810226 B retgesr Switch GSTS2TXS 81011
< | /]
| Add Selection || AddAll | | Close |

b. Select devices to add and click the Add Selection button.
To add all of the devices in the table, click the Add All button.
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c. Click the Add Group button.

" Show Filter

Rows per page| 10 E < [l > R vota 1

-l_ Name - Type 4 Device Count %

[ | Al Netgear Devices Dynamic Group 35

| Add Selection | Add All || Close |

d. Select device groups to add and click the Add Selection button.
To add all of the device groups in the table, click the Add All button.

The selected devices, groups, or both, display in the Select Target Network Devices or
Groups table.

10. If you are modifying an existing backup profile, to remove devices or groups:
a. Select the devices or groups.
b. Click the Remove button.

The devices or groups are removed from the Select Target Network Devices or Groups
table.

11. To add a schedule, click the Add Schedule button.

You can schedule the generation of the report for a later time or let it recur automatically.
For more information, see Schedule a Backup Job on page 127.

12. Click the Save button.
The new or modified backup profile is saved and displays on the Backup page.
13. To execute the backup job, click the Execute button.

Your backup profile is executed immediately.

Execute a Backup Job

You can execute a one-time backup profile immediately. Executing a backup profile is
referred as a backup job.

The application saves the backup configuration files on the NMS300 server and lists them on
the Restore page. You can use the backup files to restore device configurations for the
devices on your network. For more information, see Restore Your Device Configurations on
page 132.

The application saves configuration files from completed backup jobs for the data retention
period. For more information, see Set the Data Retention Period on page 266.
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> To execute a backup profile immediately:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select CONFIG > BACKUP.

Backup ?)
[ sareome | e[| exectsprome (RIS rovsporsage[ 1 < (1 > [ Towio
[ name = Scheduled # Recurrent Type # LastExecution Time # LasiExgcution Status # Mext Execution Time ®

O |Fvs3iec B e Mot Recurrent 0902013 11:49:45 & Succeeded
O | csm7aza % Mot Recument 092013 11:45:28 & Partially Succeeded
O standAlonesPs_Backup Yes Vigekly 0SNE01311:52:00

The Backup page displays the existing backup profiles in the application.

To add columns to or remove them from the Backup table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, Scheduled, Recurrent Type, Last
Execution Time, Last Execution Status, Next Execution Time, Description, Created By,
and Created Time.

Select the backup profile.
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7. Click the Execute Profile button.

4 Execute Profile X

Execution Result
Note: The Config Backup task may take a while to complete. Please be patient
Status a Succeeded
Rows per page| 10 E (R co &
Device Name 4 P Address 4 Start Time 4 End Time 4 Status - Detail +
KSMT2245_221 192.168.10.221 05/02/2013 16:11:53 05/02/2013 16:12:03 & Succesded

The Status field displays the progress of the backup job. After the job completes
successfully, the Status field displays Succeeded.

8. Click the Close button.

The pop-up window closes.

Schedule a Backup Job

You can schedule a backup job to occur later, either once or on a recurring basis.

» To schedule a backup job:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > BACKUP.

Backup
nddproie [l Edt | Exccutepromie |JIITNG Rowsperpage[ 10 B4 < [ 1 |1 > [EI Towi3
[ Name = Scheduled 4 Recument Type 4 LastExecution Time 4 LastExecution Status 4 Next Execution Time
O |Fvs3iec B e Mot Recurrent 0902013 11:49:45 & Succeeded
O csmrzzs B e Mot Recument 092013 11:45:28 & Partially Succesded
[ standionesPs_Backup B ves VipEkly 0962013 11:52:00

The Backup page displays the existing backup profiles in the application.

5. To add columns to or remove them from the Backup table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, Scheduled, Recurrent Type, Last
Execution Time, Last Execution Status, Next Execution Time, Description, Created By,
and Created Time.

6. Select the backup profile.
7. Click the Edit button.

s Edit Profile X
Select Devices View Result

General Info
Name Backup221 L4
Description TestBackup

Backup File Setting
File Hame SelectSwitches 2
Version 1.9

Backup Result Notification
[ E-mail To.

provioss | vt | ENTISETEITSN NN IR | o

Manage Configurations and Firmware
128



NMS300 Network Management System Application

8. Click the Add Schedule button.

Execution Type & Status
Enable Ho g Execution Type Dne time scheduled [v|
cance

9. From the Enable menu, select Yes.

10. Specify whether the application executes the backup job once or on a recurring basis by
selecting one of the following options from the Execution Type menu and entering the

corresponding information:
e Onetime scheduled. This is the default selection.

In the Starting On field, enter a date and time.

* Recurrent. The pop-up window adjusts to display more fields.

Execution Type & Status
Enable Yes g Execution Type Recurrent u
Starting On
Starting On 04/30/2013 14:59:00 z
Recurrence
Recurrence Type Weekly g
Day of the Week ¥ Monday ™ Tuesday [~ Wednesday [~ Thursday [~ Friday [ Saturday [~ Sunday
Stopping On
" End Time
* Never
cancel

Enter the following information:

a. Inthe Starting On field, enter a date and time.

b. From the Recurrence Type menu, select how the schedule recurs and complete
the corresponding field or select the corresponding check boxes.

c. Select the End Time radio button and enter the date and time in the
corresponding field, or leave the Never radio button selected, which is the

default setting.
11. Click the Submit button.
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The Schedule pop-up window closes. The backup job schedule becomes part of the
backup profile.

12. In the Edit Profile pop-up window, click the Save button.
The backup job is executed according to the schedule that you set.

The application saves the backup configuration files on the NMS300 server and lists them on
the Restore page. You can use the backup files to restore device configurations for the
devices on your network. For more information, see Restore Your Device Configurations on
page 132.

The application saves configuration files from completed backup jobs for the data retention
period. For more information, see Set the Data Retention Period on page 266.

View the Execution Status of a Backup Job

You can view the execution status of a backup job to ensure that a device configuration was
backed up as scheduled.

» To view the status of a backup job:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select CONFIG > BACKUP.

Backup (7]

naddproile | Edt J|  Executepromie [JNITTNG Rowsperpage[ 10 B4 < [ 1 i1 > Total: 3
[ name = Scheduled # Recurrent Type # LastExecution Time # LasiExgcution Status # Mext Execution Time ®
O rFvs31sc [ I Mot Recumrent 0B 0I2013 11,:49:45 @ Succesded

O csmr224 % Mot Recument 092013 11:45:28 & Partially Succeeded
O standAlonesPs_Backup Yes Wigekly 0SNE01311:52:00

The Backup page displays the existing backup profiles in the application.
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5. To add columns to or remove them from the Backup table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, Scheduled, Recurrent Type, Last
Execution Time, Last Execution Status, Next Execution Time, Description, Created By,
and Created Time.

Select the backup profile.
7. From the More menu, select View Execution Status.

B View Execution Status X

History Job Result

rowsperpage| 10 g < [7 /1 > X w1

Start Time:  End Time 4 Status 4+ Detail +
04/04/2013 01:49:32 04/04/2013 02:00:53 &W

Rows per page| 10 E < [17m1 > KN totat 1

Device Name # IPAddress # Start Time # EndTime # Status « Detail *

192.168.10.208 192.168.10.200 0410412013 01:49:3¢ 04/04/2013 02:00:51 & succesded

The pop-up window displays the execution history of a job and whether the job
succeeded or failed.

8. Click the Close button.
The pop-up window closes.

Remove a Backup Profile

If you delete a backup job from the Jobs table, the application deletes the backup profile for
the job automatically. For more information, see View and Manage Jobs on page 252. You
can also remove a backup profile manually.

» To remove a backup profile manually:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
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The Network Summary page displays.
Select CONFIG > BACKUP.

Backup (2]
[ aaprome || con | exocue prome [ Raws porpage B8 < [ 1 i1 > [ Toata
[ name = Scheduled # Recurrent Type # LastExecution Time # LasiExgcution Status # Mext Execution Time ®
O |Fvs3iec B e Mot Recurrent 0902013 11:49:45 & Succeeded

O | csm7aza % Mot Recument 092013 11:45:28 & Partially Succeeded

O standAlonesPs_Backup Yes Wigekly 0SNE01311:52:00

To add columns to or remove them from the Backup table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, Scheduled, Recurrent Type, Last
Execution Time, Last Execution Status, Next Execution Time, Description, Created By,
and Created Time.

Select the backup profile.
From the More menu, select Delete Profile.

A confirmation pop-up window opens.
Click the Yes button.

The backup profile is removed from the Backup table and deleted.

Restore Your Device Configurations

You can restore the configurations of the devices that the application manages on your
network, as follows:

Single device. You can restore the configuration of a single device on your network. For
more information, see Restore the Configuration of a Single Device on page 133.

Several identical devices. You can use the configuration of one of the devices on your
network to create a configuration template for several identical devices on your network.
For more information, see Customize and Promote a Configuration File on page 137 or
Promote a Configuration File for an FVS318G Firewall on page 140 and Restore the
Configuration of Several Identical Devices on page 144.

Note: For information about restoring the application system settings, see
Restore the System Settings on page 281.
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The Restore table (which you access by selecting CONFIG > RESTORE) displays the
backup configuration files that the application adds after it backed up a configuration.

The application saves backup configuration files for the data retention period. For more
information, see Set the Data Retention Period on page 266.

If the configuration file that you need does not display in the Restore table, you can import the
file into the application. For more information, see Import a Configuration File on page 148.
The Restore table also displays the configuration files that you imported.

& CAUTION:

When you restore the configuration of a device, you must provide the
correct configuration file. Make sure that you select both the correct device
type and correct device model for the configuration file that you upload to
the application. If you provide the wrong configuration file, the application
pushes the incorrect configuration file when it executes the configuration
restore job and you can damage the device.

The following sections describe the tasks that you can perform with device configuration files:

* Restore the Configuration of a Single Device

e Customize and Promote a Configuration File

e Promote a Configuration File for an FVS318G Firewall
» Restore the Configuration of Several Identical Devices
* Import a Configuration File

* Export a Configuration File

e Modify a Configuration File

* Remove a Configuration File

e Compare Two Configuration Files

Restore the Configuration of a Single Device

You can restore the configuration of a single device immediately or schedule the application
to restore the configuration later.

> To restore a configuration to a single device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select CONFIG > RESTORE.

Restore (7]
[ importrite | Ean J|  Restore connguration [N Rowsperpage| 10 B4 < [ 1 |11 > [N Tours
[ Fite Name: @ Device Name % FileType @ Create Time ™ Device Type ® Size(KB) ® FPromoted L
0| xs JUNEE-1 S-immy-GSMT224v2 * Tea 0902013131514 Swieh m Mo

O | backup-prof-1 192.168.10.61 B Ted 09N 072013 12:24:08 & swich 1.3 Bno

O backup-prof-1 192 16810 56 | Tedt 091042013 122341 & switch 1.08 Bro

O backup-prot-1 19218810120 B Ted 0OM0F2013 12:23:41 Switch 281 B e

To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

Select the configuration file.
Click the Restore Configuration button.

4 Restore Configuration X
Sucitodcen > | rona |

Config File Info

File Hame 215

Device Type Device Model GSM7224v2
Selact Target Network Devices of Groups AddDevice | Add Group
D Status ¢ Entity Name ¢ Entity Type ¢ P Address ¢ Hostname ¢ Vendor # Device Model *

No data to display!
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9. Click the Add Device button.

B Select Devices X

Filter:{Device Model: GSMT224v2] | Show Fitter |
Rows per page | 10 H( [ fre > EER o3

D Status ¥ M&Nem ~ [P Address % Hostname : \}mr : Mé.aType :Devir.ehhru QrFimaevrerrslnn

O e 192.168.10.102-mine 19216810230 B retoear Switch GEMTZ24v2 80126

O @& June-215pmy-GSM224v2 19216810215 B retgear & switch GEMT224v2 80144

O|@up JureS-21Sjmmy-GSM7224v2 19216810140 nnmgur Switch GEMTZ24v2 80128

< i >

Add Selection | | Addan | [ close |

10. Select the device.
11. Click the Add Selection button.

The pop-up window closes and the selected device is listed in the Restore Configuration
pop-up window.

21 Restore Configuration X

Select Devices > m
Config File Info
File Hame 215
Device Type Device Model GSMT224v2
Select Target Network Devices or Groups Add Device Add Group
D Smyu % Entity N_ama % Entity Type % P.Mc_nn s _l-belm & “Wendar # Device Model +
] @ up JuneB-215-jimmy-GSMT224v2  Device 19216810215 Metgear GSMT224v2
| 3|
[screaue | cxecus JIEE

CAUTION:

Make sure that you select the correct device. Selecting the wrong device
for the selected configuration file can damage the device.
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following buttons:

Execute. Restores the configuration file immediately.
When the job completes, a pop-up window similar to the following opens.

%4 Restore Configuration X

Execution Result

Hote: The Config Restore task may take a while to complete. Please be patient

Status @ Succesded

Rowes per page| 10 g <t > Y tota

s s

Device Name 4 [P Address 4 Start Time 4 End Time 4 CSlatus 4 Detail *
JGSMT224_207 192 168.10.207 05/21/2013 17:03:54 05/21/2013 17:04:18 a Succeeded

| Close

Schedule. Lets you set up a schedule to restore the configuration file later.

A pop-up window similar to the following opens.

Execution Type & Status

Execution Type One time scheduled [v ]

Starting On 05/21/2013 12:58:00

I | corc

a. Specify the time that you want the procedure to start.
b. Click the Submit button.
The restore procedure is executed once at the specified time.
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Customize and Promote a Configuration File

To use the configuration file of a device as a template to configure a collection of devices
(see Restore the Configuration of Several Identical Devices on page 144), you first must
customize the file for your network configuration and promote the file.

You cannot use a promoted file to configure the following types of devices and firewall
models:

e Wireless controllers

*  Wireless management systems

e Storage devices

e Any compatible NETGEAR device that does not support a text-based configuration file
« FVS318N firewall

*  FVS336Gv2 firewall

*  FVS336Gva3 firewall

¢ SRX5308 firewall

Note: For information about using a configuration file as a template to
configure several NETGEAR FVS31G firewalls, see Promote a
Configuration File for an FVS318G Firewall on page 140.

& CAUTION:

We recommend that only administrators with advanced network
knowledge and experience perform the following procedure.

» To customize and promote a configuration file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > RESTORE.

Restore (2]
Filter: None Show Filter
| importfile | Edit J|  Restore Configuration [Tl Rows perpage[ 10 [ < [1 11 > Y totar3
™| File Name ¢ Device Name & Fila Type & Create Time ~ Device Type & Size(KB) ¢ Fromoted ¢
I | backup_221 NSMT2245_221 B Text 050212013 16:12:03 @ switch 283 [
I [Promoted]backup_221 ASMT2248_ 221 B Tent 042872013 03:54:33 & switch 278 & ves
™ | backup_221 NEMT2245_221 ¥ Tedt 0472802013 03:40.27 @ switch 284 Buo

5. To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

6. To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

7. Select the configuration file.
8. From the More menu, select Promote File.

4 Promote File X

Promote Configuration
AT T er Paramelers
FERIE
| & Asset Tag S
1 1Current Configuration ~|
z =] CLIName
3 T
" © Capabiities
£ ISystem Description "GEM7224Y2 - ProSafe 24G° H Contact
3
7 1System Software Version "8.0.1 44" B Crestor =
8 = DNS hostrame
3 1System Up Time "9 days 16 hrs 0 mins 47 secs”
10 H Date Created
|
11 IAdeitionsl Packages  FASTPATH QOS & Description
1z
13 ICurrent SNTP Synchronized Time: SEP 13 16:42:08 2013 UTC © Device Driver OID
14
& Device identifier
151
18 @ Digcover Date
17 set gvrp adminmode |
@ Equipment lcon
< > E it | -
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9. Modify the configuration file by inserting a preconfigured parameter in the configuration file.

The application substitutes the parameter that you insert with the actual value that it
obtains from the device through monitoring.

a. Select the line of code that you want to modify.

The following figure shows an example of a line of code.

network parms 152.168.10.202 255.255.255.0 182.1658.10.1

b. Erase the value and leave the cursor positioned where you want the parameter
inserted in the line of code.

The following figure shows the example of Step a after you erased 192.168.10.202
from the line of code.

network parms 255.255.255.0 192.168.10.1

c. Double-click a parameter in the Filter Parameters table.

The following figure shows the preconfigured IP Address parameter that you can
select from the Filter Parameters table.

|| B IP Address |

The application inserts the parameter at the position of the curser in the line of code.

The following figure shows the example of Step a after you inserted the IP Address
parameter in the line of code.

| network parms $IPAddresss 255.255.255.0 192.168.10.1

10. Repeat Step 9 until you made all your changes in the configuration file.

A CAUTION:

When you restore the configuration of a device, you must provide the
correct configuration file. Make sure that any changes that you make on
the Promote Configuration pop-up window do not corrupt the configuration
file. If you provide a corrupted configuration file, the application pushes out
the corrupted configuration file when it executes the configuration restore
job and you can damage the device.

11. Click the Submit button.

The Promote File pop-up window closes and the promoted configuration file is listed in
the Restore table.
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Promote a Configuration File for an FVS318G Firewall

To use the configuration file of a single NETGEAR FVS318G firewall as a template to
configure a collection of NETGEAR FVS318G firewalls (see Restore the Configuration of
Several Identical Devices on page 144), you must promote the configuration file but can
retain the existing configurations for the following features:

e ISP login and type of ISP

*  WAN Internet (IP) address and DNS servers

e Dynamic DNS configuration

e SNMP configuration

e Time Zone

For each of these features, you can decide to either retain the existing configuration on the
firewalls or overwrite the configuration for the feature with the one from the promoted

configuration file. The firewalls obtain all other features that are not stated in the previous list
from the promoted configuration file.

Note: You cannot promote a configuration file for the FVS318N, FVS336Gv2,
FVS336GVv2, or SRX5308 firewall.

A CAUTION:

We recommend that only administrators with advanced network
knowledge and experience perform the following procedure.

> To promote a configuration file for an FVS318G firewall:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select CONFIG > RESTORE.

Restore (2]
Filter: Hone Show Filter
| importfile || Edit []  Restore configuration [Tl Rowsperpage[ 10 [ < [1 1 > X vota3
I~ File Name & Device Name ¢ File Type & Create Time ~ Device Type & Size(KB) ¢ Promoted ¢
I | vackup_221 NSM72245_221 B Tent 05022013 16:12:03 & switch 283 o
I™ | [Promotedibackup_221 ASMT2243 221 P Tent 0412872013 03:54:33 & switch 278 & ves
I™ | backup_221 NEMT2245_221 ¥ Tedt 0472872013 034927 @ switch 284 Brne

To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

Select the configuration file for an FVS318G firewall.
From the More menu, select Promote File.

B Promote File x
ISP Login & ISP Type > WAN Internet {IP) Address & DNS Servers Dynamic DNS mm

@) Do not use the seftings from this configuration file, instead retain current setfings in device
© Usethe seftings from this configuration file which is shown below

ISP Login

Does your internet connection require a login: Mo

Login: Password

ISP Type
Which type of ISP connection do you uss:

Account Name: Domain Maime:

el Timeout lelle Minutes:

Connection Reset hio Digconnect Time = HH: o
Disconnect Time = Mit o Delay = Sec: 0
My [P Address: Server IP Address:

9. Select one of the following radio buttons:

* Do not use the settings from this configuration file, instead retain current
settings in device.

* Use the settings from this configuration file which is shown below.
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10. Click the WAN Internet (IP) Address Servers tab.

B Promote File X
ISP Login & ISP Type WAN Internet (IP) Address & DNS Servers > mm

(& Do net use the seflings from this configuration file, instead retsin current settings in device

O Use the settings fromthis configuration file which is shown below

Internet (IP) Address

Get Dynamically from ISPAUse Static P Address: Use Static IP Address

Cliert identifier Checkbox: Chierd Idertifier Narme:

Wenclor Class kdentifier:

IP Address: 66.166.147 252 P Subiret Mask 2552562650
Gateway P Address: 65,165 147248

Domain Name Sewer (DNS) Servers

Get Automatically from ISPise These DNS Servers: Use These ONS Servers

Primary ONS Server: BE8E Secondary DNS Server 0000

B3 [ cose |

11. Select one of the following radio buttons:

Do not use the settings from this configuration file, instead retain current
settings in device.

e Use the settings from this configuration file which is shown below.

12. Click the Dynamic DNS tab.

B Promote File X

ISP Login & ISP Type WAN Internet (IP) Address & DNS Servers Dynamic DNS > m

(&) Do nct use the seftings from this contiguration file, instead retain current settings in device

©) Use the seftings from this configuralion file which is shown below

Dynamic DNS

DNS Type: Not Set Domain Marne:

User Name/Email PasswordiKey:

Use widcards: No Update every 30 days: No

m Close |

13. Select one of the following radio buttons:

Do not use the settings from this configuration file, instead retain current
settings in device.

e Use the settings from this configuration file which is shown below.
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14. Click the SNMP tab.

B Promote File X
ISP Login & ISP Type WAN Internet {IP) Address & DNS Servers m SNMP >

@ Donot use the setfings from this configuration file, instead retein currert setings in device

O Use the seftings from this configuration file which is shown below

SMMP SysConfiguration
SysContact admin SysLocation netgear

Syshlame: FWS318G

m Close

15. Select one of the following radio buttons:

* Do not use the settings from this configuration file, instead retain current
settings in device.

* Use the settings from this configuration file which is shown below.
16. Click the Time Zone tab.
[ 51057t | bt 9 om0 s | s | s> i |

() Donot use the setfings trom this configuration file, instesd retain current setiings i device

) Use the seftings from this canfiguration file which is shown below

Tirne Zone

Dede/Time: (GMT-10,00) Hawail
Automatically Adjust for Daylight Savings Time: No

Use Default NTP ServersiUse Custom NTP Servers Uise Default TP Servers
Server 1 Name /IP Address: time-c.netgear com
Server 2 Name / P Address: time-dnetgesr com

2 ciose |
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& CAUTION:

When you restore the configuration of a device, you must provide the
correct configuration file. Make sure that you configure the configuration
file correctly. If you provide a corrupted configuration file, the application
pushes out the corrupted configuration file when it executes the
configuration restore job and you can damage the device.

17. Click the Save button.

The Promote File pop-up window closes and the promoted configuration file is listed in
the Restore table.

Restore the Configuration of Several Identical Devices

You can use the configuration file of one of the devices on your network to create a template
configuration for several identical devices on your network. You must promote this template
configuration file before you can use it to restore the configuration of several devices (see
Customize and Promote a Configuration File on page 137 or Promote a Configuration File for
an FVS318G Firewall on page 140). Otherwise, the restore procedure fails.

You can restore the configuration of several devices immediately or schedule the application
to restore the configuration later.

A CAUTION:

We recommend that only administrators with advanced network
knowledge and experience perform the following procedure.

» To configure several identical devices:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > RESTORE.

WIRELESS MONITOR ALARMS TOPOLOGY REPORTS ADMIN
Restore (7]
TR, st e |
importFile | Edit ||  Restore Configuration I Rows perpage[ 10 [ < [ 1 |11 > E Totais
[ File Name # Device Name # File Type # Create Time ~ DeviceTyne ¢ sizeE) + Promoted s
O ap-210 netgearAB23FE ¥ Teat QAr0F2013 145631 & standalone AP 21.56 B
0O ap-350 350157 1= Text DOM0201314:53:26 Standalone AP 3829 Bro
D [Promoted) 21 S-non-def Junet-215jimmy-GSMT 224v2 5 Ted 0902013 14:51:35 Switch an Yes
O 215-non-der Juned-215-jimmy-GSMT224v2 ] Teat 0901072013 13:54:23 @ switch n 8o
0 |226 192.168.10.226 B Text 0011072013 13:48:53 @ switch 1835 @re

5. To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

6. To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

7. Select the promoted configuration file.
8. Click the Restore Configuration button.

4 Restore Configuration X

Seciomess 5| ruma |
Config File Info
File llame [Promated]215-nan-def
Device Type fic [v] Device Model GEM7224v2
Select Target Network Devices or Groups AddDevice | nddGroup J| Remove |
D Status # Entity Mame * Entity Type * P Address % Hostname # Vendor * Device Model *
No data to display!
Schedule ["Close |

9. Select the target network devices or groups.
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& CAUTION:

Make sure that you select the correct devices or device groups. Selecting
the wrong devices or device groups for the selected configuration file can
damage the devices.

e To add individual devices:
a. Click the Add Device button.

B Select Devices X

Rowsperpage| 10 B < [ 1 |11 > [ voscs
O status % Device Name ~ IP Address # Hostname # endor %+ Device Type + Device Model # Firmare Version
O e 192,188.10.102-mine 19216810230 I vetgesr Switch GEMT224v2 804.26
O eu JuneB-21S-immy-GEMT224v2 19216810140 B retgear Switch GSMT224v2 80129
O eu June6-215-immy-GSMT224v2 19216840215 [ [TE Switch GENT224v2 80444
< >
" add setection || Adaan || close |

b. Select the devices you want to add and click the Add Selection button.
To add all devices, click the Add All button.

The pop-up window closes and the selected devices are listed in the Restore
Configuration pop-up window.

&4 Restore Configuration X

Select Devices > m

Config File Info

File llame [Promoteclj215-non-def

Device Type Switch u Device Model GSMF224v2

Select Target Network Devices or Groups AddDevice || Add Group
O] Stelus  # Eniy Name $ Eniity Type $ P Address # Hosiname  # Vendor % Device bodel e

O ew 192168.10.102-mine Device 19246810230 Metgear cMT224v2

O &uw JuneB-215§mmy-GSM7224v2  Device 19216810140 Netgear GSMT224v2

0w June6- 215 fimmy-GSWT224v2 | Devics 19216810215 Netgear GSMTZ24v2

¢ >
[Screaue | erccre I

Manage Configurations and Firmware

146



NMS300 Network Management System Application

e To add device groups:

a. Click the Add Group button.
Fows perpage| 10 14 < [ 1 |11 > [EE Tota: 2

[ mame ~ Type 4 Device Count %
gear Devices namic Groug
[ annetgear Devi Dynamic G 38
Static Group 3

[ osmr224v2

["ada'setection | [ Adaan | [ cose |

b. Select the groups you want to add and click the Add Selection button.

To add all groups, click the Add All button.
The pop-up window closes and the selected groups are listed in the Restore

Configuration pop-up window.
R

Config File Info

File Hame [Promoted|215-non-def
GEMT224v2

Device Type Switch u Device Model
AddDevice || Add Group
-~

Select Target Network Devices or Groups
[ sStatus # Eniity Mame # Entity Type % IP Address % Hostname # Vendor # Device Modsl +

(] GSMFZ24v2 Group

[Screaue [cione
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10. Specify whether to restore the configuration file immediately or later by clicking one of the
following buttons:

* Execute. Restores the configuration file immediately.
When the job completes, a pop-up window similar to the following opens.

&4 Restore Configuration X

Execution Result
Note: The Config Restore task may take a while to complete. Please be patient.
Status 0 Succeeded
rowsperpage| 10 I < [T 11 > JEB ot
Device Name 4 IP Address 4 Start Time 4 End Time 4 Status 4 Detai ;
JGSMT224_207 192.168.10.207 05/21/2013 17:03:54 05/21/2013 170418 a Succeeded

e Schedule. Lets you set up a schedule to restore the configuration file later.
A pop-up window similar to the following opens.

Execution Type & Status

Execution Type ["One tme scheduies |

Starting On 05/21/2013 12:58:00 T

I | s

a. Specify the time that you want the procedure to start.
b. Click the Submit button.

The restore procedure is executed once at the specified time.

Import a Configuration File

You can import a configuration file for a device. If you want to use an MD5 file for error
checking during the import process, first use an MD5 tool to generate an MD5 file that is
based on the configuration file that you want to import.

» To import a configuration file for a device:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
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A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select CONFIG > RESTORE.

RESTORE

Restore 7}
Filter: Hone Show Filter

| importrie || Edit J|  Restore Contiguration || Rowsperpage[ 10 [ < [1 11 > [ totar3
I File Name & Device Name & File Type & Create Time ~ Device Type & Size(KB) ¢ Promotad &

[ backup_221 XSM72245_221 B Tert 050202012 16:12:03 & switch 283 Bto

I™ | [Promotedibackup_221 ASMT2243 221 o 0412872013 03:54:33 & switch 278 Yes

™ backup_221 XSMT2245_221 0472802013 03:49:27 @ switch 284 B

5. Click the Import File button.

4 Import File X

Config File Information

Select Your File [ Select.. | 7
I™ Enable MD5 Check | [ select.. |
File Name ‘ ‘7

Vendor ["Hetgsar

Device Type | Switch

Device Model [esn73iz

File Type [ Text

Version ‘ ‘

Description

6. Specify the following information:

e Select Your File. Click the Select button.

Select the image file from your computer, follow the directions of your browser.

 Enable MD5 Check. To enable file validation with the Message Digest 5 algorithm,

select this check box and click the Select button.

To select the MD5 file from your computer, follow the directions of your browser.

* File Name. Enter the name of the configuration file that you want to use.
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e Vendor. Select the vendor of the device.

e Device Type. Select the device type.

* Device Model. Select the device model.

* File Type. Select the file type.

* Version. Enter the version of the configuration file.

e Description. Enter a description of the configuration file.
Click the Submit button.

The Import File pop-up window closes and the imported file is listed in the Restore table.

Export a Configuration File

You can export a configuration file for a device.

To export a configuration file for a device:

1.

5.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select CONFIG > RESTORE.

RESTORE

Restore (7]
Filter: None Show Filter
| importfile I Edgit J|  Restore Configuration [T Rowsperpage[ 10 1 < [1 11 > [EY totas
I~ File Name & Device Name # File Type ¢ Create Time » Device Type + Size(KB) ¢ Promoted L
7 | backup_221 ASMT2245_221 B Text 050272013 16:12:03 & switch 283 Bno
™ | [Promotedibackup_221 XSM72245_221 P Test 04/28/2013 03:54:33 & switch 278 & ves

I" backup_221 NSMT2248_221 B Test 0472872013 03:49:27 Switch 284 Bro

To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.
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You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

6. To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

7. Select the configuration file.
From the More menu, select Export File.
9. To save the file on your computer, follow the directions of your browser.

Modify a Configuration File

You can modify a configuration file except for the configuration file for a NETGEAR firewall.
The configuration file of a NETGEAR firewall includes content in hexadecimal format.

& CAUTION:

We recommend that only administrators with advanced network
knowledge and experience perform the following procedure.

> To modify a configuration file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > RESTORE.

RESTORE

Restore (2]
Filter: None Show Filter
| importfile I Edgit J|  Restore Configuration [T Rows perpage[ 10 [ < [1 11 > Y totar3
I File Name & Device Name & Fila Type & Create Time ~ Device Type & Size(KB) & Promoled ¢
I | backup_221 NSMT2245_221 B Text 050212013 16:12:03 @ switch 283 [

I [Promoted]backup_221 ASMT2248_ 221 B Tent 042872013 03:54:33 & switch 278 & ves

I | backup_221 XEMT2248 221 ¥ Tedt 0472802013 03:40.27 @ switch 284 Buo

5. To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

6. To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

7. Select the configuration file.
8. Click the Edit button.

154 Edit File:bkp-660-167 X

Edit Config File
L& #
system: configersion 217
system basicSettings t |
system basicSettings: apName 660-167
sysiem basicSetiings:sysMacAddress 00-00-00-00-00-00
system basicSettings: sysVersion 1.0
system: basicSeftings: sysCountryRegion 541

system basicSettings adminName admin
system basicSetlings adminPasswd password

LRI N G O

w

system:basicSettings: dhepClentStatus 0

10 system basicSetfings:ipAddr 192,168 10167

11 systembasicSettings:netmaskddelr 255 25652550

12 system basicSettings: gatewayAddr 192.168.10.1

13 systembasicSetings priDnsAddr 0.0.0.0

14 systembasicSettings:sndDnsAddr 0.0.00

15 systembasicSettings:spanTresStatus 0

16 system basicSettings:managementvianiD 1

17 system basicSetiings-untaggedylanStatus 1 i
< I

[ suomi JEE)

9. Modify the configuration file by changing, inserting, deleting, or overwriting information.
The following tools are at your disposal:

e Looking glass icon. Displays the Find/Replace pop-up window.
Number sign icon. Displays the Jump to Line pop-up window.
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& CAUTION:

When you restore the configuration of a device, you must provide the
correct configuration file. Make sure that any changes that you make to
the configuration file do not corrupt the file. If you provide a corrupted
configuration file, the application pushes out the corrupted configuration
file while it executes the configuration restore job and you can damage the
device.

10. Click the Submit button.

The modified file is saved and the pop-up window closes.

Remove a Configuration File
You can remove a configuration file that you no longer need.

To remove a configuration file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select CONFIG > RESTORE.

Restore (7]
Filter: Hane Show Filter
| importfile | Edit ||  Restore Coniguration [T Rows perpage[ 10 4 < [1 11 > Y totaa
I Fila Name & Device Name & FileType & Create Time ~ Dewica Type & size(kn) & Promoted .

I | backup_221 ASMT2245_221 B Text 05022013 16:12:03 @ switeh 283 B
I | Promotedibackup_221 XSMT2245_221 P Tent 04/28/2013 03:54:33 @ switch 278 Yes
I backup_221 HEMT2245_221 B Test 042872013 03:49:27 & switch 284 [ = BT

5. To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.
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You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

6. To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

7. Select the configuration file.
8. From the More menu, select Delete File.

A confirmation window pop-up opens.
9. Click the Yes button.

The file is removed from the Restore table and deleted.

Compare Two Configuration Files

You can compare two configuration files. The files must be text files. You cannot compare
binary files.

» To compare two configuration files:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select CONFIG > RESTORE.

RESTORE

Restore (2]
Filter: Hone Show Filter
| importfie | Eait J|  Restore connguration  JIETRUIR Rowsperpage[ 10 4 < [1 11 > N o3
I™ File Name & Device Name & File Type ¢ Creale Time = Device Type & Size(KB) # Promoled 2
[ backup_221 XSM72245_221 2 Texn 050202013 16:12.03 & switch 283 Bro
IC  [Promotedibackup_221 XSMT2245_221 & Tet 047282013 03:54:33 &8 Switch 278 & Yes

I backup_221 NEMT224% 221 ¥ Text 047282013 03:49:27 & Switch 284 Bro
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To add columns to or remove them from the Restore table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Device Name, File Type, Create
Time, Device Type, Size (KB), Promoted, Description, Device IP, Device Model, Version,
Vendor, and Created By.

To filter the configuration files that are listed, click the Show Filter button.

You can filter the configuration files by criteria such as device type, device model, device
name, and device IP address.

To hide the filter, click the Hide Filter button.

Select the two configuration files that you want to compare.
Both files must be text files.

From the More menu, select Compare Files.

A pop-up similar to the following one opens.

s Compare Files X

File Compare
Changed Lines Added Lines W Missing Lines
[Promoted]215 215
0045 fine ssh 0045 ling ssh =
0048 oo4s
0047 exit 0047 exit
0042 0043
0049 spanning-tree configuration name "10-00-7F-49-8F-1C" 0049 spanning-tree configuration name ™10-0D-7F-49-8F-1C"
0050 0050
0051 snmp- ‘sysname "SEqui ames 0051 snmp-server sysname "GEM7224v2_21522202° J
0052 0052
0052 snmp-server location "$Locations” 0053 smp-server location "GSM7224v2_loe_2152223°
0054 0054
D055 snmp-server contact "$Contacts” 0055 snmp-server contact "GEMT224v2_con_2152232"
0056 0056
0057 ! 0057 !
008 00s8
0059 interface 0/1 0059 interface 0/1
0080 0060
0081 extt 0061 exit
00862 0062
1063 interfare 02 00A3 interfare N7 =
Close

The left and right side of the pop-up window each display one of the selected files. The
pop-up window highlights changed lines in yellow, added lines in green, and missing lines
in red.

Click the Close button.
The pop-up window closes.
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Import and Export Configuration Files to an External File
Server

By default, the application saves and retrieves configuration files from the NMS300 server.
However, if you set up an external file server (see Set Up an External File Server on

page 265), you can retrieve (import) and save (export) configuration files, including backup
files, to the external file server.

For each type of device, you can transfer only the entire file directory that includes all
configuration files for the type of device. You cannot transfer individual configuration files. For
example, if you export the file directory for switches, all configuration files for all switches are
exported. Similarly, if you import the file directory for standalone APs, all configuration files for
all standalone APs are imported.

Note: After file directories are transferred from the NMS300 server to an
external file server (that is, the directories are exported), the application
deletes the file directories from the NMS300 server. Similarly, after file
directories are transferred from the external file server to the NMS300
server (that is, the directories are imported), the application deletes the
file directories from the external file server.

» To import or export configuration file directories to an external file server:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS

s Discover your network and add the devices you wantto
manage,

Account Information
$ View or modify uSers, of Create New users.

— sFlow
> Set sFlow related configurations.

ca_ System Backup/Restore

Systern BackupRestore Server Configurations and
Protessing.

» System Backup/Restore File Server Seting

Backup

ALARMS

System Settings
Set global seftings for the system and website.

a Manage Monitor and Alarm
Metwork monitor, 3larm and threshold related configurations.

Manage External File Server

&L Ey1emal File Server configurations and File Processing wih
Exemnal File Server.

 Customize
Customize the navigation and look of your web portal.

k Dashboard

my.NETGEAR.com Account Profile

Configure andvalicate myNETGEAR com account profile
through myNETGEAR.com Web AP

License And Version Information

6 View NMS300 license, supported device and version
information.

5. Under Manage External File Server, click the Import or Export Files link.

mport or Export Config Files

Note

File Operation Type

Operation Type

External File Server Information
External Server IP 172.26.2.116
Directory Path backup/NMS300

[] Directory Name

After files are transferred, the system will automatically delete them from the previous server.

File import u

[7] | wireless Controlier
[7] [ Controller Managed AP

[F] |- Router

]| I switch

[ | 2 Firewall

[7] L Standalone AP
[[] 2 storage

A S

[ | Ewas

Gose

BT £

»
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6. From the Operation Type menu, select File Import or File Export.

7. In the Directory Name table, select the check boxes for the individual directories, or select
the check box in the table heading for all directories.

8. Click the Execute button.

The directories transfer to or from the external file server and the results display.

[ Import or Export Config Files X

Execution Result
Note: File import may take a whikt to complete. Please be patient

Status ¥ Succeeded

Rowsperpage[ 10 [ < 1 /1 > [ Totarn

Directory Name & Start Time % EndTime % Status 4 Detail ®
WMS 11612014 043717 11/16/2014 04:37:17 0 Succeeded

| Close

Upgrade Firmware for One or More Devices

NETGEAR posts the latest firmware for each NETGEAR device on support.netgear.com. We
recommend that you visit this site regularly to see if new firmware is available.

& CAUTION:

When you update the firmware of a device, you must provide the correct
firmware file. Make sure that you select both the correct device type and
correct device model for the firmware file that you upload to the
application. If you provide the wrong firmware file, the application pushes
out the incorrect firmware file while it executes the firmware upgrade and
you can damage the device.

A CAUTION:

When you update the firmware of stacked switches, make sure that all of
the switches in the stack support the firmware that you select to update on
the stack master.
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The following sections describe the tasks that are related to firmware upgrades:

Import a Firmware File

Execute or Schedule a Firmware Upgrade

Modify the File Name, Version Information, and Description for a Firmware File
Export a Firmware File

Remove a Firmware File

Import a Firmware File

After you download device firmware (an image) from the NETGEAR website at
support.netgear.com to your computer, you can load the firmware file onto the NMS300
server.

If you want to use an MD5 file for error checking during the import process, first use an MD5
tool to generate an MD?5 file that is based on the firmware file that you want to import.

» To load a firmware file onto the NMS300 server:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select CONFIG > IMAGE MANAGEMENT.

IMAGE MANAGEMENT

Image Management (7]
Fitter:None Show Filter

Loadimage [J Edit [ upgrade Firmware |RTTIR Rowsperpage[ 10 [ < [1 11 > [ Tota1
I~ File Name & Create Time ~ DeviceType ¢ Version & Created By 0
I |ams-0.1.0.29 0512172013 18:52.38 & switcn 9.0.1.29 & jimmy
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5. Click the Load Image button.

&4 Load Image X

Image File Information
Select Your File [ select.. | 7
™ Enable MD5 Check | = |
File Name l—‘ ¥
vendor T |
Device Type ’ﬁ
Device Model B - |
Version 1
Description
m Cancel

6. Specify the following information:
* Select Your File. Click the Select button.

To select the firmware file from your computer, follow the directions of your browser.

 Enable MD5 Check. To enable file validation with the Message Digest 5 algorithm,
select this check box and click the Select button.

To select the MD5 file from your computer, follow the directions of your browser.

e File Name. Enter the name of the firmware file.

* Vendor. Select the vendor of the device.

» Device Type. Select the device type.

« Device Model. Select the device model.

e Version. Enter the version of the firmware file.

e Description. Enter a description for the firmware file.
7. Click the Submit button.

The firmware file is transferred from your computer to the NMS300 server.

The imported firmware file is saved for the data retention period. For more information,
see Set the Data Retention Period on page 266.
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Execute or Schedule a Firmware Upgrade

After you import a firmware file into the NMS300 server (see Import a Firmware File on
page 159), you can execute a firmware upgrade immediately or schedule the application to
execute a firmware upgrade later.

> To execute or schedule a firmware upgrade:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select CONFIG > IMAGE MANAGEMENT.

Image Management (7]
Show Filter
Loadimage || Edit [| upgrade Firmware JINTEICHRA Rows perpage| 10 g < [ 1 i1 > Total: 3
[ File Narne # Create Time ~ Device Type % Version # Created By *
0O|ts_31.411 091372013 09:28:19 3 Firewanl 3N &, itran
[ m5300_10.0.0.31 0132013 09:27:27 Switch 10.0.0.31 &, jiran
0| 7520_25.05 081372013 09:26:27 Wireless Confroller 2505 & jitran

5. To add columns to or remove them from the Image Management table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Create Time, Device Type,
Version, Created By, Vendor, Device Model, Size (MB), and Description.

6. To filter the firmware files that are listed, click the Show Filter button.

You can filter the firmware files by criteria such as time range, device type, device model,
and file name.

To hide the filter, click the Hide Filter button.

7. Select the firmware file.
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8. Click the Upgrade Firmware button.

4 Upgrade Firmware X

—
Note

The firmware upgrade will apply to all stack members for Stacked Switch, Please make sure this firmware file is to

Image File Info

File Hame 75202505 File Version 2505

Device Type E Device Model WCT520

Select Target Network Devices of Groups AddDevice || Add Group
D Stu_tus ® Enuv Neme $ Entty Typa_ @ !F ﬁdd_raas ® Huatﬁ_u!ma ] \o‘en_dcf ® Devlca_ Mpde\ *

No data to display!

Device Option

Image Slot Image! g
| scheaue ] ixecue JEETEEN

9. Select the target network devices or groups:

& CAUTION:

Make sure that you select the correct devices or device groups. Selecting
the wrong devices or device groups for the selected firmware file can
damage the devices.

e To specify individual devices:
a. Click the Add Device button.

Filter:{Device Madel: WCT520] Show Filter
Fowsperpaoe[ 10 [ < [ 1 |11 > [N Tom2

[ Status % Device Name ~ P Address 4 Hostname & Vendor ¢ Device Type 4 Device Model & Firmware\

0O &w we-7520-164 19216810164 Bl uetgear Wireless Cantrolier WE7520

O &uw We7520-160 192.168.10.160 B netgenr B iirsless Controter WCT520

<

Add Selection | | Add Al || Close

b. Select devices and click the Add Selection button.
To add all devices, click the Add All button.

Manage Configurations and Firmware

162



NMS300 Network Management System Application

The pop-up window closes and the selected device or devices are listed in the
Upgrade Hardware pop-up window.

&4 Upgrade Firmware X

Select Devices > m

Note

The firmware upgrade will apply to all stack members for Stacked Switch. Please make sure this frmware file is to all

Image File Info

File Name 7520_2505 File Version 2505

Device Type V E Device Model WC7520
AddDevice | Add Group

Select Target Network Devices or Groups

D Status % Entity Name % Emm‘mu & [P Address % Hostname & Vendor & Dev\ceMpeial &
O Oup we-7520-184 Device 192.168.10.164 Netgear WICT520

O @w we7520-160 Device 192.166.10.160 Metgear WC7520

Device Option

Image Slot Imaget 57
[Schease | oxeene JREE

To specify device groups:
a. Click the Add Group button.

B sclect Groups X

Show Filter

Filter:None

Rnwsmrmm|1_ﬂ_ﬂ< [T > B ot
[ HName - Type & Device Count =
I~ | AllNetgear Devices Dynamic Group 3z

| Add Selection || Add Al || Close |

b. Select groups and click the Add Selection button.
To add all groups, click the Add All button.
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The pop-up window closes and the selected group or groups are listed in the

Upgrade Firmware pop-up window.

Select Devices >

Note
The firmware upgrade will apply to all stack members for Stacked Switch. Please make sure this firmware file is toall
Image File Info
File Hame xms-9.1.0.29 File Version 9.0.1.28
Device Type Switcl v | Device Model KEMT2245
Select Target Network Devices or Groups Add Device || Add Group
[T Status + Entity Name + Entity Type % IPAddress + Vendor %+ Device Model %
All Netgear Devices Group

-

Device Option
Image Slot Image1 u

[ scredue | Exccuie IR
10. Specify whether to execute the firmware upgrade immediately or later by clicking one of the

following buttons:
Execute. Upgrades the firmware immediately.

When the job completes, a Result pop-up window similar to the following opens.

Execution Result
Hote: The Image Upgrade task takes a whils to complete. Please be patient
Status @ Succesded
Rows per page| 10 u < > Y o
Device Name 4 P Address 4 Start Time % EndTime 4 Status ~ Detail *
xsmstack_238 192.168.10.238 05/23/2013 11:38:42 05/23/2013 11:44:31 ¥ succesded
i | ¥
Close
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e Schedule. Lets you set up a schedule to upgrade the firmware later.

A pop-up window similar to the following opens.

Execution Type & Status

Execution Type

Starting On 05/23/2013 10:30:00

[Sionn T

a. Specify the time that you want the upgrade to occur.
b. Click the Submit button.

The upgrade procedure is executed once at the specified time.

Modify the File Name, Version Information, and Description
for a Firmware File

You can modify the file name, version information, and description for a firmware file. You
cannot modify the vendor information, device type, and device model for a firmware file.

To modify information for a firmware file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.

4. Select CONFIG > IMAGE MANAGEMENT.

IMAGE MANAGEMENT

Image Management

Fitter:None Show Filter
Loadimage [J Edit [ upgrade Firmware |RTTIR Rowsperpage[ 10 [ < [1 11 > [ Tota1

I~ File Name & Create Time ~ Device Type ¢ Version & Created By

[ xms-9.1.0.29 0512172013 18.52.38 @ switch 9.0.129 & jimmy
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5. To add columns to or remove them from the Image Management table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Create Time, Device Type,
Version, Created By, Vendor, Device Model, Size (MB), and Description.

6. To filter the firmware files that are listed, click the Show Filter button.

You can filter the firmware files by criteria such as time range, device type, device model,
and file name.

To hide the filter, click the Hide Filter button.

7. Select the firmware file.
8. Click the Edit button.

4 Edit Image X

Image File Information

File Hame xms-9.1.0.29

Vendor Netgear

Device Type Switch

Device Model XSM72245

Version 90129 T
Description
[ Suom JEETET

9. Modify the information in the File Name field, Version field, or Description field, or in a
combination of these fields.

10. Click the Submit button.

The modified firmware file is saved and the pop-up window closes.

Export a Firmware File

You can export a firmware file.

> To export a firmware file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select CONFIG > IMAGE MANAGEMENT.

IMAGE MANAGEMENT

Image Management (7]
Filter:None Show Filter

Loadimage [J Edit [ upgrade Firmware |RTIRA| Rowsperpage| 10 B4 < [1 11 > SN votan1
™ File Name & Create Time ~ Device Type & Version 4 CreatedBy 03
[ xms-9.1.0.29 05/2172013 18:52:38 B switen 9.0.1.29 & jimmy

5. To add columns to or remove them from the Image Management table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Create Time, Device Type,
Version, Created By, Vendor, Device Model, Size (MB), and Description.

6. To filter the firmware files that are listed, click the Show Filter button.

You can filter the firmware files by criteria such as time range, device type, device model,
and file name.

To hide the filter, click the Hide Filter button.

7. Select the firmware file.
8. From the More menu, select Export Image.
9. To save the firmware file on your computer, follow the directions of your browser.

Remove a Firmware File

You can remove a firmware file that you no longer need.

» To remove a firmware file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select CONFIG > IMAGE MANAGEMENT.

IMAGE MANAGEMENT

Image Management (7]
Filteratone
[“Loadimago [] et || uporade rimwaro | ISR Rows perpsge 10 1 < [T 11 > [N o1
[~ File Name & Create Time ~ Device Type & Version & Crealed By L]

[ ms-9.1.0.29 051212013 185238 B switch 90120 & jimmy

To add columns to or remove them from the Image Management table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: File Name, Create Time, Device Type,
Version, Created By, Vendor, Device Model, Size (MB), and Description.

To filter the firmware files that are listed, click the Show Filter button.

You can filter the firmware files by criteria such as time range, device type, device model,
and file name.

To hide the filter, click the Hide Filter button.

Select the firmware file.
From the More menu, select Delete Image.

A confirmation pop-up window opens.
Click the Yes button.

The firmware file is removed from the Image Management table and deleted.
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Manage Alarms and Logs

Get alerts if something goes wrong

You can receive alarm notifications when conditions are suboptimal and view current and
previous alarms using various filter options. As an option, you can receive these alarm
notifications by email. In addition, you can view and manage network event notifications, device

traps, and device system logs.
This chapter covers the following topics:
* View and Manage Alarms, Triggers, and Notification Profiles
* View and Manage Network Event Notifications
* View and Manage Device Traps
* View and Manage Device System Logs
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View and Manage Alarms, Triggers, and Notification
Profiles

The application provides many default alarms, including status alarms, monitor alarms, and
trap alarms. If an upper or lower threshold is exceeded, an alarm configuration generates an
alarm.

You can view and manage the current alarms, and you can view and manage the alarm
history. You can also add custom alarm configurations that are based on existing
configuration monitors.

One or more optional alarm notification profiles let you specify criteria that enable the
application to generate and send a notification email message if an alarm occurs.

The application provides the following four severity levels for alarms:

e Critical (by default, red color indication)

e Major (by default, yellow color indication)
* Minor (by default, blue color indication)

* Info (by default, no color indication)

The following sections describe the alarm-related tasks:

¢ View and Manage Current Alarms

e View and Manage the Alarm History

* View and Manage Alarm Configurations

* Add a Custom Alarm Configuration

* Modify an Alarm Configuration

* View and Manage Alarm Notification Profiles
e Add or Modify an Alarm Notification Profile

» Customize Alarm Colors

View and Manage Current Alarms

The Current Alarms table shows the active alarms for the entire network. You can
acknowledge alarms, display details about alarms, clear alarms, and export alarms.

» To view and manage the current alarms:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select ALARMS > CURRENT ALARMS.
WIRELESS MONITOR m TOPOLOGY REPORTS ADMIN

Current Alamms [7]
Filter:{Alarm Time Range: Today] ‘Show Filter
e ] tomoness ]| cee TR Rowswosss T < (11 > [ Tors

[ Acknowledged @ Alarm Name ¢ DeviceName & Alarm Source & Severty & AlamTime * Occunence Countar ¢
0O 8roe Device Memory ulilization is over 90% netgeatAG2IF8 wenetgears2ars ([ ooo0t3 175000 (5

O/ 8w linkDown 192.168.10.226 Interface Index31 0202013 16:3406 1

O @ne linkDown 192.168.10.226 Interface Index21 DANOR013 1633 1

O 8mne failedUserLoginTrap 192.168.10.117 Device:192.168.10.... 091072013 18:31:21 1

[ < I failedUserLoginTrap 19216810226 Device192.168.10. 0O 2163007 1

O @no linkDown 192.168.10.226 Interface Index36 09101201316:01:36 1

To add columns to or remove them from the Current Alarms table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Acknowledged, Alarm Name, Device Name,
Alarm Source, Severity, Alarm Time, Occurrence Counter, Alarm Type, Device IP,
Acknowledge By, Acknowledge Time, and Notification OID.

To filter the alarm entries that are listed, click the Show Filter button.

You can filter the alarm entries by criteria such as time range, device name, device IP
address, alarm name, severity level, and acknowledgment. By default, the alarm entries
are filtered to display today’s entries.

To hide the filter, click the Hide Filter button.
Take one of the following actions:
* View details for an alarm:

a. Select the alarm.
b. Click the Detail button.

% Alarm Detail X

Acknowledged No Alarm Name Node is down
Device Name FSTS2TP-NMS300 Device IP 192.168.10.202
Alarm Source Device:FS7S2TP-NMS300 Severity Critical
Alarm Type Status Alarm Notification 01D
Alarm Time 04/08/2013 02:06:10 Acknowledge By
Acknowledge Time ‘Occurrence Counter 1

| Close

c. To close the Alarm Detail pop-up window, click the Close button.
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e Acknowledge an alarm:
a. Select the alarm.
b. Click the Acknowledge button.
Acknowledging an alarm means that you take ownership of the issue.

* Clear an alarm:
a. Select the alarm.
b. Click the Clear button.
Clearing an alarm means that the fault that the alarm indicates no longer exists.

e Acknowledge a batch of alarms:
a. Select multiple alarms.

b. From the More menu, select Batch Acknowledge.
e Clear a batch of alarms:

a. Select multiple alarms.

b. From the More menu, select Batch Clear.
e Export the entire Current Alarms table to an Excel spreadsheet:

a. From the More menu, select Export to Excel.

b. To save the alarms on your computer, follow the directions of your browser.
e Export the entire Current Alarms table to a PDF:

a. From the More menu, select Export to PDF.
b. To save the alarms on your computer, follow the directions of your browser.

View and Manage the Alarm History

The Alarm History table shows the previous alarms for the entire network. You can remove
alarms from this table to reduce the amount of disk space that the application requires on the
server. You can also export alarms.

» To view and manage the alarm history:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ALARMS > ALARM HISTORY.

HOME

MONITOR

TOPOLOGY

ADMIN

ALARM HISTORY

Adarmn History

Fitter{[Clear Time Range: Today]

[ Alarm Name
O Hade is down
[ Mode is down
[ Mode is down
[ node is down
O node is down
[ Mode is down
O node is down
O Node is down
O tinkDigwn

[ Node is down

# Device Name
FVS3186
B6.166.147.250
FV33186
FVS318G
B6.166.147.250
Jimmy-620-168
19216810217
Jur-6-M5300-jimrry
192168.10.226
wi-T520-164

[“octss | Deiee ]| _oochpeice [ ICTRS

# Device IP %
66.166.147.252
66.166.147.250
G6.166.147.252
B6.166.147.252
B6.166.147.250
19216810168
19216810217
192.168.10.209
19216810226
19216810164

Alam Source

Device PS80
DrevicecBE.166.147.250
Device FVS318G
Device FVS318G
Dievice-66.166.147.250
AP Jimmy-620-168
Device 1921681017
Deevice:Jun-6-M5300-jirmmnmy
Interface Index 36
Confrollerwe-7520-164

g
£

& Alarm Time

091072013 18:05:11
08/10/2013 18:05:11
081 0/2013 175734
0202013 17:48113
09NN 3174813
091 02013 16:39: 1
0811072013 16:36:22
08/10/2013 16:36:11
081052013 14:31:30
091 0201 3 15:50:35

' Show Filter

Rowsperpage| 10 [ < [ 1 |14 > [EEI Tota33

# Cleared Time
0N Q2013 18:06:3
091042013 18:06:05
DIM0F2013 17:56:26
092013175102
0ENQ01317:51.00
08N 2013165403
DEN0Z01316:37:49
DINDI2013 16:37:49
0BM0M2013 15.56:06
082013155308

(7]

5. To add columns to or remove them from the Alarm History table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Alarm Name, Device Name, Device IP,

Alarm Source, Severity, Alarm Time, Cleared Time, Notification OID, Cleared By, Alarm
Type, and Occurrence Counter.

6. To filter the alarm history entries that are listed, click the Show Filter button.

You can filter the alarm history entries by criteria such as time range, device name, device

IP address, severity level, and alarm name. By default, the alarm history entries are

filtered to display today’s entries.

To hide the filter, click the Hide Filter button.

7. Take one of the following actions:
* View details for an alarm:

a. Select the alarm.
b. Click the Detail button.

i History Alarm Detail X

Alarm Time
Device Name
Alarm Source
Severity
Acknowledge By
Cleared By

‘Occurrence Counter

Close

04/10/2013 09:45.08

192.168.10.218

Device:192.168.10.218

Critical

System

1

Alarm Name

Device IP

Alarm Type

Notification OID

Acknowledge Time

Cleared Time

Node is down

192.168.10.218

Status Alarm

04/10/2013 10:36:01

To close the History Alarm Detail pop-up window, click the Close button.

e Delete an alarm:

a. Select the alarm.
b. Click the Delete button.
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The alarm is removed from the database.

* Delete a batch of alarms:
a. Select multiple alarms.
b. Click the Batch Delete button.
The alarms are removed from the database.

e Export the entire Alarm History table to an Excel spreadsheet:

a. From the More menu, select Export to Excel.

b. To save the alarms on your computer, follow the directions of your browser.
e Export the entire Alarm History table to a PDF:

a. From the More menu, select Export to PDF.

b. To save the alarms on your computer, follow the directions of your browser.

View and Manage Alarm Configurations

If an upper or lower threshold is exceeded, an alarm configuration generates an alarm. The
application provides many default alarms, including status alarms, monitor alarms, and trap
alarms.

The default status alarms include the following critical alarms:

e FTP service is down

* Node is down

e Performance management (PM) collection service error
e Syslog service is down

* TFTP service is down

e Trap service is down

The default monitor alarms include alarms for memory and CPU utilization of devices and
disk, CPU, and memory utilization of the NMS300 server. The application provides multiple
default trap alarms.

You can view, disable, reenable, remove, and export alarm configurations. For information
about how to add a custom alarm configuration, see Add a Custom Alarm Configuration on
page 176. For information about how to modify an existing alarm configuration, see Modify an
Alarm Configuration on page 179.

> To view and manage the alarms configurations:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select ALARMS > ALARM CONFIGUATION.

WIRELESS RESOURCES MONITOR TOPOLOGY ADMIH

ALARM CONFIGURATION

Alarm Configuration (7]
riertons [ Showeite |
[ agd I ean || Enavie [WIVTRA Rowsperpage| 10 B3 < [ 1 |r12 > [EEN Tomk112

1 Enable # Alarm Name - Alarm Type # Trap Name % Motification OID # Severity *
O & ves atTrapRuleLogEvent Trap Alarm aciTrapRuleLogEvent 1.26.1.4.1.452611,3.2.01 Info

(] s acTrapRuleLogEvent Trap Alarm aciTrapRuleLogEvent 1.36.1.41.452610.3.2.01 Info

(] es agentinventonyCardMismateh Trap Alarm agentinventonyCardMismatch 1.36.1.41.4526.11.13.01

O 8 ves agentinventoryCardMismatch Trap Alarm agentivventoryCardMismatch 1.36.1.4.1.452610.13.01 m
0 & ves agentirvertoryCardUnsupported Trap Alarm agentinventonyCardUnsupported 136.1.41.4526.11.13.02 | inor ]

(|} e agentinventornyCardUnsupported Trap Alarm agentinventonCardUnsupported 1.36.1.4.1.452610.13.0.2
(] es agentinventoryStackPorlinkDiown Trap Alarm agentiventoryStackPorLinkDown 1.36.1.41.452611.13.04

a Vs agentinventoryStackPorLinkDown Trap Alarm agentinventoryStackPorLinkDown 1.36.1.41.4526.10.13.04

0O 8@ ves agentinventoryStackPorLinkUp Trap Alarm agentimventoryStackPonLinklp 1.36.1.4.1.4526.11.13.03 Info

(|} fes agentinventonyStackPorLinkUp Trap Alarm agentinventoryStackPorLinklUp 1.36.1.41.4526.10.13.0.3 Info

To add columns to or remove them from the Alarm Configuration table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Enable, Alarm Name, Alarm Type, Trap
Name, Notification OID, Severity, MIB Name, and Description.

To filter the alarm configurations that are listed, click the Show Filter button.

You can filter the alarm configuration by criteria such as alarm name, enabled status,
alarm type, and severity.

To hide the filter, click the Hide Filter button.
Take one of the following actions:
* Disable an alarm configuration:
a. Select the alarm configuration.
b. From the More menu, select Disable.
A confirmation pop-up window opens.
c. Click the Yes button.

The alarm configuration is disabled and can no longer generate an alarm. In the
Alarm Configuration table, the Enable column displays No for the alarm
configuration.

* Enable an alarm configuration:
a. Select the alarm configuration.
b. Select the Enable button.

The alarm configuration is enabled and can generate an alarm. In the Alarm
Configuration table, the Enable column displays Yes for the alarm configuration.
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« Remove an alarm configuration:
a. Select the alarm configuration.
b. From the More menu, select Delete.
A confirmation pop-up window opens.

c. Click the Yes button.

The alarm configuration is removed from the Alarm Configuration table and
deleted.

e Export the entire Alarm Configuration table to an Excel spreadsheet:
a. From the More menu, select Export to Excel.

b. To save the alarm configurations on your computer, follow the directions of your
browser.

e Export the entire Alarm Configuration table to a PDF:
a. From the More menu, select Export to PDF.

b. To save the alarm configurations on your computer, follow the directions of your
browser.

Add a Custom Alarm Configuration

You can define your own alarms, including alarms for all configuration monitors (see Manage
the Configuration Monitors on page 102).

A custom alarm configuration that you add is always based on an existing configuration
monitor and includes a threshold. The configuration monitor determines the polling interval
for the alarm configuration. For more information, see Manage the Configuration Monitors on
page 102.

» To add one or more custom alarm configurations:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ALARMS > ALARM CONFIGUATION.

WIRELESS

RESOURCES MONITOR

TOPOLOGY

ADMIH

ALARM CONFIGURATION

e
_ Show Fiter |

Alarm Configuration

Fitter:Nome

0o [[con || enovic (TS
1 Enable # Alarm Name

Ve atTrapRuleLogEvent

Yes aclTrapRuleLogEvent

Va5 agentimentoryCardiismatch

Yes agentinventoryCardMismatch

b agentinventonyCardUnsuppored
agentinventornyCardUnsupported
Yes agentinventonyStackPorLinkDown
s agentinventoryStackPorLinkDown
Yes agentinventaryStackPoLinkUp
Yes agentinventoryStackPorLinkUp

O0ooCcoO0oOD0oOo0Oo
[<H<N<N<N<N<N<N<J<N<]
=
o

- Alarm Type
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarm
Trap Alarrm
Trap Alarm

# Trap Name
aciTrapRuleLogEvent
aciTrapRuleLogEvent
agentinventonyCardMismatch
agentinventoryCardMismatch
agentinventorCardUnsupported
agentinventonCardUnsupported
agentiventoryStackPorLinkDown
agentinventoryStackPoriLinkDown
agentinventoryStackPortLinkUp
agentinventoryStackPorLinklUp

Rowsperpage| 10 B9 < [ 1 |12 > Total: 112

% Nobification OID
1.36.1.4.1.4526.11.3.201
1.36.1.41.4526103.2.01
1.361.41.4526.11.13.01
1.36.1.41.4526.10.13.01
1.361.41452611.1302
136.1.4.1.4526.10.13.0.2
1.36.1.41.452611.13.04
1.36.1.41.4526.10.13.04
136.1.41.452611.1303
1.361.41452610.13.0.3

# Severity *
info

Info

Infix

Info

5. Click the Add button.

& Add Threshold Alarm X

Monitor Package

Monitor Hame Device ICMP Ping g Description Device ICMP Ping results

Polling Interval(minutes) s Enable [v]

Tiweshold List [ aaa | Ear |

Rows per page | 10 u < 1014 > PEER Totsho
[] Paramter « Enable 4 Alarm Name ¢ Upperiower ¢ Count® Threshold ¢ Severity %
No data to display!

< |3

6. From the Monitor Name menu, select the monitor.

7. In the Description field, enter a new description, or use the default description.

The configuration monitor determines the polling interval for the alarm configuration. For
more information, see Manage the Configuration Monitors on page 102.

The Enable field shows whether the configuration monitor is enabled. However, you can
enable an alarm configuration even if the configuration monitor is disabled.
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8. Click the Add button.

% Add Threshold Alarm (Device ICMP Ping) X

General Info
Alarm Hame [
Description | A|
Paramter
Enable

Calculation Type Consecutive E

Count

Threshold Alarm Info

UpperLower Upper E

Threshold

Severi

m Cancel

Max Response Time (ms) u

9. Enter the following threshold information:
General Info:

Alarm Name. Enter a name for the alarm.
Description. Enter a description for the alarm.

Parameter. Select a parameter. The parameters that are displayed in the menu
depend on the monitor that you select in Step 6.

Enable. Select whether to enable the threshold.
Calculation Type. Select a consecutive or average calculation.

Count. Select the number of times that a particular event must occur before the
threshold is met.

Threshold Alarm Info:

Upper/Lower. Select an upper or lower threshold.

Threshold. Enter the threshold. If this threshold is exceeded, the application
triggers an alarm.

Severity. Select whether the alarm is considered critical, major, minor, or
informational.

10. Click the Submit button.

The Add Threshold pop-up window for the selected monitor pop-up window closes and
the alarm configuration is added to the Threshold List table.

11. To add another alarm configuration, repeat Step 8 through Step 10.

Before you add a new alarm configuration to the Alarm Configuration table, you can still
modify or remove the alarm configuration.

12. To close the general Add Threshold pop-up window, click the Close button.

All new alarm configurations are added to the Alarm Configuration table.
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Modify an Alarm Configuration

You can modify a default or custom alarm configuration.

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select ALARMS > ALARM CONFIGUATION.

WIRELESS RESOURCES MONITOR TOPOLOGY 0BS ADMIH

ALARM CONFIGURATION

Alarm Configuration (7]
Fitertlone
20 | T | IEET | wore ~ | Rowsperpage| 10 B9 < [ 1 |12 > Totak 112

[l Enable # Alarm Name - Mamm Type % Trap Name # Mobification OID 4 Severity Ll
(] fes aclTrapRuleLogEvent Trap Alarm aciTrapRuleLogEvent 136.1.41.452611.3.2.01 Info

(] s acTrapRuleLogEvent Trap Alarm aciTrapRuleLogEvent 1.36.1.41.452610.3.2.01 Info

O Tes agentinvenonCardMismatch Trap Alarm agentnvenonCardMismatch 1.2.6.1.47.452601.03.00

0O @ ves agentinvertoryCardMismatch Trap Alarmn agentivventonyCardMismateh 13.6.1.4.1.4526.10.13.0.1 “
0 & ves agentirvertoryCardUnsupported Trap Alarm agentinventonyCardUnsupported 136.1.41.4526.11.13.02 | inor ]

(|} e agentinventornyCardUnsupported Trap Alarm agentinventonCardUnsupported 1.36.1.4.1.4526.10.13.0.2 “
(] Yas agentinventonyStackPorLinkDown Trap Alarm agentinventoryStackPorLinkDown 1.361.41452611.1304

O Vs agentinventoryStackPorLinkDown Trap Alarm agentinventoryStackPorLinkDown 1.36.1.4.1.4526.10.13.04

0O @ ves agentinventoryStackPorLinkUp Trap Mlarm agentinentoryStackPonLinklUp 136.1.41.452611.1303 Infix

0O 8 ves agentinvertoryStackPorLinkUp Trap Alarm agentinventoryStackPortLinkUp 136.1.41.4526.10.13.03 Info

To add columns to or remove them from the Alarm Configuration table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Enable, Alarm Name, Alarm Type, Trap
Name, Notification OID, Severity, MIB Name, and Description.

To filter the alarm configurations that are listed, click the Show Filter button.

You can filter the alarm configuration by criteria such as alarm name, enabled status,
alarm type, and severity.

To hide the filter, click the Hide Filter button.

Select the alarm configuration.
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8. Click the Edit button.

General Info
Alarm Hame [ has cPU wtization is over 80% z
Deseription | NMS CPU wtilization is over 80%
Paramter [ Server cPu Utizations) A
Enable - — |
Calculation Type [consecuive |
Count E—
Threshold Alarm info
UpperLower
Threshold 50.00 .
Severity Major

| submit JEGTEN

9. Modify the following threshold information as needed:
* General Info:
- Alarm Name. Modify the name for the alarm.
- Description. Modify the description for the alarm.
- Parameter. You cannot modify the parameter.
- Enable. Select whether to enable the threshold.

- Calculation Type. You cannot modify the type of calculation.
- Count. Select the number of times that a particular event must occur before the

threshold is met.
e Threshold Alarm Info:

- Upper/Lower. You cannot modify the type of threshold.
- Threshold. Modify the threshold. If this threshold is exceeded, the application

triggers an alarm.

- Severity. Select whether the alarm is considered critical, major, minor, or

informational.
10. Click the Submit button.

The modified alarm configuration displays in the Alarm Configuration table.

View and Manage Alarm Notification Profiles

An alarm notification profile specifies criteria that enable the application to generate and send
a notification email message if an alarm occurs. By default, the application does not include

any alarm notification profiles.

Before the application can generate email and SMS messages, you must provide email
server settings and SMS server settings. For more information, see Configure the Email
Server for Alerts and Alarm Notifications on page 25 and Configure the SMS Server for Alerts

and Alarm Notifications on page 29.
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» To view and manage alarm notification profiles:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select ALARMS > NOTIFICATION PROFILES.
[ vwccs | moomecs | womion | _come | s | oo | suon | s | ow | vias | om |

ROTIFICATION PROFILES

Alarm Notification (7]

[ add | Edt [ Deiete [IITTIRS Rowsperpage| 10 g < | 1 i1 > [N Totar1
[ Enable # Profile Narme =~ Device Group % Selected Alamms # Marmn Time *
0O 8 re Jirnrry-email-notity Major and above Al Day

If you did not yet add any alarm notification profiles (see Add or Modify an Alarm
Notification Profile on page 182), the Alarm Notification table is empty.

To add columns to or remove them from the Alarm Notification table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Enable, Profile Name, Device Group,
Selected Alarms, Alarm Time, Created By, and Create Time.

Select an alarm notification profile.
Take one of the following actions:
e Disable the alarm natification profile:

a. From the More menu, select Disable.
A confirmation pop-up window opens.
b. Click the Yes button.

The alarm natification profile is disabled and can no longer generate an email
message. In the Alarm Notification table, the Enable column displays No for the
alarm notification profile.
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* Reenable the alarm notification profile. From the More menu, select Enable.

The alarm natification profile is enabled and can generate an email message. In the
Alarm Notification table, the Enable column displays Yes for the alarm notification
profile.

* Remove the alarm notification profile:
a. Select the Delete button.
A confirmation pop-up window opens.
b. Click the Yes button.

The alarm natification profile is removed from the Alarm Notification table and
deleted.

Add or Modify an Alarm Notification Profile

By default, the application does not include any alarm notification profiles. To be notified if an
alarm occurs, you must add an alarm notification profile.

To add an alarm notification profile or modify an existing alarm notification profile:

1.

5.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select ALARMS > NOTIFICATION PROFILES.
[R5 [esowezs1 [ Ruearon 8 Scomse IR oo o [ et 2 [ Mrerours N oes R Awsoe [ A |

HOTIFICATION PROFILES

Alarm Notification [7]

[ add [] Edt [ Delete JINITCIRG Rowsperpage| 10 [ < [ 1 |1 > [ ol
[ Enable # Profile Name - Device Group # Selected Alams ® Alamn Time %
0O B8wne Jirarroyemail-notity Major and above Al Day

To add columns to or remove them from the Alarm Notification table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.
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You can choose from the following columns: Enable, Profile Name, Device Group,
Selected Alarms, Alarm Time, Created By, and Create Time.
6. Add an alarm notification profile or modify an existing alarm notification profile:
» To add an alarm notification profile, click the Add button.
» To modify an existing alarm notification profile:
a. From the Alarm Notification table, select the alarm notification profile.
b. Click the Edit button.

For a new alarm natification profile, the Add Alarm Notification pop-up window opens. For
an existing alarm notification profile, the Edit Alarm Notification pop-up window opens.

¥ Add Alarm Notification X
Basic Information
Profile Name | r a st . ' ‘ 4 Device Group Al
Description | ‘ Enable Yes
Select Alarm

& select Alarms by Severity Critcal [v]

" Select one or more Alarms

Previous Hext Cancel

7. In the Basic Information section, specify or modify the following information:
* Profile Name. Enter or modify the name for the profile.

e Description. Enter or modify the description for the profile.

e Device Groups. Select whether to apply the profile to all device groups or to a
particular device group.

e Enable. Select whether to enable the alarm notification profile.
8. In the Select Alarm section, select one of the following radio buttons:

o Select Alarms by Severity. Select the alarms by severity by selecting a severity level
from the menu.
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e Select one or more Alarms. The appearance of the pop-up window changes,
enabling you to add alarms:

a. Click the Add button.

% Select one or more Alarms X

Rows perpage[ 10 I < [ 1 6 > [N Totai 74
|:| Enable $ Alarm Name - Alarm Type & Severity &
D- Yes a "IinkDown -TranAIa;.m 1
O] B ves authenticationFailure Trap Alarm
O Yas agerdinventory CardMismatch Trap Alarm
O & ves agentinventoryCardUnsupported Trap Alarm “
O] @ves agertinventoryStackPortLinkDown Trap Alsrm sio
O Yas linkFailureTrap Trap Alarm
O &8 ves vianRequestFaiureTrap Trap Alarm “
O & ves vienDefaulCigFaiureTrap Trap Alarm
O Yas vianRestareFailureTrap Trap Alarm
O Bves fanFailureTrap Trap Alarm
Add Selection || Add ANl | | Close |

b. Select the alarms that you want to include in the alarm notification profile.
c. Click the Add Selection button.

To add all alarms, click the Add All button.

The alarms are added to the Add Alarm Notification pop-up window (or, if you are

modifying an existing alarm notification profile, to the Edit Alarm Notification
pop-up window).

d. If you are modifying an existing alarm notification profile, to remove alarms,
select the alarms, and click the Remove button.

The alarms are removed from the Edit Alarm Notification pop-up window.

9. Click the Trigger tab.

¥ Add Alarm Notification

‘

EZEETT

Alarm Generation Time

To

Alarm notification applies to alarms that occur in any time of day.

18: 0 :00 % Alarm notification applies to alarms that occur in the specified time of day.

@ All Day

) Time From 9:0 :003
Trigger Action

E-mail To [admin@email.com
[[] sSMsTo

Previous 'Ne:(l‘ Cancel

1 System will automatically send emails to the email address(es)
when the alarm notification profile condition is triggered.

System will automatically send message to the telephone
when the alarm notification profile condition is triggered.
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10. Specify or madify the following information:
e Alarm Generation Time. Select one of the following radio buttons:
- All Day. The alarm notification applies to alarms that occur at any time of the day.

- Time Frame. From the menus, select a time frame. The alarm notification applies
only to alarms that occur in the specified time frame.

e Trigger Action. Select one or both check boxes:

- E-mail To. Enter the email address to which the application can send a
notification if the alarm notification condition is triggered.

- SMS To. Enter the telephone number to which the application can send a
notification if the alarm notification condition is triggered.

Note: The SMS natification option is supported for a particular SMS gateway in
the People's Republic of China only. For more information, see Configure
the SMS Server for Alerts and Alarm Notifications on page 29.
11. Click the Save button.

The Add Alarm Notification or Edit Alarm Notification pop-up window closes. The alarm
profile notification displays in the Alarm Notification table.

Customize Alarm Colors

You can change the colors of the alarms.

» To customize the color of an alarm:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS

L Discover your network and addthe devices you wanl to
manage.

System Settings
Set global seftings for the system and website,

Account Information

Manage Monitor and Alarm
Wiew or modify users. or create new users.

Metwork moniter, alarm and thresheld related configurations.

3 sFlow

Manage External File Server
Y SetsFlow related configurations.

&% Enemal File Server configurations and File Processing with
External File Server,

System Backup/Restore

System BackupRestore Server Configurations and
Processing.

@

4 Customize
A{ Customize the navigation and look of your web portal.

‘g MyMNETGEAR.com Account Profile

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

License And Version Infarmation

View NMS300 license. supponed device andversion
information

5. Under Customize, click the Customize Alarm Color link.

B customize Alarm Colors

Customize Alarm Colors (Click alarm color to select )

e —
Major

6. Click the alarm color.
7. Select another color.

OmE N
EEER

Customize
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Click the Submit button.

Your changes are saved.

View and Manage Network Event Notifications

The Events table shows the events for the entire network, including events for devices and
interfaces. You can display details about network events, remove network events, and export
network events.

» To view and manage network events:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Select ALARMS > EVENTS.
[rwiomers | wowron | cows | mawws [ rowoor | wmow [ mooms | o | v | aom |

EVENTS

Events (7]
| oetail | oetete | Batchpetete  [JMEETIN Rowsperpage| 10 4 < [ 1 |15 > [EEN Totar47

[ EventName & Device Name ® Device IP ® EventSource & EventType & EventTime <
O tinkp 19216810226 19216810226 Interface Indexc36 Trap Alarm 0802013155806

O tinksp 192.168.10.226 19216810226 Interface Indexc32 Trap Alarrn 09N 072013 15:49:42

O linkip 19216810226 19216810226 Interface Index32 Trap Alarm 0OMQZ01315:49:24

O linkiip 19216810226 19216810226 Interface Index27 Trap Alarrn 0OM Q2013 15:30:04

O tinkip 19216810226 19216810226 Interface Index2? Trap Alarm 0ANW01315:29:51

O tinkp 192.168.10.226 192.168.10.226 Interface Indewc2? Trap Alarrmn 092013152915

O tinkusp 19216810226 19216810226 Interface Index27 Trap Alarrm 002013 16:28:38

O tinkp 192.168.10.226 19216810226 Interface Index2? Trap Alarrn 002013 15:14:35

O linkisp 19216810226 19216810226 Interface Index2? Trap Alarm DAM0201315:14:22

O linkisp 192.168.10.226 19216810226 Interface Indexc2? Trap Alarm 08NQW2013 151346

To add columns to or remove them from the Events table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Event Name, Device Name, Device IP,
Event Source, Event Type, Event Time, and Notification OID.

To filter the event entries that are listed, click the Show Filter button.

You can filter the event entries by criteria such as time range, device name, device IP
address, and severity level. By default, the event entries are filtered to display today’s
entries.
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To hide the filter, click the Hide Filter button.

7. Take one of the following actions:
¢ View details for an event:

a. Select the event.
b. Click the Detail button.

Event Name stpinstanceTopalogyChangsTrap Device Name 14100_208-jimmy
Device IP 192.168.10.208 Event Source Device:M4100_208-jimmy
Event Type Trap Alarm Hotification OID 1.38.1.4.1.4528.101.0.11

Event Time 05/23/2013 15:54:23

Close

c. To close the Event Detail pop-up window, click the Close button.
* Delete an event:

a. Select the event.
b. Click the Delete button.
The event is removed from the database.
e Delete a batch of events:
a. Select multiple events.
b. Click the Batch Delete button.
The events are removed from the database.
* Export the entire Events table to an Excel spreadsheet:
a. From the More menu, select Export to Excel.

b. To save the events on your computer, follow the directions of your browser.
e Export the entire Events table to a PDF:

a. From the More menu, select Export to PDF.
b. To save the events on your computer, follow the directions of your browser.

View and Manage Device Traps

The Traps table shows the device trap events. You can display details about device trap
events, remove device trap events, and export device trap events.

> To view and manage device traps:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
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A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select ALARMS > TRAPS.

Traps 7]
| Detail || Deiete || BatchDetete (I Rowsperpage| 10 [ < [ 1 |18 > Total: 80
[ Source P # Trap Type # MNotification 0ID + Receive Time ~ Trap Detail

O 192.168.10.226 linkDigwr 1361831153 092013 16:34:05 136020 22100.31:31,1.361 21221 7.3111,1.361.21.221.831:2

[ 192.168.10.226 lnkDigwn 1361631153 09N 072013 16:33:51 1360202200221, 13610202 20.7.21:1,1.361.21.2.21.8.21:2

O 1921681017 falledUserLoginTrap 1.36.1.41.4526001.013 0902013 16:31:21

O 192168.10.226 falledUserLoginTrap 1.36.1.41.4526.11.1.013 09N 2013 16:30.17

[ 192.168.10.226 linkDown 1361631153 097102013 16:01:36 1361.21.221.136:36,1.361.21.221.7361.1.361.21221836:2

O 192.168.10.226 HirkUp 1361631154 0911072013 15:58:06 1.361.21.221.136:36,1.361.21.2.21.7.36:1;1.261.21.221.8.361

O 192.168.10.226 linkLp 1261631154 002013 15:49:42 1360 21.22113031.261.21.221.73201;1.361.21.2218321

O 192.168.10.226 linkDown 1.36.1.631.1.53 081072013 15:49:38 1.3.6.1.21.221.1.32:32:1.36.1.21.2.21.7.32:1,1.36.1.21.2.21.832:2

[ 19216810226 linkUgp 1361631154 092013 1549:24 1360202201303 1361202207321, 1.3.61.21.2.21.8321

[ 192.168.10.226 lnkDgwn 1361631153 08M 012013 15:49:18 1.360.20.2210.1.3232,1.36.1.21.2.21.7.32:1;1.3.6.1.21.2.21.832:2

& >

To add columns to or remove them from the Traps table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Source IP, Trap Type, Notification OID,
Receive Time, Trap Detail, Trap Version, and Time Stamp.

To filter the trap entries that are listed, click the Show Filter button.

You can filter the trap entries by criteria such as time range, device IP address, and trap
type. By default, the trap entries are filtered to display today’s entries.

To hide the filter, click the Hide Filter button.
Take one of the following actions:
* View details for a trap:

a. Select the trap.

b. Click the Detail button.

¥i Trap Detail X

Source IP 192.188.10.208
Trap Version vze
Hotification OID 1.36.1.21.17.02
Trap Type 1.36.1.2.1.17.02
Time Stamp 3 days, 6 hours, 58 minutes, 07 seconds.
Receive Time 05/2312013 15:54:25
Trap Detail
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c. To close the Trap Detail pop-up window, click the Close button.
e Delete a trap:

a. Select the trap.
b. Click the Delete button.

The trap is removed from the database.
« Delete a batch of traps:

a. Select multiple traps.
b. Click the Batch Delete button.

The traps are removed from the database.
* Export the entire Traps table to an Excel spreadsheet:
a. From the More menu, select Export to Excel.

b. To save the traps on your computer, follow the directions of your browser.
e Export the entire Traps table to a PDF:

a. From the More menu, select Export to PDF.
b. To save the traps on your computer, follow the directions of your browser.

View and Manage Device System Logs

The Syslog table shows the device system log entries. You can display details about log
entries, remove log entries, and export log entries.

> To view and manage the device system log entries:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select ALARMS > SYSLOGS.

WIRELESS MONITOR CONFIG REPORTS ADMIN

Syslogs (7]
Fiter:{Receive Time Range: Totiay]
| Detail || peiete | Batcnpelete [N Rows perpage 10 [ < [ 1 |r297 > [N Tota: 2963

[ Receive Time ~ Device IP & Facility & Severlly & Message s

O 01002013 18:41:15 19216810162 dagmaon Info Jan 1 02:51:44 Idpd[585]: ldpd_decode: unable 1o guess frame type

O 02102013 18:41:14 192.168.10.168 dagmaon Info. Jan 1 02:01:08 lldpd[684]: ldpd_decode: unable 1o guess frame type

O 091052013 18:41:08 19216810162 daemaon Infe Jan 1 02:51:35 Idpd[685): lldpd_decode: unable 10 guess frame type

O 0911072013 18:41:02 192.168.10.162 daemon I Jan 1 02:51:30 I1dpd[685]: ldpd_decode: unable 1o guess frame type

O oar02013 18:41:02 19216810168 dagrmon Info Jan 1 02.00:55 IIdpd[684]; lldpd_decode: unable 10 guess frame type

O | 0ai052013 18:40:58 19216810162 daemon Infg. Jan 1 02:51:27 IIdpd[685]: ldpd_decode: unable 1o guess frame type

O o10:2013 18:40:54 19216810162 dagmaon Info Jan 1 02:51:23 Idpd[685]: Ndpd_decode: unable 10 guess frame type

O 0210:2013 18:40:45 192.168.10.162 dagmaon Infg. Jan 1 02:51:13 IIdpd[685): lldpd_decode: unable 1o guess frame type

O 091052013 18:40:44 19216810168 daegmaon Inife Jan 1 02:00:37 lldpd[684): lldpd_decode: unable 10 guess frame type

O o8/1052013 18:40:36 192.168.10.162 daemon Infg. Jan 1 02:51:08 IIdpd[685]: ldpd_decode: unable 1o guess frame type

To filter the syslog entries that are listed, click the Show Filter button.

You can filter the syslog entries by criteria such as time range, device IP address, and
severity level. By default, the syslog entries are filtered to display today’s entries.

To hide the filter, click the Hide Filter button.
Take one of the following actions:
* View details for a log entry:

a. Select the log entry.
b. Click the Detail button.

¥ Device Syslog Detail X

Receive Time (05/24/2013 13:53:34

Device IP 192.168.10.238

Facility user

Severity debug

Message JAN 01 01:15:27 192.168.10.238-2 BOXSERV[-1937443136]: sysapi_hpc.c(1780) 1053 %% sysapHpcLocalFanDataGet: fan 2 fault detected, state 3

c. To close the Device Syslog Detail pop-up window, click the Close button.
* Delete a log entry:

a. Select the log entry.
b. Click the Delete button.
The log is removed from the database.
e Delete a batch of log entries:

a. Select multiple log entries.
b. Click the Batch Delete button.

The log entries are removed from the database.
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e Export the entire Syslogs table to an Excel spreadsheet:

a. From the More menu, select Export to Excel.

b. To save the log entries on your computer, follow the directions of your browser.
e Export the entire Syslogs table to a PDF:

a. From the More menu, select Export to PDF.

b. To save the log entries on your computer, follow the directions of your browser.
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Manage Maps and Topologies

View the topology of your network

You can create hierarchical maps and topological views of your network.

This chapter covers the following topics:

* View and Manage Maps
» View and Manage Network Topologies
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View and Manage Maps

The application provides a default world map. This map is the root map for any child map that
you add.

The following sections describe the tasks that relate to maps:

View a Hierarchical Map and Locate a Device

Manage a Hierarchical Map

Add an Alarm Configuration for a Link on a Hierarchical Map
Change an Alarm Configuration for a Link on a Hierarchical Map
Add a Childmap

Add Devices to a Map

Add a Link Between Devices on a Map

Customize the Style of a Link on a Map

View a Hierarchical Map and Locate a Device

You can view a hierarchical map of your network, locate devices on the map, and view details
about the devices, including alarms.

» To view a hierarchical map, locate a device on the map, and view details about the
device:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
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4. Select TOPOLOGY > MAP VIEWS.

WIRELESS 3 MONITOR CONFIG ALARM S TOPOLOGY REPORTS

ADMIN
MAP VIEWS

B A e %Y 8 0080 09 @ 0 &

.____t_,z_)_ﬁblld i Maps Devices Link Delete Refresh Auto  Sefting Resat  Help  Screen  Print

|=]F]= ®

6810014

- — ™, ‘\.
Search % e
Derics Kame = 192.168.10.208 )
@ 192.162.10.200 192188100208
- 192.168.10.213
@ 192.168.10.215 192.188.10.215 68.10.205

@ 192.168.10.205 19216810205
@ Frery-pamT2E 19218810247
@ 192.162.90.208  192.162.10.208
@ GSTASTV2 Sman 192.162.10.204
0 192.168.10.213  192.162.10.213

A EETETID MAET 107 1R 10N

5. From the Map Tree, select the map.

The selected map displays.

- (Block...)
= 2y 2 = N p P =
Map Tree B E €& % @ o e IR IE 2
© Q World Maps Devices Link Delete Refresh Aulo  Seting Reset Help Screen  Print
)RR "l_'"_ TN s —rsiry (4
 San Jose I 1 X T ; =
§ China Netgear \g o . e

e Meware

@ 192.168.10.114 | 182.168.10.114
@ 192.168.10.104 | 192.168.10.104

|@ 192.188.10.202 | 192.168.10.202

6. From the Device List table, select the device that you want to locate on the map.
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A circle displays around the selected device.

Map View (m“
N ¢ o= - " (3] =
e B 5 ¢ %8 oo s e s
© § World Maps Devices Link Delete Refresh | Auto  Seftng Reset Help Screen Print
‘o &9 San Jose Netgear
& San Jose Il

<
@ China Netgear

y s
192.168.10. s
- 1‘!2\ 1

;
o o
el e

Device Name ®

@ 192.168.10.104 | 192.168.10.104

@ 192.168.10.202 | 102.168.10.202

© 192.168.10.114  192.168.10.114 ‘ z

* 192.168.10.104

Wi D

7. To view information about the device (node), point to the device on the map.

A pop-up window similar to the following opens.

3

192.168@{;,124

Node:192.168.10.124

IP Address: 192.168.10.124
MNode Status: ~ @up
Device Type: € Switch
Vendor: Netgear

8. To see detailed information and the Dashboard menu for the device, double-click the device
on the map.

For more information, see View Device Details and Interface Details on page 95.
9. To view the details for a link, point to the link on the map.

A pop-up window similar to the following opens.

20

Link:mass -192.168.10.124

A Interface: 1/g47
Z Interface: 1/0/6
| Speed: 1000Mbps |

10. To view the summary for an alarm, point to the alarm summary on the map.

An alarm summary is displayed as a red-colored rectangular with a number.
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A pop-up window similar to the following opens.

[ Alarm Summary

Critical:
Major:
Minar:

.I_ Total Count:

Manage a Hierarchical Map

On the Map Views page, the icons that display above a map let you perform various tasks.

B B & % 8 OB 9 € i1 &

Maps Devices Link Delete Refresh  Auto Setting Reset Help Screen  Print

Figure 3. Icons on the Map Views page

The following procedure describes the tasks that you can perform for a hierarchical map. For
complicated tasks, the procedure points to a section that provides detailed information.

> To manage a hierarchical map:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

Manage Maps and Topologies
197



NMS300 Network Management System Application

4. Select TOPOLOGY > MAP VIEWS.

WIRELESS | RESOURCES | MOMITOR TOPOLOGY REPORTS 5 ADMIN
MAP VIEWS
Map View ?
21 G e - L] [
Map Tree . LI % 5 | e Rz HE > Nk-] < TR
| Word Maps Devices Link Delete Refresh Aute  Sefting Resat  Help  Sereen  Print
«

Search

Duwice Nume » 192.168.10.208 .~

@ W2.16210200 19218010200 & s
@ 10216810215 192.168.10.215 68.10.205
@ 192.162.90.205 192.168.10.205
@ Fereny-pamT22i 1921881017
ﬂ 192.168.90.208  192.168.10.208
@ CSTIETV2.Sma 192.188.10.204

@ 192.162.10.213 192.168.10.213

S CETETTE MRS 197 AR AL

5. From the Map Tree, select the map.
6. To rescale the map, use the scaling tool that displays on the left of the map.

Map View (mﬂ
| &) Q < i r 2 L] -
Msp Tree 8 B e % @ OG99 ¢ I &
© & World Maps Devices Link  Delete Refresh | Auto Settng Reset Help  Screen Print
© & San Jose Nelgear _ . T ———r———
© San Jose I e 3 § i % g N s

«
Q China Netgear T : e s ey

Search
Device Name i

@ 102.168.10.104 | 192.168.10.104

@ 192.168.10.202 | 192.168.10.202

© 192.168.10.114  192.168.10.114

7. To reposition the map, hold your cursor on the map and drag the map to a new position.
8. Take one of the following actions:
e Let the application refresh the map automatically. Click the Auto icon.

The map refreshes automatically every two minutes. Automatic refreshment is the
default setting.

* Refresh the map manually. Click the Refresh icon.

The map refreshes once immediately.
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* Add a childmap. Click the Maps icon.
For more information, see Add a Childmap on page 206.
e Add devices to a map. Click the Devices icon.
For more information, see Add Devices to a Map on page 208.
e Add a link between devices on a map. Click the Link icon.
For more information, see Add a Link Between Devices on a Map on page 210.
e Customize the link style settings. Click the Setting icon.
For more information, see Customize the Style of a Link on a Map on page 213.

* Remove a childmap, device, or link from the map:
a. Select the item.
b. Click the Delete icon.

The item is removed.

* Undo unsaved changes. Click the Reset icon.

The unsaved changes are reset.
e Save changes. Click the Save icon.

Your changes are saved. When the Save icon is grayed out, everything is saved.
e Open the Help pop-up window. Click the Help icon.

The Help pop-up window opens.
» Enter full-screen mode. Click the Screen icon.

The page displays in full-screen mode. To return to the regular page display, either
press the Esc key, or from the full screen, click the Screen icon.

* Print the page. Click the Print icon.

The map is printed.

Add an Alarm Configuration for a Link on a Hierarchical Map

You can add an alarm configuration and set alarm thresholds for a link on a hierarchical map.
The alarm configuration applies to the selected link only.

» To add an alarm configuration for a link on a hierarchical map:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

Manage Maps and Topologies
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The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.
4. Select TOPOLOGY > MAP VIEWS.

WIRELESS RESOURCES MONITOR TOPOLOGY REPORT S ADMIN

MAP VIEWS

CEE 8 re %Y d 089 e 0

9 World Maps Devices Link Delete Refresh Aute  Sefing Reset Help Screen  Print

Search

Device Xame ® 192.168.10.208 ~

@ 12.162.10200 19216810200 |
@ WI18.10.215 WLIRI02I5 68.10.205 1zleslezl)
@ 192.162.10.305 192.168.10.206
ﬂ Fney-gamT2A2E 192.168.10.217
0 102.168,90.208  192.168.10.208
@ CETAET2-Sma 192108 40.204
@ 192.160.30213 921NN

o coTETTD MK 19T 1R 10703

5. From the Map Tree, select the map.
6. Click a link between two devices.

The link displays in bold.
7. On the right of the page, click the tab.
The LEGEND pop-up window opens.

LEGEND

» Manual Link —
LLDP Link
_< 1.5Mbps = emeeee-
I \-.
' >= F5Mbps, < 10... ==-=-=-
1"" - 10MbpS, < 100... ~--nnn-
') >= 100Mbps, < 1G... =======
>= 1Gbps, < 10Gb... ====-=-
>=10Gbps =~ ====---

Unknown Speed m—————

Threshold Setting

8. At the bottom of the pop-up window, next to Threshold Settings, click the icon.
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The Add Threshold Alarm pop-up window opens.

¥ Add Threshold Alarm X

Monitor Package

Monitor Name Device interface Trafic |9 Description Device interface performance stq

Polling Intervaliminutes) 10 Minute v | Enable [v |

Tveshol it [“haa | ean_] ot |
Rowsperpage[ 10 [ < 1 /1 > | Go RETES

[] Parameter + Enable % Alarm Name % UpperiLower % Count® Threshoid % Severity 1

[ Transmitted Interface Utiiz... Yes Interface Utiization for TX is over 90% Upper 2
[]  Percent RX Packet Loss (%) Yes Packet Loss for RX is over 5% Upper 2 5.00
[] Percent TX Packet Loss (%) ﬂ Yes Packet Loss for TX is over 5% Upper 2 5.00

[

Close

The Threshold List contains four predefined thresholds. You can add more thresholds.
9. Click the Add button.

& Add Threshold Alarm %

Monitor Package
Monitor Hame Device ICMP Ping g Description Device ICMP Ping results
Polling Intervaliminutes) Enable es E
ThreshokdList [ aaa | can |
Rowsperpsge[ 10 B < [ 1 |11 > I Tow:o
D Paramter « Enable ¢ Alarm Name & Upperiower ¢ Court® Threshold & Severtty L]
No data to display!
L] | &)

10. From the Monitor Name menu, select the monitor.
11. In the Description field, enter a new description, or use the default description.

The configuration monitor determines the polling interval for the alarm configuration. For
more information, see Manage the Configuration Monitors on page 102.

The Enable field shows whether the configuration monitor is enabled. However, you can
enable an alarm configuration even if the configuration monitor is disabled.
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12. Click the Add button.

% Add Threshold Alarm (Device ICMP Ping) X

General Info
Alarm Hame [ |
Description | AI
Paramter ,mu]
Enable Yes
Calculation Type Consecutive
Count l\—| k4
Threshold Alarm Info
UpperLower ,I.lmaer—ﬂ
Threshold [Erteradouble or integer. |2
Severity Critical
m Cancel

13. Enter the following threshold information:

¢ General Info:

- Alarm Name. Enter a name for the alarm.

- Description. Enter a description for the alarm.

- Parameter. Select a parameter. The parameters that are displayed in the menu
depend on the monitor that you select in Step 10.

- Enable. Select whether to enable the threshold.

- Calculation Type. Select a consecutive or average calculation.

- Count. Select the number of times that a particular event must occur before the

threshold is met.
e Threshold Alarm Info:

- Upper/Lower. Select an upper or lower threshold.
- Threshold. Enter the threshold. If this threshold is exceeded, the application

triggers an alarm.

- Severity. Select whether the alarm is considered critical, major, minor, or

informational.
14. Click the Submit button.

The Add Threshold pop-up window for the selected monitor pop-up window closes and
the alarm configuration is added to the Threshold List table.

15. To add another alarm configuration, repeat Step 12 through Step 14.

Before you add a new alarm configuration to the Alarm Configuration table, you can still
modify or remove the alarm configuration.

16. To close the Add Threshold pop-up window, click the Close button.

All new alarm configurations are added to the Alarm Configuration table.
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Change an Alarm Configuration for a Link on a Hierarchical Map

You can modify an existing alarm configuration, including the alarm thresholds, for a link on a
hierarchical map. The alarm configuration applies to the selected link only.

» To change an alarm configuration for a link on a hierarchical map:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

D 8 e % § 6080 5 e &

| & Word Maps Devices Link Delete Refresh Aute  Seftng Reset  Help  Screen  Prind

Search

Duevice Name r 192.168.10.208

@ 19216210200 19216810200 | 192100212
@ WIBI0215 191610215 68.10.205
@ 12.168.10.205 192.188.10.205
@ Frmy-gamT2A2 19216810217
@ 192.162.10.208  192.168.10.208
@ GSTAETW2-Smar 192.168.10.204
@ 19216210213 192.168.10.213

B EETETTR AES 192 168 U030

5. From the Map Tree, select the map.
6. Click a link between two devices.

The link displays in bold.
7. On the right of the page, click the tab.
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The LEGEND pop-up window opens.

LEGEND

» Manual Link —]
LLDP Link

<1.5Mbps  ==mm---

' Mbps, < 10... -------
1 >= 10Mbps, < 100... =======
»>= 100Mbps, < 1G... -------

>= 1Gbps, < 10Gb... =======
>=10Gbps = ===e=eee

Unknown Speed mm—————

Threshold Setting

8. At the bottom of the pop-up window, next to Threshold Settings, click the icon.
The Add Threshold Alarm pop-up window opens.

¥ Add Threshold Alarm X

Monitor Package
Monitor Hame Device Interface Trafic [ Description Device interface performance al%
Polling Intervaliminutes) 10 Minutes [v || Enable e [v |
Tireshot is [ haa | o] o |
Rows perpage| 10 a OO m Total: 4
U. Parameter 4 Enable % Alarm Name $ UpperiLower % Count$ Threshold % Severty 3
Interface Utiization for RX is over 90% E ]
[7] | Transmitted Interface Utiiz... ﬂ Yes Interface Utiiization for TX is over 90% Upper 2 90.00
[F] | Percent RX Packet Loss (%) Yes Packet Loss for RX is over 5% Upper 2 5.00
[[] ' Percent TX Packet Loss (%) ﬂ Yes Packet Loss for TX is over 5% Upper 2 5.00
€| m | »
| ciose

The Threshold List contains four predefined thresholds. You can change the settings for
these thresholds.

9. Select the check box the to left of an alarm configuration.
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Click the Edit button.

General Info
Alarm Hame [ s cPU wtiization is over 50% z
D | NMS CPU utilization is over 80%
Paramter v |
Enable T — - |
Caleulation Type
count N
Threshold Alarm Info
UpperLower m
Threshold ﬁo—] z
Severity Major

[ sumit TN

10. Modify the following threshold information as needed:
* General Info:

Alarm Name. Modify the name for the alarm.

Description. Modify the description for the alarm.
Parameter. You cannot modify the parameter.

Enable. Select whether to enable the threshold.

Calculation Type. You cannot modify the type of calculation.

Count. Select the number of times that a particular event must occur before the
threshold is met.

e Threshold Alarm Info:

Upper/Lower. You cannot modify the type of threshold.

Threshold. Modify the threshold. If this threshold is exceeded, the application
triggers an alarm.

Severity. Select whether the alarm is considered critical, major, minor, or
informational.

11. Click the Submit button.

The modified alarm configuration displays in the Add Threshold Alarm pop-up window.

12. To close the Add Threshold Alarm pop-up window, click the Close button.

The Alarm Configuration table displays.
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Add a Childmap

You can add a childmap (submap) to a hierarchical map. The hierarchical map functions as
the parent map to the childmap. The application provides default childmaps. You can also
import your own childmaps.

» To add a childmap:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select TOPOLOGY > MAP VIEWS.

I A re % 8 ¢80 9 ¢ o0&

| P Word Maps Devices Link Delete Refresh Auto  Seftng Resat Help Screen  Print

Search

Dievice Name ® 192.168.10.208

@ 1216290200 10216010200 | 1028401
@ 19215810215 192.188.10.215 68.10.205
@ 192.162.10.205  192.168.10.205.
@ Fny-gamT2azl 19216810217
0 192.162,10.208  192.168.10.208
6 GSTAETZ Smm 192.162.10.204
0 192.162,10.213  192.1682.10.213

S EETETTE LArEa 197 16 1031

5. From the Map Tree, select the map.
6. Click the Maps icon.

BB € S 8 O o | 9 € 1 &

Maps | Devices' Link  Delete Refresh Aulo | Seiting Reset Help  Screen  Print
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The Add Map pop-up window opens.

5 Add Map

Map Info
Map Name ;
(=) Selecta Map: i
LS
'
Warld v -,
(_) Selecta Local Map:

Enter a name for the childmap.

S Add Map

Map Info
Map Name
Location 1 4' ;
: 3
(») Selecta Map:
A
World - .
World
usA
s '
San Jose
San Jose State University
I Floor Map 1
., Floor ap 2 ——

Either select a default childmap or import a map from your computer by selecting one of the
following radio buttons:

e Select a Map. Select a default map from the menu.
* Select a Local Map. Take the following action:

a. Click the Select button.

b. Locate and select a map on your computer.
Click the OK button.
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The map that you selected or imported displays as a childmap below the parent map and
the name of the map you selected displays in the Map Tree.

Map View /—Q\B‘oﬁ 5
N ¢ = KA -
BB e % @ G 9 9 0 &
@ @ world Maps Devices Link  Delete Refresh Auto  Setting Reset Help  Screen  Print
© @ SanJose Netgear 2
@ /
@ San Jose || - /
& Location 1 GJ'".»I ND: & - dmaconnection  [] - photocopier  RR - restraom
@ China Netgear N
* & i 1081
Collection Develapment B
LS & Acquisitions Cataloging
& | Classroom
el 106 “P’. I_\fhﬂ L L “.I“l,
E 1088108 ¢ 108D 1ok [108F [ 108
13 “FERENCE
iz REFERENC
COLLECTION
| GOWVERNMENT DOCUMENTS.
B Auditorium
L]
Dervice List {uirids -
searn | canstruetion) | T < Refirence i | vioe [ e s feion | vos
Eifrance Coit piater w =}
Databases =z Referenee! Govemment Informatico {4l es
Device Name b Z g | .
[—’ LI |—‘ Ll = £ o | 1o

[Frmnde

Main
Entrance

it
CURRENT PERIODICALS
Ciircul ation
k

el

() (B
=g

Sorting Reading Room
Shelves .

FIRST LEVEL

ey oo BRI

Add Devices to a Map

You can add devices to a map.

To add devices to a map:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select TOPOLOGY > MAP VIEWS.

WIRELESS RESOURCES MONITOR ALARMS TOPOLOGY SFLOW REPORTS ADMIN

MAP VIEWS

P B f e % a8 0 9 @ 5l&

& World Maps Devices Link Delete Refresh Auto  Sefting Resat  Help  Screen  Print

Search

Dvice Name ® 192.168.10.208 ~

@ 192.162.10.200 192188100208

192.168.10.213
68.10.205

@ 1020215 9210215
@ 192.188.10.205 | 192.163.10.205
@ Frery-pamT2E 19218810247
@ 19216210208 192.168.10.208 |
@ GSTASTV2 Sman 192.162.10.204

@ 19216210213 192.182.10.213

& corerro wares 197 168 10s0e |

5. From the Map Tree, select the map.
6. Click the Devices icon.

B E(e DT 8 O &G 9 € i &

Maps | Devices| Link  Delete Refresh mm Seiting Reset Help Screen  Print

The Add Devices pop-up window opens.

% Add Devices

Device Filter
Vendor Device Type Group Location
L ] son o |
Device List
|| Name P Location Vendor Device Type Device Model
.|_1.0 192.168.10.102-mine | 192.168.10.102 shanghai CN Netgear Switch GSM7224v2
[]/@& 192.168.10.120 192.168.10.120 Netgear Switch M5300-28G3
[ @ 192.168.10.122 192.168.10.122 Netgear Switch GSM73525v2
[ @ 192.168.10.232 192.168.10.232 Netgear Switch GSM7224P
L | @& GSM7212F_217 192.168.10.217 GSM7212F_loc  Netgear Switch GSM7212F

7. Select one or more devices.
8. Click the OK button.
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The devices display on the map.

Map View

Map Tree

@ ©Wworld
© @ San Jose Netgear
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9. For each device, select the device and drag it to where you want it on the map.
10. Click the Save button.

The devices display at their locations on the map. The map also displays the existing
links between the devices.

Map View
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Add a Link Between Devices on a Map

You can add a link between devices. For devices that do not support link discovery through
Link Layer Discovery Protocol (LLDP), you can manage links manually. When you know that
physical connections exist for the non-LLDP devices, you can draw these links manually and

also update them manually when the physical connections are reconfigured.
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» To add alink between devices on a map:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.
4. Select TOPOLOGY > MAP VIEWS.

WIRELESS RESOURCES MONITOR TOPOLOGY REPORTS ADMIN

MAP VIEWS

CEE B8 % 8 00 ¢ 9 e na

i World Maps Devices Link Delete Refresh Auto  Sefting Resat  Help Screen  Print

6810014

Search %
Dvice Name t3 192.168.10.208 o
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0 192.168,10.213  192.162.10.213

S CETETID LA 197 16 10302

5. From the Map Tree, select the map.
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6. Select the device that is the first endpoint of the link.
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:
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7. Click the Link icon.

B B € S| 8 O o 9 € i o=

Maps Devices| Link | Delete Refresh = Autd Seifting Reset Help Screen  Print

8. Drag your cursor from the device that you selected in Step 6 to the device that is the second
endpoint of the link.

9. Release the mouse button.
The Add Link pop-up window opens.

A Interface

Device Name 192.168.10.122

Device Interface | lag22 -
Z Interface
Device Name GSM7212F_217
Device Interface | lag8 =

[ ox J coa |

10. From the menus, select the device interface for each end of the link.

Device Interface ‘ lag22
W lagz2
Lface . A/0i46

301
Device Name u

|+

Device Interface W 7oad

W lagse

11. Click the OK button.
The Add Link pop-up window closes.
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12. Click the Save button.
The link is added.
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Customize the Style of a Link on a Map

You can customize the way that a link displays.

»> To customize the style of a link:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.
The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.
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4. Select TOPOLOGY > MAP VIEWS.

HOME WIRELESS A MONITOR C G ALARMS TOPOLOGY REPORTS USERS ADMIN

MAP VIEWS

Map View 2
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5. From the Map Tree, select the map.
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6. Click the Setting icon.
B E ¢ % 8 O o €& X &
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Maps Devices Link Delete Refresh Setting| Reset Help  Screen  Print
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The Link Style Setting pop-up window opens.

Link Style Setting
Speed Thresholds Color Thickness
< 1 5Mbps g 275
= 1.5Mbps, < 10Mbps g 2 B
>= 10Mbps, < 100Mbps g 2 tj
»= 100Mbps, < 1Gbps | E tj
>= 1Gbps, < 10Gbps !J 2 @
== 10Gbps g 2 B
Unknown Speed ! 2 tj

[ oc

7. Select the color and thickness of the links:

Thickness

8. Click the OK button.
The links on the map display the modified link styles.
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9. Click the Save button.

Your changes are saved.
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View and Manage Network Topologies

A network topology displays the structure of your network as a link tree view, radial view, or
spring view:

e Link tree view. The network nodes are displayed as a hierarchical organization chart.

* Radial view. The network nodes are displayed in an outwardly expanding radial pattern.

e Basic spring view. The network nodes are displayed in a pattern in which children nodes
are in circles with parent nodes.

Link tree view Radial view Basic spring view

Figure 4. Network topology views

The following sections describe the tasks that relate to network topology views:

e Add a Topology View

e View a Network Topology and Details About a Device

e Manage a Topology View

e Add a Link Between Devices on a Topology View

* Customize the Style of a Node and Link on a Topology View
* Remove a Topology View

Add a Topology View

You can add a topology view of your network.

> To add atopology view of your network:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
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The Network Summary page displays.
4. Select TOPOLOGY > NETWORK TOLOPOGY.

WIRELESS RESOURCES MONITOR CONFIG ALARMS TOPOLOGY SFLOW REPORTS USERS ADMIN

HETVIORK TOPOLOGY

Network Topology
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6122.15‘&.10.203 182.168.10.200 -
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Note: If you did not yet add any topology views for your network, the page
does not display any.

5. Next to View List, click the + (f.) button.

[m Maode Link Tree View ~
{2/ San Jose Neigear
|m) Radial Tree View
|m Topology Tree View
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The Add Topology View pop-up window opens.

B Add Topology View

General Info

View Name *

Display Layout | Radial Tree |

Device Filter
Filter Device By

[] Subnet I

[_] Device Vendor

6. Specify the following information:
* General Info:
- View Name. Enter a name for the topology view.
- Display Layout. From the menu, select Radial, Node Tree, or Basic Spring.

e Device Filter. Select one of the following check boxes and specify the corresponding
information:

- Subnet. Enter an IP address and select a subnet from the menu.
- Device Vendor. Select a vendor from the menu.
7. Click the OK button.
The Add Topology View pop-up window closes.
8. To view the new topology view, select it from the View List table.
The topology view displays.

View a Network Topology and Details About a Device

You can view a network topology and view details about the devices, including alarms.

> To display a network topology and details about a device in the network:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select TOPOLOGY > NETWORK TOPOLOGY.
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5. From the View List table, select the topology view.

For information about adding a topology view, see Add a Topology View on
The selected view displays.

page 216.
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6. From the Device List table, select a device.
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A circle displays around the selected device.
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7. To view information about the device (node), point to the device on the map
A pop-up window similar to the following opens.

IP Address:
Node Status:
Device Type:
Vendor:

Netgear |

8. To see detailed information and the Dashboard menu for the device, double-click the device
on the map.
For more information, see View Device Details and Interface Details on page 95

0.

To view the details for a link, point to the link on the map.

A pop-up window similar to the following opens.

A Interface:
Z Interface:
| Speed:

1/g1
0/6
1000Mbps |

10. To view the summary for an alarm, point to the alarm summary on the map

An alarm summary is displayed as a red-colored rectangular with a number.
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A pop-up window similar to the following opens.

( Alarm Summary

Critical:
Major:
Minar:

| Tatal Count:

Manage a Topology View

On the Network Topology page, the icons that display above a topology view let you perform
various tasks.

B & @ O o 9 € 11 &

Link Delete Refresh  Aute  Setting Reset Help  Screen  Print

Figure 5. Icons on the Network Topology page

The following procedure describes the tasks that you can perform for a topology view. For
complicated tasks, the procedure points to a section that provides detailed information.
» To manage atopology view:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select TOPOLOGY > NETWORK TOPOLOGY.
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5. From the View List table, select the topology view.

6. To rescale the topology view, use the scaling tool that displays on the left of the topology
view.
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To reposition the topology view, hold your cursor on the topology view and drag the topology
view to a new position.

Take one of the following actions:

Let the application refresh the topology view automatically. Click the Auto icon.

The topology view refreshes automatically every two minutes. Automatic refreshment
is the default setting.
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» Refresh the topology view manually. Click the Refresh icon.
The topology view refreshes once immediately.
* Add a link between devices on a topology view. Click the Link icon.

For more information, see Add a Link Between Devices on a Topology View on
page 223.

e Customize the link style settings. Click the Setting icon.

For more information, see Customize the Style of a Node and Link on a Topology
View on page 226.

* Remove a link from the topology view:
a. Select the link.
b. Click the Delete icon.

The link is removed.

* Undo unsaved changes. Click the Reset icon.

The unsaved changes are reset.
e Save changes. Click the Save icon.

Your changes are saved. When the Save icon is grayed out, everything is saved.
e Open the Help pop-up window. Click the Help icon.

The Help pop-up window opens.
* Enter full-screen mode. Click the Screen icon.

The page displays in full-screen mode. To return to the regular page display, either
press the Esc key, or from the full screen, click the Screen icon.

* Print the page. Click the Print icon.

The topology view is printed.

Add a Link Between Devices on a Topology View

You can add a link between devices. For devices that do not support link discovery through
Link Layer Discovery Protocol (LLDP), you can manage links manually. When you know that
physical connections exist for the non-LLDP devices, you can draw these links manually and
also update them manually when the physical connections are reconfigured.

» To add alink between devices on a topology view:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.
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2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.
3. Click the Sign In button.
The Network Summary page displays.
4. Select TOPOLOGY > NETWORK TOPOLOGY.
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5. From the View List table, select the topology view.
6. Select the device that is the first endpoint of the link:
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7. Click the Link icon.

B(% 8 OB & 9 & I &

Link | Delete Refresh | Aute  Sefting Reset Help Screen Print

8. Drag your cursor from the device that you selected in Step 6 to the device that is the other
endpoint of the link.

9. Release the mouse button.

The Add Link pop-up window opens.
EEe

Device Name 192.168.10.202

Device Interface ‘ &40

7 Interface

Device Name 192 168.10.219

Device Interface ‘ 011

10. From the menus, select the device interface for each end of the link.
Device Interface ‘ u

.Itl

eface W =

v

ed
Device Name |
Device Interface W e

B =5

11. Click the OK button.
The Add Link pop-up window closes.

12. Click the Save button.

The link is added between the two devices.
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Customize the Style of a Node and Link on a Topology View

You can customize the way that a node and a link display.

To customize the style of a node and link:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.

The Network Summary page displays.
4. Select TOPOLOGY > NETWORK TOPOLOGY.
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5. From the View List table, select the topology view.
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The Node and Link Style Settings pop-up window opens.
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7. Select the node style settings and link style settings:

£¥ Node and Link Style Setting

Node Style Setting
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8. Click the OK button.

The nodes and links on the view display the modified node and link styles.
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9. Click the Save button.

Your changes are saved.
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Remove a Topology View

You can remove a topology view that you no longer need.

To remove a topology view:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select TOPOLOGY > NETWORK TOLOPOGY.
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5. From the View List table, select the topology view.
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6. Next to View List, click the X button.

(@ Node Link Tree View

=/ San Jose Nefgear
| Radial Tree View

-
(@ Topology Tree View

A confirmation pop-up window opens.
7. Click the Yes button.

The topology view is removed from the View List table and deleted.
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Manage sFlow

Manage sFlow sources and view the sFlow
summary

Using packet sampling, sampled flow (sFlow) lets you monitor managed switches in high-speed
switched networks.

This chapter covers the following topics:
» Set Up the sFlow Collection Server and Manage the sFlow Settings

* Manage sFlow Sources
* View and Export the Results of sFlow Monitoring
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Set Up the sFlow Collection Server and Manage the sFlow
Settings

» To configure the SMS server:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings

Discover your network and 26d the devices you want to Set global Settings for the system and website,
manage.

4 Customize
f’ Customize the navigation and 100k of your web portal,

Account Information

Manage Monitor and Alarm
& View or modify users, or create new users.

LN my. NETGEAR.com Account Profile
Network monitor, alarm and threshold related configurations Configure and validate myNETGEAR com account profile
through my NETGEAR com Web APL

> myNETGEAR com Account Profile

= sFlow Manage External File Server License And Version Information
t_‘j' Set sFlow related configurstions. &5 Exemal File Sever configurstions and File Processing with View NMS300 license, supponed device andversion
External File Server, information,

» Manage sFlow Source

Ei System Backup/Restore

System BackupRestore Server Configurations and
Processing.

Manage sFlow
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5. Under sFlow, click the sFlow Settings link.

B sFlow Settings X

SFlow Settings
History Data Save in{days) IE - |
sFlow Collection Server [aeosaz— |
sFlow Collection Server Port | 8342 ’
Sampling Rate [1024 *
Max Header Size [ 4
Cancel

6. Enter the sFlow settings:

History Data Save in (days). From the menu, select how long sFlow data is saved.
By default, the data is saved for 15 days. You can also select 3, 5, or 7 days.

sFlow Collection Server. Enter the IP address of the sFlow collection server.
sFlow Collection Server Port. Enter the port number for the sFlow collection server.

By default, the port number is 6343.
Sampling Rate. Enter the rate at which the data is sampled.

By default, the rate is 1024, which means that 1 in 1024 packets is sampled. You can
set a higher sampling rate, which might result in a higher accuracy but increases the
sFlow traffic. You can set the sampling rate from 1024 to 65536 packets.

Max Header Size. Enter the maximum size of the header.

By default, the size is 128, which means that a maximum of 128 bytes is sampled
from a packet. You can set the maximum header size from 20 to 256 bytes.

7. Click the Submit button.

Your changes are saved.

Manage sFlow Sources

An sFlow system consists of multiple devices performing two types of sampling:

« Random sampling of packets or application-layer operations

e Time-based sampling of counters

The sampled packet and operation information, referred to as flow samples, and the sampled
counter information, referred to as counter samples, are sent as sFlow datagrams to the
application, which functions as the sFlow collector.

sFlow is supported for managed switches only (see NETGEAR Managed Switches on
page 14) and for a maximum of 16 interfaces at a time.

Manage sFlow
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> To enable interfaces of managed switches as sFlow sources:

1.

5.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select SFLOW > MANAGE SOURCE.

MANAGE SOURCE

Manage sFlow Source

Desice Tree View (7]

Group By | Location |= Enabie sFlow

@ @ Unknown
;@ 10.100.4.14
5 @ 10.100.4.19
5 @ 10,100,420
3 @ 10.100.5.253
3 @ 10100635
5 @ 10.100.6.45

[Suorve BT

Click the [ ¢ | icon to the left of the IP address of a managed switch.

@ @& Unknown

o @ 10.100.4.14
@ 1o
@ 1o ¥
@ 103 L]
@ 1104
@ 11055
@ 11066
@ 1107
@ 108
@ 1019
@ 1010
@ 1011
@ 11012
® 11013 ]
@ 11014 ]

Select the check boxes for active interfaces (displayed with green icons) that must be
included as sFlow sources.

To add interfaces of another managed switch, scroll down and repeat Step 5 and Step 6.

Note: You can select a maximum of 16 interfaces from the same or different
managed switches.

Manage sFlow
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8. Click the Submit button.

Your changes are saved.

View and Export the Results of sFlow Monitoring

If you specify the sFlow sources, and traffic is present for these sources, you can view the
results of sFlow monitoring.

The application provides the following defaults and filter options for viewing the results:

Source. You can select to display the source switch. By default, the application displays
information about the source switch with the lowest IP address.

Interface. You can select to display the source interface. By default, the application
displays information about all source interfaces for the selected source switch.

Date time range. You can select to display a time range or customize a time range. By
default, the application displays the sFlow information that is collected today.

Top. You can select to display the top 10 or top 20 active sFlow streams. By default, the
application displays information about the top 10 active sFlow streams.

> To view the results of sFlow monitoring:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Manage sFlow
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4. Select SFLOW > SFLOW SUMMARY.

ADMIN

RESOURCES MONITOR ALARMS TOPOLOGY

SFLOW SUMMARY

Ty Costis °

« Convarsations Filter: [Managed Source: 10.100.4.14] [Interface: AN} [Date Time Range: Today] [Top: Top 10 Show Filter
- Sources ExporttoExcel [ Exportto PDF
LTSI Source IP # Destination IP ¢ Application ® Flow Total # Flow Rale(%) e
» Applications [ ERREI 224111 Whoises 9260TME R —

10.1005.13 10.100.4.20 snmp 1.095KB [— 1 —

W 10.1005.13 10.100.4.14 snmp 8308 fi— )

[ 10.100.4.12 255,255,255 255 domain 268 ( L1 )

H t1.1.1-2248 0. 1(wheis ) [§ 10.100.5.13-10.100.4.20(snmp) [] 10.100.5.23-10.100.4.14(snmp) 10.100.4.19-255.255.255.255(domain)

By default, the table and associated pie chart show the sFlow conversations (that is,
application traffic streams) between source and destination IP addresses, their total flow
traffic, and their flow rate in percentage.

By default, the application displays the top 10 streams that sFlow collected today for the
device with the lowest IP address.

5. To view a table and pie chart of IP sources, destinations, or applications, click one of the
following Show Summary menu links:

e Sources. The table and associated pie chart show the sFlow source IP addresses
and the total flow traffic and flow rate in percentage for these addresses.

« Destinations. The table and associated pie chart show the sFlow destination IP
addresses and the total flow traffic and flow rate in percentage for these addresses.

e Applications. The table and associated pie chart show the sFlow applications and
the total flow traffic and flow rate in percentage for these applications.

6. To filter the event entries that are listed, click the Show Filter button.

You can filter the event entries by criteria such as managed source IP address, interface
number, time range, and top active interfaces.

To hide the filter, click the Hide Filter button.

7. Click the Export to Excel button or the Export to PDF button.
8. To save the sFlow information on your computer, follow the directions of your browser.

Manage sFlow
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Generate and View Reports

Record how your network performs

You can generate reports from either built-in or customized report templates, and you can view
them at any time. You can create new report templates that generate one-time reports or regular

reports automatically on a schedule.
This chapter covers the following topics:

* Manage Report Templates
* Generate and Schedule Reports
» View and Remove Saved Reports
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Manage Report Templates

The application provides default report templates that are based on inventory, devices,
wireless devices, wireless clients, traffic, and storage device components. You can generate
and view a report based on such templates. You can also add a new report template based

on an existing template, modify an existing template, and remove a report template.

The following figure shows the types of reports that the templates are based on.

> \Wireless Client

» Storage

Node Status

» Traffic
> Wireless Device
> Wireless Client

» Storage

Device SNMP Traffic

Interface Traffic Errors and Discards
Total Bytes Transferred by Interface
Interface Trafic Rates

Interface Utilization
» Wireless Device

» Wireless Client

» Storage

» Wireless Client

» Slorage

Client Count per Radio

» Siorage

¥ Inventory > nventory » Inventory » Inventory » Inventory » Inventory
Boaa: reamiuy ¥ Device » Device » Device » Device P Device
Tibifeca lavecsiony e ¥ Tramc » Traflc » Traflc » Traffic
s P Baicaipriiadic ¥ Wirsless Device > Wiireless Device > Wireless Device
T Memary Device ICMP Traffic Traflic per Radia AT JEirElEss Ciidr
> Wiielass Devic Temperature Device TCP Traffic Traflic per SSID Client Count per AP ~EIE
Avallabllity Device UDP Trafiic WLAN Utilization Client Count per S8ID Device Temperature

Disk Temperature
Fan Speed

Disk Space Ulilizalion
Storage Capacity
vinual Disk

Disk Drives

Figure 6. Overview of the types of reports

Add or Modify a Report Template

To generate reports for your particular network and situation, you can add a report template
that is based on a default report template or modify a default report template.

> To select areport style and add a report template or modify an existing report
template:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select REPORTS > REPORT TEMPLATES.

VWARELESS | RESOURCES MONITOR ALARMS TOPOLOGY

REPORT TEMPLATES

Report Type Report Templates (7]
v Irventory | nga || Edn || veiete || Generate Report Rowsperpage] 10 09 < [ 1 i1 > [ Totr3
C ] Name & File Format % Report Period + Scheduled ¢ Recurrent Type % Nexd Execution Time .
Interface Inventory [ Device Inventory B POFFile Currant B no Mot Recurrent
[ Fit_APs 8] PDFFile Current B o Not Recurrent
= Dokce [ Device inventory 8 POF File Curren B o Mol Recurment

» Trafflc
» Wirgless Device
» Wireless Client

> Slorage

To add columns to or remove them from the Report Templates table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, File Format, Report Period,
Scheduled, Recurrent Type, Next Execution Time, Email, and Description.

From the Report Type menu, select the report type.

For some report types, the application provides one or more default report templates. For
other report types, the application does not provide any default report templates and you
must add a report template.
Add a report template or modify an existing report template:
e To add areport template, click the Add button.
e To modify an existing report template:

a. From the Report Templates table, select the report template.

b. Click the Edit button.

For a new report template, the Add Report Template pop-up window opens. For an
existing report template, the Edit Report Template pop-up window opens.

f Add Report Template X
Select Devices Customize Fields m

General Info

Report Name [Device iventory |2

Report Type Inventory - Device Inventory

Report Period [Carrent
Device nventory information for selected device,
Description
Report Option
File Format @ PDFFile (" EXCELFile (" HTML File [V Save Report in HMS300 File System
[~ Email

Frevos | [hext e
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Depending on your type of report selection, a different Add Report Template pop-up
window or Edit Report Template pop-up window might open.
Enter or modify the following general report information:
* General Info:
Report Name. Enter or modify the name for the report template.
Report Type. Your selection in Step 6 determines the content of this field.
Report Period. Select the period to which the report template applies.
Description. Enter or modify the description for the report template.
* Report Option:

- File Format. Select the PDF File, EXCEL File, or HTML file radio button.

To save generated reports, select the Save Reports in NMS300 File System
check box.

For information about how to view reports that were generated previously, see
View and Remove Saved Reports on page 248.

- Email. To let the application send a copy of the report to your email address,
select the Email check box and enter or modify your email address.

Click the Select Devices tab.

™ Add Report Template X

Select Devices > Customize Fields m
Select Target Network Devices or Groups AddDevice || Add Group

[~ status 4+ Entity Name % Entity Type + [P Address + Vendor % Device Model #7

No dats to display!

orevons | Went e
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10. Add devices, device groups, or both:
a. Click the Add Device button.

P Select Devices X

Fiker: Hone
Rows perpage@ < [ rs > B voumiss

[ Status 4 Device Name 4 |P Address 4 Vendor %+ Device Typs 4 Device Model & Firmware Version s

- euw 182.168.10.102 182.168.10.102 B netgear Switch BSMTZ24v2 8.0.1.26

O @uw 182.168.10.104 182.168.10.104 B netgear &y Switch FST26TP

- ®up 182.168.10.114 192.168.10.114 B netgear Switch GST28TPS 53017

r ®uw 182.168.10.120 192.168.10.120 B netgear &) Switch W5300-286G3 10.0.0.18

r ®uw 182.168.10.121 192.168.10.121 B netgear Switch GSM73285v2 80320

r ®u 192.168.10.124 192.168.10.124 Bl netgear Switch BSM7252P5 80325

r eu 192.188.10.125 192.188.10.125 B tetgear Switch GSMT248v2 80.4.22

O @u 192.168.10.131 192.168.10.131 B netgear Switch GSM7252PS £0.3.38

O @uw 182.168.10.140 152.168.10.140 Bl netgear Switch BSMTZ24v2 8.0.1.28

- @u 182.168.10.202 182.168.10.202 B netgear &) switcn FST52TF 50233

| Add Selection || Add Al || Clese |

b. Select devices to add and click the Add Selection button.
To add all of the devices in the table, click the Add All button.
c. Click the Add Group button.

E select Groups X

Filter: None Show Filter

Rowsperpage[ 10 B < [ 11 > [ motar s
[~ Name = Type 4 Device Count *
[T | ANl Netgear Devices Dynamic Group 35

| Add Selection | | Add All || Closs |

d. Select device groups to add and click the Add Selection button.
To add all of the device groups in the table, click the Add All button.

The selected devices, groups, or both, display in the Select Target Network Devices
or Groups table.

e. If you are modifying an existing report template, to remove devices or groups, select
the devices or groups, and click the Remove button.

The devices or groups are removed from the Select Target Network Devices or
Groups table.
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11. Click the Customize Fields tab.

" Add Report Template X

Customize Report Fields

Optional Fields
Software Version
MAC
Location
Device Group
Config Version
Serial Number
Last Update

Discover Time

Data Sort

Sort By Device Device Name [+]

pravons | et [ coecus JIEES

Select Devices Customize Fields > m

£ Faw

Selected Fields

€ Descending (% Ascending

Depending on your type of report selection, a different Customize Fields pop-up window

might open.

a. Inthe Customize Report Fields section, specify the fields and the order in which you
want them to appear in your report template.

To select the fields, use the >, <, >>, and << buttons. To arrange their order, use the up

and down buttons.

b. In the Data Sort section, specify how you want the information sorted.

You can sort by device and by descending or ascending order.

12. Click the Save button.

The report template is saved and added to the Report Template table.

Remove a Report Template

When you delete a report generation job from the Jobs table, the application deletes the
report template for the job automatically. For more information, see View and Manage Jobs
on page 252. You can also remove a report template manually.

» To remove a report template manually:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select REPORTS > REPORT TEMPLATES.

WIRELESS RESOURCES MORITOR ALARMS TOPOLOGY 0BS ADMIN

REPORT TEMPLATES

Report Type Report Templales (7]

¥ Inventory m|m|[ Generate Report Rows parpage| 10 u < [ > [ ot

D [ Name # File Format # Repor Period % Scheduled * Recument Type % Mext Execution Tirme %
Interface Inventory O Device inventory B PODF File Current e Mot Recurrent
0O Fit_aps B PDF File Current [ I Mot Recurrent

Euake [ Device Inventory B POF File Current o Mot Recurrent
» Trafiic

» Wireless Device

» Wirgless Client

* Storage

5. To add columns to or remove them from the Report Templates table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, File Format, Report Period,
Scheduled, Recurrent Type, Next Execution Time, Email, and Description.

6. From the Report Type menu, select the report type.
7. Select the report template.
8. Click the Delete button.

A confirmation pop-up window opens.
9. Click the Yes button.
The report template is removed from the Report Templates table and deleted.

Generate and Schedule Reports

You can generate reports from an existing report template. You can create one-time reports
manually that are generated immediately or schedule one-time reports that are generated
later. You can also schedule recurring reports that are generated automatically.

Generate a One-Time Report Immediately

You can generate a new report immediately from an existing template. For information about
how to schedule the generation of a one-time report later, see Schedule a Report on
page 245.
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> To generate and view areport:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select REPORTS > REPORT TEMPLATES.

WIRELESS RESOURCES MONITOR ALARMS TOPOLOGY 0BS ADMIN

REPORT TEMPLATES

Report Type Report Templates (7]
¥ Irventory m|m|m[ Generate Report Rows perpage| 10 ! <[ 1 n > m Total 3
O Name # File Farmat 4 Report Period ¢ Scheduled ¢ Recurrent Type 4 MNextExacution Time s
Interface Iveniory O Device nventory 8] PDF File Current o Mot Recurrent
[ Fit_APs B PDF File Cument B o Mot Recurrant
» Device [ Device Invantory 8] POF File Current B Mot Recurrant

» Traffic
> Wirgless Device
> Wireless Client

» Storage

5. To add columns to or remove them from the Report Templates table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, File Format, Report Period,
Scheduled, Recurrent Type, Next Execution Time, Email, and Description.

6. From the Report Type menu, select the report type.

7. Select the report template.

8. Click the Generate Report button.
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The Generate Report pop-up window opens and displays the results.

Execution Result

Note: If your report has been generated successfully, please click “View Report” to open the report
Report Generation: % Succeeded.

Save Report: W succeedso.

Email: B Not Set.

View Report: @

Close

9. Click the View Report button.
The report displays.
10. Click the Close button.

The pop-up window closes.

Schedule a Report

You can schedule a report from an existing template for generation at a future time, or you
can schedule the report for generation on a recurring basis.

» To generate areport according to a schedule:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select REPORTS > REPORT TEMPLATES.

HOME WIRELESS RESOURCES MORTOR ALARMS TOPOLOGY SFLOW ADMIN

Report Type Report Templates (7]
bl [ ada || cat J petete ] Generate Report Rows perpage[ 10 19 < [ 1 i1 > [ Totar3
Device Invertory ] Name # File Format # Report Period % Scheduled & Recurent Type 4 Ned Execution Time ¢
Interface Invertory [ Oevice Inventory B FOF File Cument B o Not Recurrent
[ Fit_aPs B’ FODF File Cument B no Mot Recurrent
> Device [ Device Inventory B POF File Curmant B no Mot Recurrent
> Traffic

» Wireless Device
> Wirgless Clignt

» Slorage

To add columns to or remove them from the Report Templates table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Name, File Format, Report Period,
Scheduled, Recurrent Type, Next Execution Time, Email, and Description.

From the Report Type menu, select the report type.
Select the report template.
Click the Edit button.

M Edit Report Template X
Select Devices Customize Fields m

General Info
Report Name [ Device inventory test [®
Report Period [ Corrent
Device Inventory information for selected device.
Description
Report Option
File Format @ PDFFile " EXCELFile (7 HTML File ¥ save Report in NMS300 File System
™ Email

posous | vt | cose|

Depending on your type of report selection, a different Edit Report Template pop-up
window might open.

Generate and View Reports
246



NMS300 Network Management System Application

9. Click the Add Schedule button.

Execution Type & Status
Enable Mo g Execution Type Dne time schaduled [v |
[ cance

10. From the Enable menu, select Yes.

11. Specify whether the application generates the report once or on a recurring basis by
selecting one of the following options from the Execution Type menu and entering the

corresponding information:
e Onetime scheduled. This is the default selection.

In the Starting On field, enter a date and time.

* Recurrent. The pop-up window adjusts to display more fields.

Execution Type & Status
Enable Yes g Execution Type Recurrent u
Starting On
Starting On 04/30/2013 14:59:00 z
Recurrence
Recurrence Type Weekly g
Day of the Week ¥ Monday ™ Tuesday [~ Wednesday [~ Thursday [~ Friday [ Saturday [~ Sunday
Stopping On
" End Time
* Never
cancel

Enter the following information:

a. Inthe Starting On field, enter a date and time.

b. From the Recurrence Type menu, select how the schedule recurs and complete
the corresponding field or select the corresponding check boxes.

c. Select the End Time radio button and enter the date and time in the
corresponding field, or leave the Never radio button selected, which is the

default setting.
12. Click the Submit button.
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The Schedule pop-up window closes. The report generation schedule becomes part of
the report template.

13. In the Edit Report Template pop-up window, click the Save button.

The report is generated according to the schedule that you set.

View and Remove Saved Reports

You can view the saved reports in the application. However, reports are saved for the data
retention period. For more information, see Set the Data Retention Period on page 266. You
can also remove reports that you no longer need.

View a Saved Report

You can view a saved report.

» To view a saved report:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select REPORTS > GENERATED REPORTS.

MONITOR TOPOLOGY m ADMIN

Generated Reports 9
Filter{Create Time Range: Last 30 days] Show Filter

[ Delete | Rows per page| 10 u < [ e > A Totatar
] Report Name ® Repor Category ® Repor Type % Repon Period ® File Format L]

Oo Invvritary Device Inventory Currant B FOF File

Oc Wireless Client Client Count per Radio Last 24 hours 8] POF File

Ol Wireless Client Client Count per Radio Last 24 hours & POF File

(] Wireless Client Client Count per Radio Today B8] POFFile

Olc Wireless Client Clignt Count per Radio Customized periodity dale) 8] POF File

0Oc Wiireless Client Client Count per AP Today B8] FOF File

(m ¥ Wireless Device WLAN Utilization Today 8] FDF File

O Wireless Device Traffic per SSID Today 8] FOF File

ol Wireless Device Traffic per Radio Today 8] FOF File

O|c Wireless Client Client Count per SSID Today 8] FOF File

5. To add columns to or remove them from the Generated Reports table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.
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You can choose from the following columns: Report Name, Report Category, Report

Type, Report Period, File Format, Execution Type, Created Time, Created By, and
Description.

6. To filter the reports that are listed, click the Show Filter button.

You can filter the current jobs by criteria such as time range, category, and report type.
The previous figure shows the Generated Reports table after a time range filter for the
past 30 days was applied.

To hide the filter, click the Hide Filter button.

7. Select the report.
8. Double-click the report.

Your report opens.

Remove a Saved Report
You can remove a saved report that you no longer need.

To remove a saved report:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select REPORTS > GENERATED REPORTS.

MONITOR TOPOLOGY SERS ADMIN

GENERATED REPORTS

Generated Reports

(7]

Rows mrpansm < [ Jre > R Totar 3t

* Report Category ® Report Type * Report Period @ File Format ®
0| oe Irrveritary Diewice Inventory Curran 8 POF File
(m [ Wireless Client Client Count per Radio Last 24 hours B8] FOF File
O« Wiireless Client Client Count per Radio Last 24 hours 8] POF File
ac Wireless Client Client Count per Radio Today B8] POF File
(i wireless Client Clignt Count per Radio Customized periodiby date) 8] POF File
{m Wirglass Client Client Count per AP Today B8] POF File
(m ¥ Wiraless Device WLAN Uttilization Today B POF File
[m Wireless Device Traffic per SSI0 Today 8] POF File
0 | ram wireless Device Traffic per Radio Today 8] PDF File
[ | client Count p Wireless Client Clignt Count per $SID Today B8] POF File

5. To add columns to or remove them from the Generated Reports table, right-click the table
heading anywhere, and specify the columns by selecting the corresponding check boxes.
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You can choose from the following columns: Report Name, Report Category, Report
Type, Report Period, File Format, Execution Type, Created Time, Created By, and
Description.

To filter the reports that are listed, click the Show Filter button.

You can filter the current jobs by criteria such as time range, category, and report type.
The previous figure shows the Generated Reports table after a time range filter for the
past 30 days was applied.

To hide the filter, click the Hide Filter button.

Select the report.
Click the Delete button.

A confirmation pop-up window opens.
Click the Yes button.

The report is removed from the Generated Reports table and deleted.
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Manage Jobs

Manage the system jobs

You can view job detail and status information.

This chapter covers the following topics:

e Schedule Jobs
* View and Manage Jobs
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Schedule Jobs

The application supports regular and time-consuming jobs that are used for configuration and
management tasks. You can schedule these jobs for future execution on a one-time basis or
on a recurrent basis for batch operations.

The application supports the following jobs, which are scheduled when you complete the
corresponding procedures (see the section references in the following list):

e Configuration file backup. Both one-time and recurrent jobs are supported. For more
information, see Schedule a Backup Job on page 127.

e Configuration file restore. One-time jobs are supported. For more information, see
Restore the Configuration of a Single Device on page 133 and Restore the Configuration
of Several Identical Devices on page 144.

* Firmware upgrade. One-time jobs are supported. For more information, see Execute or
Schedule a Firmware Upgrade on page 161.

* Report generation. Both one-time and recurrent jobs are supported. For more
information, see Schedule a Report on page 245.

* Resource discovery. Both one-time and recurrent jobs are supported. For more
information, see Schedule or Reschedule an Existing Discovery Job on page 45.

Output files from completed jobs are saved for the data retention period. For more
information, see Set the Data Retention Period on page 266.

View and Manage Jobs

You can view job detail and status information. You can also enable, disable, and delete jobs.
For information about modifying or rescheduling jobs, see the section references in the
previous section, Schedule Jobs.

When you delete any of the following items from the Jobs table, the application deletes its
corresponding profile or template from its database:

» Discovery job. You can create a discovery profile. For more information, see Add or
Modify a Discovery Profile on page 40.

* Backup job. You can create a new backup profile. For more information, see Add or
Modify a Backup Profile on page 122.

* Report generation job. You can create a report template. For more information, see
Manage Report Templates on page 238.

Manage Jobs
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When you delete any of the following items from the Jobs table, the application does not
delete the related file from its database:

Restore configuration job. To remove the configuration file from the application, you
must delete the configuration file manually. For more information, see Restore Your
Device Configurations on page 132.

Firmware upgrade job. To remove the firmware file from the application, you must
delete the firmware file manually. For more information, see Upgrade Firmware for One or
More Devices on page 158.

To view and manage jobs:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select JOBS > JOB MANAGEMENT.

Jobs 7]
v ]| Dasie 1 oot | vote | rowsserape 0 18 < [1 1 > [ Toms
[] Enable  # JobName # Job Type % RecumentType ¢ Status # LastExecution Time = Next Execution Time ®

O 8ne 31013 Image Upgrade Mot Recurrant @ Failed 091152013 0318:22

O/ @ ves Inventory Polling Inventory Daily 5 waitto run 09/11/201301:00:00 | 091272013 01:00:00

O 8re 31013 Image Upgrade Mot Recurrent B3 Failed DUI2013 232044

O 8w 31.013 Image Upgrade Mot Recurrent B Failed 09M052013 23:29:16

0O 8o 9500-3.1.0.14 Image Upgrade MotRecurrent | BF Failed 0971072013 23:24:55

O Bne Quick Discover Discavery Mot Recurrent @ Succeaded 0941062013 23:22:50

To add columns to or remove them from the Jobs table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Enable, Job Name, Job Type, Recurrent
Type, Status, Last Execution Time, Next Execution Time, Last Execution Status, Job End
Time, Created By, and Create Time.

To filter the jobs that are listed, click the Show Filter button.
You can filter the current jobs by criteria such as job type, status, and last execution time.

To hide the filter, click the Hide Filter button.
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7. Select a job.

8. Take one of the following actions:
* Enable the job. Click the Enable button.
» Disable the job. Click the Disable button.
» Display job details. Click the Detail button.

B Job Detail X
General Info
Job Name Default profile Jab Type Discove
Status Succesde Enable [v]
Created By Create Time 04/28/2013 03:46:00
Execution Information
Last Execution Status Succeeded Last Execution Time 04/28/2013 03:47:47

Next Execution Time

Previous || Next || Close

Depending on your selection, a different Job Detail pop-up window might open.
To close the Job Detail pop-up window, click the Close button.
e Delete the job:
a. Click the Delete button.
A confirmation pop-up window opens.
b. Click the Yes button.

The job is removed from the Jobs table and deleted.
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Manage the system users

You can manage security profiles, the user base, and online users.
This chapter covers the following topics:

e Security Profile Concepts

* Add a Security Profile

e Modify or Remove a Security Profile
* Add a User Profile to the User Base
* Modify or Remove a User Profile

* View and Log Off Online Users

Note: Only admin users (that is, users with a security profile that is set to
Admin) can perform user management tasks.
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Security Profile Concepts

The application provides the following default user security profiles:

Admin. A user who can perform all functions of the application, including management of
users and security profiles.

Operator. A user who can manage the network functions, but cannot manage users or
security profiles, or perform administrative tasks.

Observer. A user who can only monitor and view network functions.

As an admin user, you can modify and delete these security profiles and you can define new
security profiles. For example, you can add a security profile for someone who can only run
and view network reports but is not authorized to perform any other tasks.

Add a Security Profile

If one of the default security profiles does not satisfy your needs, you can add a security
profile and specify the tasks that are associated with the security profile. For most functions,
you can specify whether the security profile includes viewing only, modifying only, or both
viewing and modifying. You can specify the following tasks in a security profile:

Monitoring

Configuring

Managing alarms

Managing topologies

Discovering

Reporting

Managing jobs

Managing users and security profiles
Performing administrative tasks

» To view the existing security profiles and add a security profile:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.

Manage Users and Security Profiles
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4. Select USERS > SECURITY PROFILES.

m WIRELESS RESOURCES

SECURITY PROFILES

User Profile

[ security Profile Name
O ovserer

O operatar

O Admin

e

Rows perpage[ 0 B4 < [ 1 |11 > [ o3

# Default “ Created By # Creale Time
Yes system 08102013 23117:25
Yes systam 002013 23:17:25
Yes system 0OM02013 23:17:25

5. Click the Add button.
The Add Security profile pop-up window opens.

Profile Information
Profile Name * 2z

Profile Setting

Function Module View  Modify Description
Monitor 4 [T Enterprise network monitor and views functions.
Confige || [T Config file backupirestore and image management functions.
Alarm F [T Alarm, event, trap, and device syslog views. And alert configuration and notification profile related functions.
Topology =2 [ Metwork map topology, layer 2 & 3 topology and Google Map related functions.
Discovery | [T Network devices discovery and credential management.
Report O [T Metwork report generation and view.
Job { i [T Joblist and status related functions.
User | ml [T User and security profile related functions.
Admin [ ] T Administration related functions.

Cancel

6. In the Profile Name field, enter a name.

7. Inthe Profile settings section of the pop-up window, select the check boxes for the functions

that you want to include in the security profile.
8. Click the Submit button.

The security profile is saved and added to the User Profile table.

Modify or Remove a Security Profile

You can modify or remove a security profile. For a default security profile, you can change
only the profile name. For a custom security profile, you can change the profile name and the

tasks. You cannot remove a default security profile.
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> To modify or remove a security profile:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select USERS > SECURITY PROFILES.

SECURITY PROFILES

User Profile

[ Security Profile Name
O ovserer

O operator

O Admin

+ Default = Created By
& ves systam
Yes systam
Yes system

(7}
Rows per page| 10 u < [ > EH Totar 3
# Creale Time ®

0902013 231725
09M 02013 23:17:25
0AMOME013 231725

5. Select the security profile.
6. Take one of the following actions:
e Modify the security profile:
a. Click the Edit button.

The Edit Security Profile pop-up window opens.

L Edit Security Profile X

Profile Information

Proiile Name *

Profile Setting

Funcion Module

Monitor

Configs

Operstor

View  Modify Description

Enterprize network monitor anid views functions:

Config fie backupiestore and image management functions.

Alarm, event, frap, and device syslog vievws. And slert configuration and nofification profile related functions.

Network map topology, layer 2 & 3 topology and Google Map related functions
Metwork devices discovery and credential managemert

Metwark report generation and view.

Jab list and status related functions

User and securlty profile related functions.

Adminisiration related functions.
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b. (Optional) In the Profile Name field, modify the name.

(Optional) In the Profile settings section of the pop-up window, select the check
boxes for the functions that you want to include in the security profile.

For a default security profile, you can change only the profile name.
d. Click the Submit button.
The modified security profile is saved and added to the User Profile table.
* Remove the security profile:
a. Click the Delete button.
You cannot remove a default security profile.
A confirmation pop-up window opens.
b. Click the Yes button.

The security profile is removed from the User Profile table and deleted.

Add a User Profile to the User Base

The application includes one default user profile, which is a user with the name admin to
which an Admin security profile is assigned. You can add multiple user profiles to the user
base.

> To view the existing user profiles and add a user profile:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select USERS > USER MANAGEMENT.

WIRELESS | RESOURCES | mMoOMITOR aLarms | TopoLocy REPORTS m ADMIN
User Management Q
[ aca [] ear ]| oeicte | Rowsperpage[ 10 B9 < [ 1 i1 > [ Touis
[ Status # UserName « Security Profile 4 E-mail % LastName # First Narme # Telephone £
O @ Active B, admin Admin adming@email com
0O @ Active &, Justiooking Obsener justiooking@emall.com
0| ® Active & Justoperating Operalor lustoperating@emall.com
0O © Active &, roland Admin rolandg@email.com

The Status column displays whether the user is active and can log in.
5. Click the Add button.
The Add User pop-up window opens.

2 Add User X

User Basic Information

User Name E-mail =
Password [ Check Password =
Last Name 1 First Hame S
Telephone 1

User Satus

Staus Er— |

Security Profile Observer

B | cancel

6. Specify the following information:

* Inthe User Basic Information section, enter the user name, password, and email
address for the user. The first and last name and telephone number are optional.

* Inthe User Status section, select whether the user profile is active and select the
security profile that applies to the user.

For more information about security profiles, see Security Profile Concepts on page 256.
7. Click the Submit button.

The pop-up window closes and the new user is added to the User Management table.
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Modify or Remove a User Profile

You can modify or remove a user profile.

» To modify or remove a user profile:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select USERS > USER MANAGEMENT.

RESOURCES | MOMITOR ALARMS | TOPOLOGY REPORTS m ADMIN
User Management (7]
[ naa [| car ]| eiete | Rows perpage[ 10 1 < [ 1 i1 > I Totar
[ status & Usgor Name ~ Security Profile & E-mail ¢ LastName & First Narne & Telephone &
O @ Astive L admin Admin adming@ernail com
0O & Active & Justiooking Obsener justiooking@email.com
0O @& Aive A& Justoperating Operator justoperating@email.com
0O @ ative & roland Admin roland@ernall.com

5. Select the user profile.
6. Take one of the following actions:
* Modify the user profile:
a. Click the Edit button.

The Edit User pop-up window opens.

A Edit User X

User Basic Information
User llame atmin * E-mail adming@email com *
Password r Re-type Password [ eeeer r
Last llame | First Hame
Telephone
User Satus
Status Active E
Security Profile Adminy E
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a. (Optional) In the User Basic Information section, modify the user name,
password, or email address for the user. The first and last name and telephone
number are optional.

b. Inthe User Status section, select whether the user profile is active and select the
security profile that applies to the user.

For more information about security profiles, see Security Profile Concepts on
page 256.

c. Click the Submit button.
The modified user profile is saved and added to the User Management table.

* Remove the user profile:
a. Click the Delete button.

A confirmation pop-up window opens.
b. Click the Yes button.

The user profile is removed from the User Management table and deleted.

View and Log Off Online Users

You can view the users who are currently logged in and log them off:

> To view and log off (abort) users who are online:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select USERS > ONLINE USERS.

ADMIN

On-line User (7]
[ abort | Fows perpage| 10 a < [ dn > [ Totar2
[ status # UserName # Security Profile # Emall @ Telephone & LoginTime « LoginIP ¢
(] Attive L roland Admin roland@email.com 0W1172013 09:49:57 192168104

O Active B JusiLooking Observer justiooking@@ema. .. 091172012 09:51:07 | 127.00.1

5. To add columns to or remove them from the Online User table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, User Name, Security Profile, E-mail,
Telephone, Login Time, Login IP, First Name, and Last Name.

6. Select one or more users.

To select all users, select the check box at the left in the table heading.
7. Click the Abort button.

A confirmation pop-up window opens.
8. Click the Yes button.

The users are logged off.
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Customize select global system settings
and back up and restore system settings

You can change global settings and back up and restore the system settings from the
administration dashboard. Except for the procedures that are described in this chapter, all
procedures that you can perform from the System and Website Setting page of the
administration dashboard are described in the subject-specific chapters.

This chapter covers the following topics:

e Set Up an External File Server

* Set the Data Retention Period

» Set the Inventory Polling

» Set the Idle Time-Out

» Set the Real-time Chart

e Change the Auto Refresh Setting

» Set Up a File Server for System Backup and Restore Operations
» Back Up the System Settings

» Restore the System Settings

Note: Only admin users (that is, users with a security profile that is set to
Admin) can customize the global settings and back up and restore the
system settings, as described in this chapter.
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Set Up an External File Server

By default, the application uses an internal file server to save and retrieve configuration files.
If you set up an external file server, you can import and export configuration files (see Import
and Export Configuration Files to an External File Server on page 156).

Even if you set up an external files server, all file transfers are still handled by the NMS300
server, that is, the external file server is for file storage only.

> To set up an external file server:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings Customize

Discover your network and 3dd the devices you wantto Set plobal seftings for the system and website A= Customize the navigation and look of your web portal
manage,

Account Information Manage Monitor and Alarm = my.NETGEAR.com Account Profile
& Vigw or modify users, or create new users, a Network moniter, alarm and twesheld related configurations. © Configure and validate myNETGEAR.com acoount profile
through my NETGEAR. com Web APL
=) sFlow Manage External File Server License And Version Information
) setsFlow retated configurations &L Enemal Flle Sewver configurations and File Processing with View NMS300 license, suppened device andversion
External File Server information.
» IMPORt of EXpOR GO Files

System Backup/Restore

System Backup/Restore Server Configurations and
Processing
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5. Under Manage External File Server, click the External File Server Setting link.
The External File Server Setting pop-up window opens.
6. From the File Server Type menu, select External File Server.

The pop-up window adjusts.

B External File Server Setting X

External File Server Setting
File Server Type | External File Server E
External Server IP [ .1 [ 5 ’
Directory Path | z
User Hame [ z
Password [ z

Cancel | [ Test

7. Specify the server settings:
» External Server IP. Enter the IP address of the external file server.
» Directory Path. Enter the directory path where the configuration files are stored.

You must enter the directory path for the external file server in the xxx/xxx format, in
which the delimiting character is a slash (for example, backup/NMS300).

« User Name. Enter the user name to access the external file server.
« Password. Enter the password to access the external file server.
8. Click the Test button.

Access to the external file server is verified.
9. Click the Submit button.

Your changes are saved.

Set the Data Retention Period

You can change how long the application retains your network data. The longer information is
retained, the more disk space is required on the NMS300 server. You can monitor the
NMS300 server information (see View the NMS300 Server Information on page 117).

» To modify the data retention period:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.
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2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select ADMIN > SETTINGS.
[ vous T wmeress [ resowsces [ wowton | cownc [ avamws [ rosorosy [ siow [ wroms [ soss [ usms [ aoww ]
[Ss Meres nemsewmcener ]

System and Website Settings

Getting Started with NM$ System Settings  Customize
/ Discover your network and add the devices you wantto Set global seftings for the system and website, A{ Customize the navigation and look of your web portal,
manage,

Account Information ﬁ Manage Monitor and Alarm D my.NETGEAR.com Account Profile
& View or modify users, or creale new users. Metwork monitor, alarm and threshold related configurations d Configure and validate myNETGEAR com account profile
through myNETGEAR.com Web API.

> U

3 sFlow Manage External File Server License And Version Information
SetsFlow related configurations. &5 Extemal File Server configurations and File Processing with View NMS300 license, supported device and version
Extemal File Server. information

System Backup/Restore

System BackupRestore Server Configurations and
Processing.

Server Setting

5. Under System Settings, click the Data Retention Period link.

B Data Retention Setting (Days) X

Data Retention Setting (Days)

Events E R | Alarm History E 4
HMS Audit Log ]20—‘ r Raw Performance Datas ’:| ¥
Sumary Performance Datas 180 ? Report Files ]C 2
Config Files ’90—‘ T Image Files D .4

[ suomic JRETEN
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For the data retention periods that you want to change, enter the updated information:

Events. This setting determines how long events are retained. The default period is
30 days. For more information, see View and Manage Network Event Notifications on
page 187.

Device Traps. This setting determines how long trap data is retained. The default
period is 30 days. For more information, see View and Manage Device Traps on
page 188.

NMS Audit Log. This setting determines how long audit logs are retained. The
default period is 30 days. For more information, see View and Export Audit Logs on
page 115.

Summary Performance Data. This setting determines how long summary
performance data is retained. The default period is 180 days. For more information,
see Customize the Optional Network Dashboard on page 108.

Configuration Files. This setting determines how long backed-up configuration files
are retained. The default period is 90 days. For more information, see Back Up Your
Device Configurations on page 122.

Job Result. This setting determines how long job execution reports are retained. For
more information, see View and Manage Jobs on page 252.

Alarm History. This setting determines how long alarms are retained. The default
period is 30 days. For more information, see View and Manage the Alarm History on
page 172.

Device Syslogs. This setting determines how long syslogs are retained. The default
period is 30 days. For more information, see View and Manage Device System Logs
on page 190.

Raw Performance Data. This setting determines how long raw performance data is
retained. The default period is 3 days. For more information, see Manage the
Configuration Monitors on page 102.

Report Files. This setting determines how long job reports are retained. The default
period is 30 days. For more information, see View and Remove Saved Reports on
page 248.

Image Files. This setting determines how long device firmware files are retained. The
default period is 365 days. For more information, see Upgrade Firmware for One or
More Devices on page 158.

Click the Submit button.

Your changes are saved.
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Set the Inventory Polling

You can change how often the application polls the network for your device inventory.
> To modify the inventory polling:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings

Customize
Discover your network and 3dd the devices you wantto Setglobal seftings for the system and website, A{ Customize the navigation and 100k of your web porta),
manage.

» Diata Retention Periad

Account Information a Manage Monitor and Alarm

'b my.NETGEAR.com Account Profile
* View or modify users, o create new users,

Metwork monitor, alarm and threshold related configurations. Configure and validate myNETGEAR com account profile
theough my NETGEAR.com Web APL

=) sFlow Manage External File Server License And Version Information
2 set sFiow related configurations &L Exemal File Server configurations and File Processing with View NMS300 license, supported device and version
Extemal File Server. information.

t& System Backup/Restore

System Backup/Restofe Server Configuranens and
Processing.
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5. Under System Settings, click the Inventory Polling link.

B System Inventory Polling Setting X

System Inventory Polling Setting
Recurrence Type Daily a Every Day(s) 1 ¥ Execute Time 1:0 :00{%

6. Specify the recurrence type and execution time.
If you select Hourly from the Recurrence Type menu, the pop-up window adjusts.
7. Click the Submit button.

Your changes are saved.

Set the Idle Time-Out

You can change how long the application waits before it logs you out for inactivity. The default
period is 30 minutes.

» To modify the idle time-out:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.
[ wowion [ comns | acamws [rvovoroor [ smow [ serowrs [ soss [ wsmns [ wowm ]

SETTGS

System and Website Settings

Getting Started with NMS System Settings / Customize

L Discover your network and add the devices you wantto Set global seftings for the system and website. ‘v/ Customize the navigation and look of your web portal.
manage,

Account Information a Manage Monitor and Alarm = my.NETGEAR.com Account Profile
View of modify users, of create new users. Network monitor, alarm and threshold related configurations. . Configure and validate myNETGEAR com acoount profile
through myNETGEAR.com Web AP
> i » myNETGEAR com Ac
H: »
>
— sFlow Manage External File Server License And Version Information
% SetsFlow related configurations. L gxemal File Server configurations and File Pracessing with View NMS300 license, supported device and version
External File Server. information.

—_ System Backup/Restore

Systern BackupRestore Server Configurations and
Protessing.

5. Under System Settings, click the Idle Time Out link.

B System Ide Time Out Setting X

System lde Time Out Setting

Idle Time Qut 30 Minutes u

m | cancel

6. Specify the new idle time-out period.
7. Click the Submit button.

Your changes are saved.
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Set the Real-time Chart

You can change how often the application refreshes your chart data and the maximum time

range that is displayed on your charts. By default, the data refresh interval is 10 seconds and
the maximum time range is 5 minutes.

» To modify the chart settings:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

and Websi

g

Getting Started with NMS System Settings

Discover your network and add the devices you wantto
manage

Customize

Set global seltings for the system and website, &5 customize the navigation and look of your web portal,

Account Information @ Manage Menitor and Alarm

= my.NETGEAR.com Account Profile
h View or modify users, or create new users,

Network menitor, alarm and thresheld related configurations: * Configure and validate my.NETGEAR com account piofile
through my NETGEAR.com Web AP

3 sFlow Manage External File Server

< SetsFlow related configurations &% Evemal File Sever configurations and File Processing with
External File Server,

License And Version Infarmation

View NMS300 license, supponed device andversion
infermation

€
<
=

» sFlow Seftings

System Backup/Restore

System BackupRestore Server Configurations and
Processing
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5. Under System Settings, click the Real-time Chart link.

B Real-time Chart Setting X

Real-time Chart Setting
Data Refresh Interval: 10 Second ] The interval system retrieves data.
Max Time Range: 5 Minutes ™ The time range system displays the charts.

. Specify the data refresh interval and maximum time range.
7. Click the Submit button.

Your changes are saved.

Change the Auto Refresh Setting

You can change how often the application refreshes the browser page for the web
management interface. By default, the page refresh interval is one minute.

» To modify the auto refresh setting:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.
rsocs | vom |

[ son [ wroms | oms | v [mom |
e
System and Website Settings

Getting Started with NMS

System Settings
/& Discover your network and addthe devices you want to
manage.

4 Customize
Set global Seftings for the system and website, J Customize the navigation and 100k of your web portal,

Account Information Manage Monitor and Alarm ‘g MyMNETGEAR.com Account Profile
& View or modify users, or create new users. Metwork moniter, alarm and thresheld related configurations.

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

3 sFlow

Manage External File Server
Y SetsFlow related configurations.

License And Version Infarmation
&% Enemal File Server configurations and File Processing with

View NMS300 license. supponed device andversion
information

External File Server,

Ei System Backup/Restore

System BackupRestore Server Configurations and
Processing.

» System Backup/R)

Under Customize, click the Auto Refresh Setting link.

B Auto Refresh Setiing (for Web Page Auto Refresh) X

Auto Refresh Setting (for Web Page Auto Refresh)

Auto Refresh Interval

L —

[Suoms I

Specify the new auto refresh interval.
Click the Submit button.

Your changes are saved.
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Set Up a File Server for System Backup and Restore
Operations

Before you can back up and restore the application system settings, you must specify an
external file server.
> To set up an external file server for system backup and restore operations:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select ADMIN > SETTINGS.
T

System and Website Settings

Getting Started with NMS System Settings ¢ Customize
Discover your network and add the devices you wanto Setglobal settings for the system and website, j Customize the navigation and Iook of your web portal,

manage.

Account Information Manage Monitor and Alarm 0 my.NETGEAR.com Account Profile
& View or modify users, of creale new users. A Network monitor, alarm and threshold related configurations Configure and validate myNETGEAR com account profile
through myNETGEAR.com Web API.

= sFlow Manage External File Server License And Version Information

S getsFiow retated configurations &5 Eaemal File $erver configurations and File Pracessing witn View NMS300 license, Suppened device and vergion
Extemal File Server. Information.

m System Backup/Restore

System BackupRestore Server Configurations and
Processing
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Under System Backup/Restore, click the System Backup/Restore File Server Setting
link.

The System Backup/Restore File Server Setting pop-up window opens.
From the File Server Type menu, select External File Server.

The pop-up window adjusts.

E System Backup/Restore File Server Setting %

System Backup/Restore File Server Setting

External Server IP/Hostname | 172262116

Directory Path [smb

User Name smb

Password | ssssssssess ks
Number of Backup 10 z

Cancel! Test

Specify the server settings:

« External Server IP/Hostname. Enter the IP address or host name of the external file
server.

« Directory Path. Enter the directory path where the backup files are stored.

You must enter the directory path for the external file server in the xxx/xxx format, in
which the delimiting character is a slash (for example, backup/system/NMS300).

« User Name. Enter the user name to access the external file server.
« Password. Enter the password to access the external file server.

*  Number of Backup. The maximum number of backups, which is a number from
1 to 31. By default, the number is 10.

Click the Test button.
Access to the external file server is verified.
Click the Submit button.

Your changes are saved.
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Back Up the System Settings

You can back up the application system settings immediately or schedule a backup job for
future execution, either once or on a recurring basis.

Note: For information about backing up devices that are on your network,
see Back Up Your Device Configurations on page 122.

The application saves the system settings backup file on the external file server that you
specify (see Set Up a File Server for System Backup and Restore Operations on page 275).
You can use the system settings backup file to restore the system settings. For more
information, see Restore the System Settings on page 281.

The application saves system settings backup files from completed backup jobs for the data
retention period. For more information, see Set the Data Retention Period on page 266.

Execute a System Settings Backup Job and See the History

You can execute a one-time system settings backup job immediately.

> To execute a system settings backup job immediately and see the backup history:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.

WIRELESS

System and Website Settings

Getting Started with NMS

manage

Account Information
“ View or modify users, of create new users.

= sFlow
= setsFiow retates configurations

System Backup/Restore

System BackupMRestore Server Configurations and
Processing

@

MOMITOR

Discover your network and add the devices you want to

ALARMS TOPOLOGY

System Settings
Set global seftings for the system and website.

¢ Customize
“—/ Customize the navigation and look of your web portal,

Manage Monitor and Alarm
Metwork monitor, alarm and thresheld related configurstions.

g MY.NETGEAR.com Account Profile

Configure and validate myNETGEAR.com acoount profile
theough myNETGEAR com Web AP

a

Manage External File Server

&5 Evemal File $erver configurations and File Pracessing with
External File Server

License And Version Information

View NNS300 license, supponed device and version
informaticn.

System Backup/Restore File Server Setting

Last Backup Time
Last Backup Status

Backup schedule has been configured

Start Backup .BackupHisfnﬂ[ Cancel

External Server IPHostname 172.26.2.116
Directory Path smb
Backup Status

127172015 06:34:17

Q Succeeded

Brne ©

Under System Backup/Restore, click the System Backup link.

6. Click the Start Backup button.

The System Backup pop-up window adjusts. The Status field displays the progress of the
backup job. After the job completes successfully, the Status field displays Succeeded.

The NMS300 History Backup Result pop-up window opens and displays all system

To see the backup history, click the Backup History button.

settings backups, including the one you just executed.

Click the Close button.

The pop-up window closes and the System Backup pop-up window displays again.
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9. Click the X button.

The pop-up window closes.

Schedule a System Settings Backup Job

You can schedule a system settings backup job to occur later, either once or on a recurring
basis.

» To schedule a system settings backup job:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings Customize

Discover your network and addthe devices you want to Set plobal seftings for the system and website. ‘{ Customize the navigation and look of our web portal.
manage.

Account Information Manage Monitor and Alarm = my.NETGEAR.com Account Profile
* View or modify users, or create new users, & Network monitor, alarm and threshold relsted configurations. * Configure and validate myNETGEAR com acoount profile
thegugh myNETGEAR. com Web APIL

=] sFlow Manage External File Sarver License And Version Information

S setsFlow related configurations &% Etemal File Server configurations and File Pracessing with @ View NMS300 license, supported device andversion
External File Server. information.

System Backup/Restore

System BackupRestore Server Configurations and
Processing

ackupRestore File Server Setting
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5. Under System Backup/Restore, click the System Backup link.

B system Backup x
System Backup/Restore File Server Setting
External Server IPiHostname 172262116
Directory Path smb
Backup Status
Last Backup Time 121172015 06:34:17
Last Backup Status ¥ Succeeded
Backup schedule has been configured B ©
Start Backup Backup History | Cancel

6. Next to Backup schedule has been configured, click the clock icon.
The Schedule pop-up window opens.
7. From the Enable menu, select Yes.

8. Specify whether the application executes the backup job once or on a recurring basis by
selecting one of the following options from the Execution Type menu and entering the
corresponding information:

« Onetime scheduled. This is the default selection.
In the Starting On field, enter a date and time.

e Recurrent. The pop-up window adjusts to display more fields.

T Schedule X
Execution Type & Status
Enable es Execution Type Recurrent E
Starting On
Starting On 04/30/2013 14:59:00 =

Recurrence

Recurrence Type Weekly ]

Day of the Week [¥ mMonday [~ Tuesday [~ Wednesday [~ Thursday [~ Friday [ Saturday [ Sunday

Stopping On
" End Time

@ Hever

m Cancel

Enter the following information:

a. In the Starting On field, enter a date and time.

b. From the Recurrence Type menu, select how the schedule recurs and complete
the corresponding field or select the corresponding check boxes.

c. Select the End Time radio button and enter the date and time in the

corresponding field, or leave the Never radio button selected, which is the
default setting.

9. Click the Submit button.
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Your changes are saved.

10. Click the X button.

The pop-up window closes.

Restore the System Settings

If you backed up the application system settings (see Back Up the System Settings on
page 277), you can restore system settings.

The application saves system settings backup files for the data retention period. For more
information, see Set the Data Retention Period on page 266.

Note: For information about restoring devices that are on your network, see
Restore Your Device Configurations on page 132.

A WARNING:

After the system settings are restored successfully, the application
reboots, and you must log in again.

> To restore the system settings from a backup file:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS System Settings  Customize
Discover your network and agd the devices you wantto Set gloval setlings for the system and website,
manage.

J Customize the navigation and 100k of your web portz),

Account Information Manage Monitor and Alarm
ﬁ View or modify users, or create new users,

= my.NETGEAR.com Account Profile
Network monitor, alarm and threshold related configurations

Configure and validate my NETGEAR com account profile
through myNETGEAR com Web API

» MyNETGEAR com Account Profile

= sFlow Manage External File Server License And Version Information
EL setsmowreisted conigurations % Exemal File Server configurations and File Processing with View NUS300 license. supporied device andversion
External File Server. infermatien.

System Backup/Restore

System BackupRestore Server Configurations and
Processing.

5. Under System Backup/Restore, click the System Restore link.

System Backup/Restore File Server Setting

External Server IP/Hostname

172262116
Directory Path smb
Select Backup File
Backup Date ~ Fie Name & NMS300 Version 03
121172015 10:29.38 NIS300_Backup_36_1.5.0.8.1449800978972 zip 1508
) 121172015 09:16:02 NIS300_Backup_35_1.5.0.8.1449796562395 zip 1508
© 1212015 063417 NIHS300_Backup_36_1.5.0.8.1449786857852 2ip 1508

Start Restore Cancel

6. Select the radio button for the backup file from which the system settings must be restored
By default, the most recent backup file is listed at the top of the table.
7. Click the Start Restore button.

The system settings are restored. If the operation is successful, the application reboots,
and you must log in again.
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Manage the system licenses

You can view license information, add a license, and deregister a license.
This chapter covers the following topics:

* View License Information
* Register a License
e Deregister a License

Note: Only admin users (that is, users with a security profile that is set to
Admin) can perform license management tasks.
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View License Information

The default license that comes with the application supports up to 200 devices. Each device
that the application discovers and adds to its device inventory is subtracted from the balance
of 200 devices. However, controller-managed APs are not subtracted from the balance.

For information about managing more than 200 devices, contact your NETGEAR sales
contact.

> To view license information:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select ADMIN > LICENSE MANAGEMENT.
[ comn | s [ ommao | v | wooms | on | o hmm |

LICENSE MANAGEMENT

Device Count

Madmum Alowed 200 - o
Current Monnged 35
License Management 9

[ Register || _Deregister |

[ License Name # Device Count % Expiration Time: * Key % Registered s
| NMS300 Default License 200 Never DEFAULT ves

The Device Count section of the page displays the maximum number of allowed devices
with the current license or licenses and the number of devices that the application
manages.

5. To add columns to or remove them from the License Management table, right-click the
table heading anywhere, and specify the columns by selecting the corresponding check
boxes.

You can choose from the following columns: License Name, Device Count, Expiration
Time, Key, Registered, Created By, and Created Time.
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Register a License

To register a license, you need a license key, and the NMS300 server must be connected to
the Internet to connect to a NETGEAR license server.

> To register alicense:

1. Open a browser and connect to the application through the static IP address of the

NMS300 server.

For more information, see Log In to the Application on page 20.

A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is

also admin.

3. Click the Sign In button.

The Network Summary page displays.
4. Select ADMIN > LICENSE MANAGEMENT.

ol | femy [y Eeer| ey [ e e | [
LICENSE MANAGEMENT

[ | MMS300 Default License

Device Count
Macdimum Alowed 200
175%
Current Manngod 3% -
License Managerment
[ License Name & Device Count ¢ Expiration Time ® Koy

200 Mever DEFAULT

# Registered 2
Yes

5. Select the license.

Manage Licenses

285



NMS300 Network Management System Application

6. Click the Register button.

&= Register License X

Company Information

' 4

Hame

Email [

City and State [ ‘

Country Postal Code | |

|
Address |
|
|

Telphone

License Information

Key rite erated by commas L4

EEEI | cancer

7. In the Company Information section, enter your information.
You must enter information in the Name, Email, and Telephone fields.
8. In the License Information section, enter the license key in the Key field.
You must enter a single license key.
9. Click the Submit button.

The license is registered with a NETGEAR license server. After successful registration,
the license is added to the License Registration table. The license is tied to the MAC
address of the NMS300 server.

Deregister a License

You can deregister a license on one NMS300 server, transfer it to another NMS300 server,
and reregister the license on the new NMS300 server. You cannot deregister the default
license.

After you deregister a license, if the number of allowed devices falls below the number of
managed devices, the application displays a wizard. To bring the number of managed
devices within the limit of the number of allowed devices, the wizard lets you select devices
from the currently managed list that you can delete from the application.

To deregister a license, the NMS300 server must be connected to the Internet to connect to a
NETGEAR license server.

» To deregister alicense:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

Manage Licenses
286



NMS300 Network Management System Application

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.

4. Select ADMIN > LICENSE MANAGEMENT.

[ o | s | s | come | ms | oror | siom | wooms | o | v | |
LICENSE MANAGEMENT

Dendce Count
Macdmum Alowed 200
175%
etz 3 —
License Management (7]
[ License Name # Device Count # Expiration Time * Key # Registered Ll

[ NMS300 Default License 00 Mevar DEFALULT es

5. Select the license.
6. Click the Deregister button.

A confirmation pop-up window opens.

7. Click the Yes button.

The license is removed from the License Management table and deregistered.
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Manage the registration of devices

You can view registration information, register one or more devices, and resynchronize your
device registration status.

This chapter covers the following topics:

Registration Concepts

Set Up and Validate Your Account Profile in the Application
Register One or More Devices

Register All Devices

Resynchronize Previously Registered Devices

Note: Only admin users (that is, users with a security profile that is set to
Admin) and operators (that is, users with a security profile that is set
to Operator) can perform registration tasks.
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Registration Concepts

Before you can use the registration tool that the application provides, you must create a
customer account at the NETGEAR product registration website. After you create a customer
account, you must set up the account profile in the application. For more information, see Set
Up and Validate Your Account Profile in the Application on page 289.

The registration tool lets you register one, several, or all devices that the application
manages. Registration occurs with the NETGEAR registration server. For more information,
see Register One or More Devices on page 293 and Register All Devices on page 296.

If you already registered your devices, either through the NETGEAR registration website or
through the application, and you install or reinstall the application, you can resynchronize the
previously registered devices. For more information, see Resynchronize Previously
Registered Devices on page 298.

Set Up and Validate Your Account Profile in the
Application

If you do not yet own a customer account to register devices, create a customer account at
the NETGEAR product registration website. For more information, visit
https://my.netgear.com/registration/login.aspx.

Set Up Your Account Profile for Device Registration

If you own a customer account, enter your account email address and password in the
application to create an account profile. This account profile enables you to register and
resynchronize devices through the application.

> To set up your account profile for device registration:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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Select ADMIN > SETTINGS.

System and Website Settings

Getting Started with NMS

’ Discover your network and addthe devices you wanl to
manage.

System Settings
Set global seftings for the system and website,

i . Account Information Manage Monitor and Alarm

View or modify users, or create new users. Metwork moniter, alarm and thresheld related configurations.

Manage External File Server

&% Exemnal File Server configurations and File Processing with
External File Server,

Q sFlow
Y SetsFlow related configurations.

» External File Sen

» Import or Expol

‘-3 System Backup/Restore

System BackupRestore Server Configurations and
Processing.

> System BackupRestore File Server Sefting

LN my.NETGEAR.com Account Profile

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

@ License And Version Infarmation

¢ Customize
Customize the navigation and look of your web portal,

fx Dashboard

View NMS300 license. supponed device andversion
information

» License Management

Under my.NETGEAR.com Account Profile, click the my.NETGEAR.com Account Profile

link.

my:NETGEAR.com Account Profile Configur:

Account Profile

Email Id [ |*

Password | ] r

Validate
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6. Configure the account profile:

* Inthe Email Id field, enter the email address that corresponds to your NETGEAR
customer account.

* Inthe Password field, enter the password that corresponds to your NETGEAR
customer account.

7. Click the Submit button.

The application connects to the NETGEAR registration server to verify the validity of the
email address and password. A pop-up window informs you whether the operation was
successful.

Validate and Retrieve Your Customer Account Information

If you own a customer account, you can retrieve your account information in the application.

> To validate and retrieve your customer account information:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select ADMIN > SETTINGS.
[ o | s | s | wowon | come | mems [ oo | suow | wooms | ow | va |hom |

System and Website Settings

Getting Started with NMS

Discover your network and add the devices you want to
manage

System Settings
Set global seftings for the system and website,

4 Customize
f’ Customize the navigation and 100k of your web portal,

Account Information

Manage Monitor and Alarm
& View or modify users, or create new users.

‘g MyMNETGEAR.com Account Profile

Configure and validate myNETGEAR.com account profile
through my NETGEAR com Web APL

Metwork monitor, alarm and threshold related configurations.

= sFlow

Manage External File Server
B4 set sriow relsted comgurations

&% Enemal File Server configurations and File Processing with
External File Server,

License And Version Infarmation

View NMS300 license, supponed device and version
information

Ei System Backup/Restore

System BackupRestore Server Configurations and
Processing.

Under my.NETGEAR.com Account Profile, click the my.NETGEAR.com Account Profile
link.

The my.NETGEAR.com Account Profile pop-up window opens.
Click the Validate button.
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The application connects to the NETGEAR registration server to retrieve the customer
account information.

Account Info

Customer Type Consumer
First Hame les

Last Hame murg
Email Id les murug@ryahoo com
Telphone 4031001000
Address1

Address?

City los angeles
State Ca
PostCode 94051
Country United States

[ cancet

7. Click the Cancel button.
The Account Info pop-up window closes.
8. Click the Cancel button.
The my.NETGEAR.com Account Profile pop-up window closes.

9. To change any account information, visit https://my.netgear.com/registration/login.aspx.

Register One or More Devices

You can register a single device or a selection of devices. However, the application cannot
register NETGEAR devices that do not report their serial number to the application. If the
Devices table does not list a serial number in the Serial Number column for a device, the
device does not report its serial number to the application.

> To register one or more devices:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.
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The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.

The Network Summary page displays.
Select RESOURCES > DEVICES.

WIRELESS MONTOR ALARMS TOPOLOGY 0BS ADMIN

| Edt [| peiete [| Resync [JMITITIRS Rowsperpage| 10 4 < | 1 lis > [ Totat 41
[ status ¢ Device Name ~ |P Address ¢ MACAddess ¢ Hostname ¢ Managed By 4 Location ¢ Device Type ¢ Device Model ¢
O euve 192168.10102-mine | 192.168.10.230 744401800872 IP Address shanghal CN Switch GEMT224v2
0O éu 10.10 192.168.10.104 00:22:31.90:95:37 1P Address Switch GEMT3288v2
0O ew 19216810114 20:4€7E81:5hicE 1P Address san jose Swiltch GST28TPS
Oeu 192.168.10.120 4c:B0:dedb 7768 IP Address san jose Switch M5300-286G3
0O euve 19216810125 cl:30eTlcbcs 1P Address peijing Switch GEMT248v2
0O euw 192.168.10.201 10:0d:763:06:08 1P Address Switeh GET43TPS
0Oeuw 19216810216 28:6:80:01:90:20 1P Address Swiltch GS5T24Tv3
0O euv 192.168.10.217 20:4e:7170:07:93 IP Address Jung-locatioon-217 Swilth GSMI212F
0O eus 2 19216810226 00:8ef2 Sadale 1P Address Switch GETSITHS
0O eup 192.168.10.237 192.168.10.237 30:46:9a1 207 1P Address Switch GEMT252P8

The page displays the devices that the application discovered.

To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.

Select one or more devices.
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8. From the More menu, select Register Device.

B Device Registration X
Purchase Info > m

Select one or more devices in the table below. Populate the appropriate value for Date of Purchase and Courtry of Purchase for the selected devices by entering in the fields
below and clicking on Apply. Once these are populsted for all selected devices, then cick on Execute,

Date of Purchase (12130013 | | Apply
Courtry of Purchase Argentina u | Apply |
Device Mame % Device Type % |P Addrezz % Serial Number % Date of Purchase # Country of Purchase *
BEO-167 Stancalone AP 192 16810167 2)041 29000067 United States
Jimimny-B20-16: = Standalone AP 63 2P128NADOD3T | |uniteasites

9. In the Date of Purchase field, enter the date of purchase, and click the Apply button.
10. In the Country of Purchase field, enter the country of purchase, and click the Apply button.

The date of purchase is applied to all selected devices.

By default, the application lists the country that you entered when you created your
customer account at the NETGEAR product registration website. You can change the
country of purchase, which is applied to all selected devices.

11. Click the Execute button.

The application contacts the NETGEAR registration server. The Result pop-up window
opens and displays whether the registration is successful.

Register Devices
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B Device Registration X

Execution Result

Hote: Device Registration may take a while to complete, Please be patisnt,

Status 0 Succeeded

Rows perpage | 10 u < .l'1 > LM Total: 2

Device Mame % [P Address + Start Time + End Time 4+ Stalus - Detail *
B60-167 19216810167 121172013 21:35:59 121102013 21:36:01 0 Succeeded
Jimmmy-620-165 19216810168 121172013 21:35:39 121102013 21:36:01 a Succeeded

Close

Note: A serial number must be unique for a device registration to be successful.

12. Click the Close button.

The pop-up window closes.

Register All Devices

You can register all devices simultaneously. You can also clear selected devices so they are
not registered. The application cannot register NETGEAR devices that do not report their

serial number to the application. If the Devices table does not list a serial number in the Serial
Number column for a device, the device does not report its serial number to the application.

» To register all devices simultaneously:

1. Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.

2. Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

3. Click the Sign In button.
The Network Summary page displays.
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4. Select RESOURCES > DEVICES.

CONFIG ALARMS TOPOLOGY 0BS ADMIN

| edn [ petete || Resync [ITERA Rowsperpage| 0 8 < [ 1 s > [N Tott a1
0 staus - |P Agdress ¢ MACAddress ¢ Hosmame ¢ Managed By % Location % Device Type ¢ Device Model ®
0O eur 19216810230 THA40190172 1P Address shanghal CN Swiiteh GENI22402
0 ®&up 19216810104 00:22:39:95:37 1P Address Swilen GSMT3289v2
0O eu 19216810114 2040701 5bich IP Address san jose Switeh GST28TPS
O eup 192.168.10.120 4¢:60:de:db 77 68 IP Address £an jose Switch M5300-28G3
0O eu 192.168.10.125 c0:310e: 7hobics 1P Address belling Switch GEMT248v2
0O eu 192.168.10.201 10:00:7(b3:06:08 P Address Switch GST48TPS
0 eu 192.168.10.216 23cE0e:01:9b:20 IP Address Switch G5724Tv3
0O eu 192.168.10.217 20:4e:TETOOT93 IP Address Jung-1ocatioon-217 Switch GSMI212F
Oeu 19216810226 00:8e125adale 1P Address Switch GETSITHS
0 eup 192.168.10.237 30:46:9a1b:b 207 IP Address Switeh GEM7252PS

The page displays the devices that the application discovered.

5. To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

6. To filter the devices that are listed, click the Show Filter button.

You can filter the devices by criteria such as type, name, IP address, vendor, model, and
status.

To hide the filter, click the Hide Filter button.
7. From the More menu, select Register All Devices.
[ rcorio > | o]

Select ane or more devices in the table below. Populate the appropriste value for Date of Purchase and Country of Purchase for the selected devices by entering in the fields
belovy and clicking on Apply. Once these are populated for all selected devices, then click on Execute.

Date of Purchase 72713:3:01_3'—| | Apply
Courtry of Purchass m | Apply |
Device MName # Device Type < [P Address 4 Serial Number 4 Date of Purchase # Country of Purchase +
s e 1821881041 United Stetes El
[ Juyi7-ss0-183 Standalore AP 1926810163 2012ANI0018E United States.
netgearA623F8 &l Sonclone 4P 19218810150 Unied States
Jiminy-620-168 [l Standsione AP 192166110168 2XP128NADDO3T United States
nelgesrD20226 Standalone AP 18218610133 26Y2245N002E7 Unied States.
[7] eso-167 Stancllors 4P 19216810167 250128000087 United Stetes
7] aso-157 & Standalone 8P 19216810157 2921075600104 Unfted States
19246810104 Switch 19216810104 United States
192.16810.70 Switch 192.186.10.70 2%N12458F0029 United States
1921681052 &3 switch 1921881062 2UE11BS2F002D United States v

[Execue IR

8. If you want to exclude some devices, clear the associated check boxes.
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9. In the Date of Purchase field, enter the date of purchase, and click the Apply button.
The date of purchase is applied to all selected devices.
10. In the Country of Purchase field, enter the country of purchase, and click the Apply button.

By default, the application lists the country that you entered when you created your
customer account at the NETGEAR product registration website. You can change the
country of purchase, which is applied to all selected devices.

11. Click the Execute button.

The application contacts the NETGEAR registration server. The Result pop-up window
opens and displays whether the registration is successful.

B Device Registration X

Execution Result

Hote: Device Registration may take a while to complete. Please be patient.

Status @ Succeeded

Rows per page | 10 E . < [ 1 s > m Tatalk 52
Device Mame & [P Addrezs + Start Time %+ End Time % Status “ Detail *
192 168.10.102-mine 19216610102 AZM 272013 14:11:04 12A220M3 141119 @ Succeeded l’:]‘
192.168.10.104 15216810104 12122013 14:11:04 12120213 1411:05 05.‘|mcaewed |;|
19246810411 19216810111 121272013 14:11:04 12122013 14:11:20 @Sw:caeded
19216810117 19216810117 121272013 14:11:04 1222013 1411:20 @Mc&edﬂd
19216810120 19216810135 121272013 14:11:04 12022013 14:11:20 as‘ucceeded
19216610124 189216610124 121 272013 14:11:04 12M220M314:11:20 @Sw:ceeded
19216810125 15216810125 12M 212013 14:11:04 12120213 14120 @chceedied
19216810126 Unknoeen 121272013 14:11:04 1222013 14:11:20 @ Succeeded
I

19216810126 19216810126 12N 272013 14:11:04 12A220131411:20 @Succeemed ]
Close

Note: A serial number must be unique for a device registration to be successful.

12. Click the Close button.
The pop-up window closes.

Resynchronize Previously Registered Devices

The application lets you resynchronize previously registered devices. This capability is useful
in the following situations:

* You already registered your devices directly at the NETGEAR product registration
website and you install the application for the first time or upgrade the application to a
version that supports device registration.

After you resynchronized the previously registered devices with the NETGEAR
registration server, the application displays which devices are already registered and
which devices still require registration.
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You already registered your devices through the application and you remove and reinstall
the application. In such a situation, the registration information is deleted from the local
database of the application.

After you resynchronized the previously registered devices with the NETGEAR
registration server, the registration information in the local database of the application is
restored.

To resynchronize previously registered devices:

1.

Open a browser and connect to the application through the static IP address of the
NMS300 server.

For more information, see Log In to the Application on page 20.
A login window opens.
Enter your user name and password.

The default administrator user name is admin and the default administrator password is
also admin.

Click the Sign In button.
The Network Summary page displays.
Select RESOURCES > DEVICES.

ADMIN

| edt || oetete [| Resync [JMTETRRA Rows perpage| 10 [ < [ 1 |15 > Total: 41
[ status ~ # Device Name - P Address 4 MACAddress  # Hostname % Managed By % Location % Device Type % Device Model +
0O eup 192,168 ine | 192.168.10,230 T4A401:9000.72 P Address shanghal CN Switch GEMT224v2
0O eu 1 192.168.10.104 00:22:3090:95:37 P Addrass Switch GEMT2288v2
0O eu 19216810114 20:4e 791 5bicE IP Address san jose Switch GST28TPS
O eu 1 192.168.10.120 460 decdb 7T 68 P Address san jose Switch M5300-28G3
O eup 19216810125 03 0e Flchcs IP Address belling Switch GEMT 2482
0 euv 192.168.10.201 10:08:7103:06:08 1P Address Switeh GST44TPS
0Oeu 192.168.10.216 28:6:8¢:01:90:20 1P Address Switch GET24TYE
0O eup 1 192.168.10.217 20:4e7ETb:d] 95 P Address Jung-locatioon-217 Switch GESMT212F
O eup 1 19216810226 00:8ef2 5adale P Addrass Switch GST5ITHS
O eup 192.168.10.237 30:46:921 0207 1P Address Switch GEMTI52PS

The page displays the devices that the application discovered.

To add columns to or remove them from the Devices table, right-click the table heading
anywhere, and specify the columns by selecting the corresponding check boxes.

You can choose from the following columns: Status, Device Name, IP Address, Device
Model, Device Type, Firmware Version, Serial Number, MAC Address, Last Update Time,
Location, Registered, Hosthame, Managed By, Date of Purchase, Vendor, Country of
Purchase, Hardware Version, Configuration Version, Contact, Discover Time, and
Description.

From the More menu, select Resync Registration.

A pop-up window opens and informs you whether the operation was successful.

Register Devices
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Technical Specifications

Hardware and software requirements

Table 4. Hardware and software requirements

Item Specification

System architecture e B/S-based multitiered system

Browser support (HTTP and HTTPS)

Internet Explorer 9 or a later version
» Firefox 15.0 or a later version
e Chrome 10.0 or a later version

OS support *  Microsoft Windows XP (Professional) 32-bit and 64-bit with SP3 or
later
*  Windows Server 2003 (Standard, Enterprise, and Web), 32-bit and
64-bit

* Windows Server 2008 (Enterprise), 32-bit and 64-bit

* Microsoft Windows 7 (Professional, Enterprise, and Ultimate), 32-bit
and 64-bit

* Microsoft Windows 8 (Enterprise), 64-bit
» Microsoft Windows Server 2012 (Standard), 64-bit
» Microsoft Windows 10 (Home, Pro, Enterprise) 32-bit and 64-bit

VM support » Support hypervisors include VMWare and other major ones such as
Hyper-V and XenServer

Standard server requirement (for 200 | 2.8 GHz dual-core CPU

devices) « 4 G RAM (32-bit OS) or 8 G RAM (64-bit OS)
e 20 G HD (free space)
e Static IP

Standard client requirement e 2 GHz CPU
« 2 G RAM

* 3 G HD (free space)

Installation e Server is installed through an automated GUI-based installer
» Single server deployment
e Client is web-based and no installation is required

Language support » English
* Chinese
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Table 4. Hardware and software requirements (continued)

Item Specification
Management interface support e SNMP (v1, v2c, v3)
e TFTP

e Telnet/HTTP/HTTPS
*«  Web management interface

Supported devices See Compatible Devices on page 14

DB MySQL (v5.5)

Technical Specifications
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Device Details

Device details that you can display

You can view many details for a device and its interfaces. For information about how to view
details, see View Device Details and Interface Details.

The detailed information that the application can provide depends on the type of device. The
Devices table can list the following devices in the Device Type column:

Switch. For information about the available details, see Switch Details on page 303 and
Interface Details on page 311.

Firewall. For information about the available details, see Firewall Details on page 304.

Standalone AP. For information about the available details, see Standalone AP Details
on page 305.

Controller-Managed AP. For information about the available details, see
Controller-Managed AP Details on page 306.

Wireless Controller. For information about the available details, see Wireless
Controller Details on page 307 and Interface Details on page 311.

WMS. For information about the available details for a wireless management system,
see Wireless Managements System Details on page 308.

Storage. For information about the available details for a storage system, see Storage
System Details on page 309.

Router. For information about the available details, see Router Details on page 310 and
Interface Details on page 311.

Unknown. For information about the available details for an unknown device, see
== Unknown Device Details on page 311.
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Switch Details

The following table lists the dashboard options and widgets or tables that are available for a
switch.

Table 5. Detailed information available for a switch

Dashboard Menu Option | Widget or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Average CPU and Memory Utilization (Today)

Inventory Information

Min/Max/Average Response Time

Latest 10 Alarms

CPU

Top 10 Interface by Traffic (Today)

Memory

Latest 10 Config Backups

Interface List Slot List

Note: Supported for M6100 managed switches only.

Slot List Interface List

Note: For more information, see Table 14 on page 311.

Traffic Monitor IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Bandwidth Monitor Received Bytes Real-time Chart

Transmitted Bytes Real-time Chart

Selected interfaces

Config Files Config File Backup List

Credential Authentication Association

Device Details
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Firewall Details

The following table lists the dashboard options and widgets or tables that are available for a
firewall.

Table 6. Detailed information available for a firewall

Dashboard Menu Option |[Widget or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Latest 10 Alarms

Top 10 Interface by Traffic (Today)

Latest 10 Config Backups

Interface List Interface List

Note: For more information, see Table 14 on page 311.

Traffic Monitor IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Bandwidth Monitor Received Bytes Real-time Chart

Transmitted Bytes Real-time Chart

Selected interfaces

Config Files Config File Backup List

Credential Authentication Association

Device Details
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Standalone AP Details

The following table lists the dashboard options and widgets or tables that are available for a
standalone AP.

Table 7. Detailed information available for a standalone AP

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Average CPU and Memory Utilization (Today)

Inventory Information

Min/Max/Average Response Time

Wireless Info (Current)

CPU

Latest 10 Alarms

Memory

Latest 10 Config Backups

Radios and Network 2.4 GHz Radio and networks

SSID and authentication information

5 GHz Radio and networks

SSID and authentication information

Client List Active Client List
Note: For more information, see Monitor Wireless Clients and View Client Details
on page 99.

Top 10 Top 10 Client by Traffic (Current)

Top 10 SSID by Client Count (Current)

Top 10 SSID by Traffic (Today)

Device Details
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Table 7. Detailed information available for a standalone AP (continued)

Dashboard Menu Option

Dashboard Submenu Option, Widget, or Table

Wireless Monitor

WLAN Utilization

Monitor per SSID

Wireless Client Count By SSID

Wireless Traffic (Received and Transmitted) By SSID

Wireless Frames (Received and Transmitted) By SSID

Monitor per Radio

Wireless Traffic (Received and Transmitted) By Radio

Wireless Client Count By Radio

Wireless Packets (Received and Transmitted) By Radio

Wired Monitor

Total Traffic

Wired Received/Transmitted Bytes

Wired Received/Transmitted Packets

Traffic by Protocol

IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Config Files

Config File Backup List

Credential

Authentication Association

Controller-Managed AP Details

The following table lists the dashboard options and widgets or tables that are available for a
controller-managed AP.

Note: Because of the nature of controller-managed APs, the application can
provide only limited information for controller-managed APs,
compared to standalone APs.

Table 8. Detailed information available for a controller-managed AP

Dashboard Menu Option

Dashboard Submenu Option, Widget, or Table

Controller Managed AP
Details

General Information

Latest 10 Alarms

Device Details
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Table 8. Detailed information available for a controller-managed AP (continued)

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Radios and Network 2.4 GHz Radio and Networks

SSID and authentication information

5 GHz Radio and Networks

SSID and authentication information

Client List Active Client List
Note: For more information, see Monitor Wireless Clients and View Client Details
on page 99.
Top 10 Top 10 Client by Traffic (Current)
Top 10 SSID by Client Count (Current)
AP Monitor Monitor per SSID Wireless Client Count By SSID
Monitor per Radio Wireless Client Count By Radio

Wireless Controller Details

The following table lists the dashboard options and widgets or tables that are available for a
wireless controller.

Table 9. Detailed information available for a wireless controller

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Controller Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Inventory Information

Latest 10 Alarms

Latest 10 Config Backups

Profiles 802.11b/bg/ng Profiles
802.11a/na Profiles
Top 10 Top 10 Client by Traffic (Current)

Top 10 Controller Managed AP by Client Count (Current)

Top 10 SSID by Client Count (Current)

AP List Access Points

Device Details
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Table 9. Detailed information available for a wireless controller (continued)

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Client List Active Client List
Note: For more information, see Monitor Wireless Clients and View Client Details
on page 99.

Interface List Interface List

Note: For more information, see Table 14 on page 311.

Traffic Monitor IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Bandwidth Monitor Received Bytes Real-time Chart

Transmitted Bytes Real-time Chart

Selected interfaces

Config File Config File Backup List

Credential Authentication Association

Wireless Managements System Details

The following table lists the dashboard options and widgets or tables that are available for a
wireless management system (WMS).

Table 10. Detailed information available for a WMS

Dashboard Menu Option | Widget or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Inventory Information

Latest 10 Alarms

Latest 10 Config Backups

Interface List Interface List

Note: For more information, see Table 14 on page 311.

Device Details
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Table 10. Detailed information available for a WMS (continued)

Dashboard Menu Option | Widget or Table

Config Files Config File Backup List

Credential Authentication Association

Storage System Details

The following table lists the dashboard options and widgets or tables that are available for a

storage system.

Table 11. Detailed information available for a storage system

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Inventory Information

Volume Information

Latest 10 Alarms

Disk Information

Latest 10 Config Backups

Interface List Interface List

Note: For more information, see Table 14 on page 311.

Traffic Monitor IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Bandwidth Monitor Received Bytes Real-time Chart

Transmitted Bytes Real-time Chart

Selected interfaces

Temperature Monitor Storage Temperature (°C)

Disk Temperature (°C)

Device Details
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Table 11. Detailed information available for a storage system (continued)

Dashboard Menu Option | Dashboard Submenu Option, Widget, or Table

Disk and Fan Monitor Disk Utilization (%)

Fan Speed (RPM)

Disk Capacity
Config File Config File Backup List
Credential Authentication Association

Router Details

The following table lists the dashboard options and widgets or tables that are available for a
router.

Table 12. Detailed information available for a router

Dashboard Menu Option | Widget or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Inventory Information

Top 10 Interface by Traffic (Today)

Latest 10 Alarms

Interface List Interface List

Note: For more information, see Table 14 on page 311.

Traffic Monitor IP Traffic Monitor

ICMP Traffic Monitor

TCP Traffic Monitor

UDP Traffic Monitor

SNMP Traffic Monitor

Credential Authentication Association

Device Details
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Unknown Device Details

The following table lists the dashboard option and widgets that are available for an unknown
device.

Table 13. Detailed information available for an unknown device

Dashboard Menu Option | Widget or Table

Device Details General Information

Average Response Time and Packet Loss (Today)

Min/Max/Average Response Time

Latest 10 Alarms

Interface Details

The interface details can display for switches, wireless controllers, wireless management
systems, and routers. The following table lists the dashboard options and widgets or tables
that are available for an interface.

Table 14. Detailed information available for an interface

Dashboard Menu Option | Widget or Table

Interface Details General Information

Traffic Information

Latest 10 Alarms

Monitor Data Interface Received/Transmitted Bytes

Interface Received/Transmitted Packets

Interface Utilization (%)

Interface Traffic Rate (bps)

Interface Inbound/Outbound Error Packets

Interface Inbound/Outbound Discards

Network Details VLAN Membership

Forwarding Database

Common STP Port Status

Device Details
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A

access points, supported 16
account information, changing 24

administrator user name, default 21
administrator user security profile 256
alarm configuration, hierarchical map links 199—205

alarms, managing 170—187
application notifications 119
audit logs 115

autorefreshing browser 273

backing up device configurations 122—132

backing up, system settings 277

basic spring view, network topology 216

browser, autorefreshing 273
browsers, supported 300

C

chart data, refreshing 272
charts, performance 110
childmaps 206

Chinese, language menu 20
colors, alarms 185

configurations, customizing, promoting, and restoring

132—155
controlled devices. See devices.

controller-managed AP, described 33

controllers, supported 17
CPU alarms 174
credentials, devices
adding and modifying 37
described 18
critical alarms 170, 174

current alarms, viewing and managing 170

customizing pages
DashBoard View 108
Network Dashboard 113
Network Summary 79
Top 10, all devices 86

Top 10, wireless devices 92
Wireless Summary 92

D

dashboard (network), customizing 108—114
data retention period 266
data, refreshing 272
defaults
administrator user name 21
auto refresh settings 273
data retention periods 268
device credentials 35
idle time-out 270
license 284
Network Summary page 78
real-time chart settings 272
report templates 238
Top 10 page, all devices 83
Top 10 page, wireless devices 90
user security profiles 256
Wireless Summary page 90
world map 194
deregistering licenses 286
details viewing, devices 302—311
device metrics, monitoring 102—107
devices
adding to a map 208
configurations
backing up 122—132
restoring 132—155
upgrading 158—168
credentials
adding and modifying 37
described 18
details, viewing 95, 302—311
discovering 33—49
firmware, managing 121—168
groups
described 12
managing 71
IP addresses, discovery 35, 42
managing 50—76
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rebooting 60

registering 288—299

reports 238

supported 14

tables of 50—54

third-party 33
discovering devices 33—49
dynamic device groups 73

E

email server 25
English, language menu 20
event notifications, network 187
exporting
alarm configurations 174
alarm history 172
alarms 170
configuration files 150
device traps 188
firmware files 166
inventory and interface list tables 70
network events 187
system logs 190
exporting, external file server 156
external file server 156

F

file server, external 156
firewalls, supported 16
firmware versions, viewing 116
firmware, managing 121—168

G

global system settings, customizing 264—274
Gmail account, email server 27
groups, devices

described 12

managing 71

H

header size, sFlow 233
hierarchical maps 197
history retention period, sFlow 233
history, alarms 172
HTTP, device credentials
adding and modifying 37
described 18

HTTPS, device credentials 37
Hyper-V 300

idle time-out 270
importing
child maps 206
configuration files 148
firmware files 159
from external file server 156
informational alarms 170
interface details, viewing 95

inventory and interface list tables, exporting 70

inventory polling 269
inventory reports 238
IP addresses, device discovery 35, 42

J

jobs, managing 251—254

L

language, selecting 20
levels of alarms 170
licenses, managing 283—287
link tree view, network topology 216
links, adding

onamap 210

on a topology view 223
LLDP, device discovery 42
logging in

devices 59

NMS300 20
logging off users 262
logs

audit 115

network events 187

system (syslog) 190

M

major alarms 170
managed switches, supported 14
management systems, supported 17
managing
alarms 170—187
device registrations 288—299
devices 50—76
firmware 121—168
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groups 71
jobs 251—254
licenses 283—287
maps 194—215
monitors 102—107
network topologies 216—230
reports 237—250
security profiles (users) 256—259
sFlow 231
SNMP traps 188
topologies 216—230
traps 188
users 259—262
maps, managing 194—215
memory alarms 174
MIB browser 62
minor alarms 170
monitoring devices and network 77—102
monitors, managing 102—107

N

network dashboard, customizing 108—114
network event notifications 187
network summary, viewing and customizing 78—83
network topologies, managing 216—230
NMS300 server

described 11

monitoring 117

requirements 300
notification profiles, alarms 180
notifications

alarms 185

application 119

file backup results 124

network events 187

(0

observer and operator, security profiles 256
operating systems, supported 300

P

password, changing 22
performance, real-time 109
pinging devices 60
polling intervals, configuring 107, 269
port, sFlow server 233
profiles
alarm notification 180

backup 122
customer account for registration 289
discovery 36
user security 256
promoting configurations 137—144
protocols, device credentials 38

Q

quick discovery 34

R

radial view, network topology 216
ReadyDATA and ReadyNAS systems, supported 17
real-time chart, refreshing 272
real-time performance 109
rebooting devices 60
registering

devices 288—299

licenses 285
reports, managing 237—250
resources. See devices.
restoring device configurations 132—155
restoring, system settings 281
results, sFlow monitoring 235
resynchronizing registered devices 298
retention period 266
roles, users 256

S

sampling rate, sFlow 233
scheduling
backup jobs 127
discovery jobs 45
firmware upgrades 161
jobs 252
reports 245
restoring of configurations 133, 144
system settings backup jobs 279
security profiles (users), managing 256—259
servers
email 25
NMS300
described 11
monitoring 117
requirements 300
sFlow 233
SMS 29
SMTP 26, 30
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sFlow, managing sources and viewing result 231 managing 259—262
smart switches, supported 15 types of 12
SMS server 29
SMTP server 26, 30 VvV
SNMP MIB browser‘62 VMWare 300
SNMP traps, managing 188
SNMP, device credentials
adding and modifying 37 w
described 18 wireless access points, supported 16
software versions, viewing 116 wireless clients, monitoring 99
software, managing 121—168 wireless controllers and management systems, supported
sources, sFlow 233 17
standalone AP, described 33 wireless device and client reports 238
static device groups 71 wireless summary, viewing and customizing 89—94
storage systems
reports 238 X

supported 17
summary, sFLow 235
supported devices 14
switches, supported 14—16

XenServer 300

synchronizing devices 57
syslogs 190
system settings
backing up 277
restoring 281
system settings (global), customizing 264—274

T

Telnet, device credentials
adding and modifying 37
described 18

templates, reports 238

third-party devices 33

time-out, idle 270

Top 10 widgets
all devices 83—89
wireless devices 89—94

topologies, managing 216—230

tracing a route to a device 60

traffic reports 238

traps, managing 188

types of users 12

U

upgrading device configurations 158—168
user name, default 21

user security profiles, managing 256—259
users

315



	NMS300 Network Management System Application
	Contents
	1. Introduction
	Network Environment Concepts
	Device Groups
	Types of Users

	Compatible Devices
	NETGEAR Managed Switches
	NETGEAR Smart Switches
	NETGEAR Firewalls
	NETGEAR Wireless Access Points
	NETGEAR Wireless Management Systems and Controllers
	NETGEAR Storage Systems

	Prepare the Network Devices for Discovery
	What to Do Next

	2. Get Started
	Log In to the Application
	Change Your Password and Account Information
	Change Your Password

	Change Your Account Information
	Configure the Email Server for Alerts and Alarm Notifications
	Configure the General Email Server Settings
	Configure Email Server Settings for a Gmail Account

	Configure the SMS Server for Alerts and Alarm Notifications

	3. Discover and Manage Resources
	Discovery Concepts
	Use Quick Discovery to Discover Devices on Your Network
	Use a Discovery Profile to Discover Devices on Your Network
	Add or Modify a Device Credential
	Add or Modify a Discovery Profile
	Execute a Discovery Job
	Schedule or Reschedule an Existing Discovery Job
	Remove a Device Credential
	Remove a Discovery Profile

	View and Manage the Wired and Wireless Devices on Your Network
	View Device Information
	View Wireless Device Information Only
	Modify the Name, Location Information, and Contact Information
	Remove Device Information
	Synchronize a Network Device
	Log In to a Device
	Ping, Perform a Traceroute, or Reboot a Device
	Use the SNMP MIB Browser
	View and Export the Inventory Table and Interface List Table

	Manage Device Groups
	Add or Modify a Static Device Group
	Add or Modify a Dynamic Device Group
	Remove a Device Group

	Search for the Switch to Which a Host Is Connected

	4. Monitor Devices and the Network
	Monitor the Network
	View the Default Network Summary
	Customize the Network Summary Page

	Monitor the Top 10 Widgets for All Devices
	View the Default Top 10 Widgets

	Customize the Top 10 Page
	View the Wireless Summary and Monitor the Top 10 Widgets for Wireless Devices
	View the Wireless Summary and Default Top 10 Wireless Widgets
	Customize the Wireless Summary Page

	View Device Details and Interface Details
	Monitor Wireless Clients and View Client Details
	Manage the Configuration Monitors
	Configure an Individual Monitor
	Disable a Monitor
	Reenable a Monitor
	View or Modify the Polling Interval for a Monitor

	Customize the Optional Network Dashboard
	Create or Modify a Dashboard View and Launch the Dashboard View
	Remove a Dashboard View
	Customize the Network Dashboard

	View and Export Audit Logs
	View Firmware Version Information
	View the NMS300 Server Information
	View Application Notifications

	5. Manage Configurations and Firmware
	Back Up Your Device Configurations
	Add or Modify a Backup Profile
	Execute a Backup Job
	Schedule a Backup Job
	View the Execution Status of a Backup Job
	Remove a Backup Profile

	Restore Your Device Configurations
	Restore the Configuration of a Single Device

	Customize and Promote a Configuration File
	Promote a Configuration File for an FVS318G Firewall
	Restore the Configuration of Several Identical Devices
	Import a Configuration File
	Export a Configuration File
	Modify a Configuration File
	Remove a Configuration File
	Compare Two Configuration Files

	Import and Export Configuration Files to an External File Server
	Upgrade Firmware for One or More Devices
	Import a Firmware File

	Execute or Schedule a Firmware Upgrade
	Modify the File Name, Version Information, and Description for a Firmware File
	Export a Firmware File
	Remove a Firmware File


	6. Manage Alarms and Logs
	View and Manage Alarms, Triggers, and Notification Profiles
	View and Manage Current Alarms
	View and Manage the Alarm History
	View and Manage Alarm Configurations
	Add a Custom Alarm Configuration
	Modify an Alarm Configuration
	View and Manage Alarm Notification Profiles
	Add or Modify an Alarm Notification Profile
	Customize Alarm Colors

	View and Manage Network Event Notifications
	View and Manage Device Traps
	View and Manage Device System Logs

	7. Manage Maps and Topologies
	View and Manage Maps
	View a Hierarchical Map and Locate a Device
	Manage a Hierarchical Map
	Add an Alarm Configuration for a Link on a Hierarchical Map
	Change an Alarm Configuration for a Link on a Hierarchical Map
	Add a Childmap
	Add Devices to a Map
	Add a Link Between Devices on a Map
	Customize the Style of a Link on a Map

	View and Manage Network Topologies
	Add a Topology View
	View a Network Topology and Details About a Device
	Manage a Topology View
	Add a Link Between Devices on a Topology View
	Customize the Style of a Node and Link on a Topology View
	Remove a Topology View


	8. Manage sFlow
	Set Up the sFlow Collection Server and Manage the sFlow Settings
	Manage sFlow Sources
	View and Export the Results of sFlow Monitoring

	9. Generate and View Reports
	Manage Report Templates
	Add or Modify a Report Template
	Remove a Report Template

	Generate and Schedule Reports
	Generate a One-Time Report Immediately
	Schedule a Report

	View and Remove Saved Reports
	View a Saved Report
	Remove a Saved Report


	10. Manage Jobs
	Schedule Jobs
	View and Manage Jobs

	11. Manage Users and Security Profiles
	Security Profile Concepts
	Add a Security Profile
	Modify or Remove a Security Profile
	Add a User Profile to the User Base
	Modify or Remove a User Profile
	View and Log Off Online Users

	12. Manage Global Settings and Backups
	Set Up an External File Server
	Set the Data Retention Period
	Set the Inventory Polling
	Set the Idle Time-Out
	Set the Real-time Chart
	Change the Auto Refresh Setting
	Set Up a File Server for System Backup and Restore Operations
	Back Up the System Settings
	Execute a System Settings Backup Job and See the History
	Schedule a System Settings Backup Job

	Restore the System Settings

	13. Manage Licenses
	View License Information
	Register a License
	Deregister a License

	14. Register Devices
	Registration Concepts
	Set Up and Validate Your Account Profile in the Application
	Set Up Your Account Profile for Device Registration
	Validate and Retrieve Your Customer Account Information

	Register One or More Devices
	Register All Devices
	Resynchronize Previously Registered Devices

	A. Technical Specifications
	B. Device Details
	Switch Details
	Firewall Details
	Standalone AP Details
	Controller-Managed AP Details
	Wireless Controller Details
	Wireless Managements System Details
	Storage System Details
	Router Details
	Unknown Device Details
	Interface Details

	Index

